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About CentreVu ™ Supervisor 1

The Lucent Technologies CentreVu Supervisor (Supervisor) software is a PC-
based interface to the CentreVu Call Management System (CMS). The 
Supervisor software runs on any IBM* compatible PC that is running any of 
the following Microsoft† operating systems:
● Windows‡ 95
● Windows NT 4.0
● Windows 3.1
● Windows for Workgroups 3.11
● Windows NT 3.51.

Supervisor is a client/server application. The “client” is the PC on which 
you are running the Supervisor application. The “server” is the CMS 
machine where the CMS database is located.

The CMS is a software product used by customers who have Lucent 
Technologies telecommunication switches and receive a large volume of 
telephone calls that are processed through the Automatic Call Distribution 
(ACD) feature of the switch. The CMS collects call-traffic data, formats 
management reports, and provides an administrative interface to the ACD 
feature in the switch.

* IBM is a registered trademark of International Business Machines Corp.
† Microsoft is a registered trademark of Microsoft Corp.
‡ Windows is a registered trademark of Microsoft Corp.
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You can use Supervisor to access and run the following CMS functions:
● Reports
● Dictionary
● Exceptions
● ACD Administration
● CMS System Setup
● Maintenance
● User Permissions
● Existing CMS Custom Reports
● Designer Reports (if Report Designer has been purchased).

In addition to giving you access to the CMS, Supervisor has many features, 
such as Report Designer and Bookmarks, that are not available when 
accessing CMS through a terminal. See the “Supervisor Features” section in 
this chapter for an outline of the features specific to Supervisor.

Some of the CMS functions, such as Vector Contents and Timetable, are not 
available in Supervisor. You will use the CentreVu Terminal Emulator on 
your PC or a terminal to use those features. For more information, see the 
“When to Use CentreVu Terminal Emulator” section in this chapter and 
Chapter 18, “CentreVu Terminal Emulator.”

Instead of the Custom Reports feature of the CMS, Supervisor has a report 
creation and editing tool, which is called the Report Designer. For more 
information on how to use the Report Designer, refer to the CentreVu 
Supervisor Report Designer (585-215-831) document and on-line help.
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Supervisor Features 1

Supervisor uses Windows capabilities to access the following features:

● The Controller — accesses CMS features (instead of a hierarchical 
MainMenu as in the terminal interface to CMS). The Controller includes 
the following features:

— A toolbar for one-click access to other program features of the 
Supervisor application. The toolbar has buttons that access the CMS 
features (Reports, Dictionary, Exceptions, ACD Administration, 
CMS System Setup, Maintenance, and User Permissions). The 
toolbar can also be customized to give you one-click access to the 
CMS reports and operations that you use on a regular basis.

— A menu bar with menus that access the CMS features (Reports, 
Dictionary, Exceptions, ACD Administration, System Setup, 
Maintenance, and User Permissions) and Supervisor features 
(Options, adding and deleting toolbar buttons, Login/Logout, and 
Help)

— A status bar, which displays the status of the CMS server and gives 
brief descriptions of each toolbar button. 

— Tooltips, which are brief descriptions that display when the mouse 
pointer is over a toolbar button.

— Indicators for CMS server date and time, ACD link status, and 
login/logout status.

● Use of the Windows 95 system tray — When the Supervisor application 
is running in Windows 95, the Supervisor icon resides in the system tray. 
If you are using report threshold highlights, the system tray icon 
changes when a Caution or Warning threshold is met. Also, the system 
tray icon gives you access to all of the Supervisor windows that you 
have open at any one time. See the “Using the System Tray Icon” section 
in Chapter 2, “Supervisor Basics,” for more information on this feature.

● Bookmarks — easily accesses reports and operations that you run on a 
regular basis. For more information on using the Bookmarks feature, see 
Chapter 14, “Bookmarks.”
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● Threshold highlights — and notification on real-time reports. The 
threshold highlighting includes the following features:

— Color-coded highlighting in reports when user-specified thresholds 
are reached or exceeded

— Icon changes for threshold alerting notification while a report 
window is minimized (Windows for Workgroups 3.11 only)

— Notification in the Windows 95 system tray when a threshold 
Warning or Caution condition has been met.

For more information on Threshold highlighting, see Chapter 5, 
“Reports.”

● The ability to export real-time, historical, and exception data to the 
Windows clipboard or to a file — exported information can then be 
imported to any application that runs on Windows, such as a spreadsheet 
application. For more information on exporting report data, see Chapter 
4, “Reports Basics.”

● A set of standard PC-based reports — features graphical 
representations of data, such as pie charts and three-dimensional bar 
charts. For more information on graphical reports, see Chapter 4, 
“Reports Basics,” Chapter 5, “Reports,” Chapter 15, “Real-Time 
Reports,” Chapter 16, “Historical Reports,” and Chapter 17, “Integrated 
Reports.”

● New “Integrated” reports — combine real-time data and historical data 
into one report. You will find these reports especially useful for looking 
at cumulative data throughout one day. For more information on 
integrated reports, see Chapter 4, “Reports Basics,” Chapter 5, 
“Reports,” and Chapter 17, “Integrated Reports.”

● New “drill-down” report capabilities — let you quickly access, from a 
report that is currently running, detailed information on a specific agent 
or on all of the agents in a particular work state for a split/skill. You can 
access the drill-down information by double clicking on an agent name 
or login ID or work state (depending on which information you are 
interested), or by selecting the drill-down report from the right mouse 
button menu. For more information on the drill-down report 
capabilities, see Chapter 5, “Reports.”
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● A report manager — gives you access to Properties information about 
each report, lets you copy standard reports so they can be edited in the 
Report Designer, and lets you copy designer reports to diskette for easy 
transportation to another CMS in your business. For more information 
on the report manager, see Chapter 5, “Reports.”

● ACD Administration — including the following features:

— Moving extensions between splits using the Windows drag-and-drop 
capability.

— Moving agents between skills using the Windows drag-and-drop 
capability.

— Adding and deleting agents’ skills.

— Changing agent splits/skills from within a report.

For more information on the Supervisor ACD Administration features, 
see Chapter 8, “ACD Administration.”

● User-controlled real-time sorting of report data — For more 
information on sorting report data, see Chapter 5, “Reports.”

● Network and direct-connect printing capabilities — Supervisor can 
connect to the CMS through a local area network (LAN). The LAN 
connectivity allows you to print reports on any network printer 
accessible by your PC. Supervisor also allows you to print on printers 
that are connected directly to your PC.

● LAN connectivity and modem connectivity — to the CMS server. 
Supervisor allows you to connect to the CMS server across a LAN or 
using a modem. For more information on setting up your connectivity, 
see Chapter 12, “Options.”
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When to Use CentreVu  Terminal Emulator 1

When you use Supervisor, there are specific CMS capabilities that you 
cannot access. In order to access these capabilities, you need to use the 
CentreVu Terminal Emulator or another terminal to access the CMS server. 
The CentreVu Terminal Emulator is a separate application that is included in 
the Supervisor installation. The following CMS capabilities are accessed 
through Terminal Emulator or another terminal:

● Forecast

● Shortcuts (in Supervisor, Bookmarks are used instead of Shortcuts)

● Timetables

● ACD Administration — Vector Contents

● CMS Administration and CMS Services login capabilities

● UNIX* system command capabilities

● INFORMIX† database commands.

*UNIX is a registered trademark of Novell, Inc. in the Unites States and other 
countries licensed exclusively through X/Open Company.
†INFORMIX is a registered trademark of Informix Software, Inc.

Note To learn how to use CentreVu Terminal Emulator, refer to Chapter 
18, “CentreVu Terminal Emulator.”
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Contents of This Document 1

This book describes what you need to know to use the Supervisor 
application on a day-to-day basis. The book is organized as follows:

● Chapter 1, Introduction — gives you background information on the 
Supervisor application and general information about the User Guide.

● Chapter 2, Supervisor Basics — walks you through starting Supervisor, 
logging into a CMS server, logging out of a CMS server, and exiting 
Supervisor. Also describes the Controller in detail, teaches you how to 
use the system tray icon, and teaches you how to complete input 
windows and close windows.

● Chapter 3, Operations Basics — defines how to use windows that 
display as a result of selecting an item from any Operations tab, 
including detailed information on the Actions menu items in operations 
input windows.

● Chapter 4, Reports Basics — defines how reports are displayed in 
Supervisor and teaches you how to format and print reports, including 
selecting run dates and times. Also gives detailed information on the 
Actions menu items available in report output windows and teaches 
you how to export report information to another Windows application.

● Chapter 5, Reports — teaches you how to run a historical, real-time, or 
integrated report including changing agent splits/skills from within a 
report, setting report threshold highlights, and using the drill-down 
capabilities of Supervisor.

● Chapter 6, Dictionary — teaches you how to use the Dictionary 
command and gives information on performing Supervisor tasks that 
are specific to this command including naming entities in the 
Dictionary, creating agent groups, and deleting agents from an agent 
group.

● Chapter 7, Exceptions — teaches you how to use the Exceptions 
command and gives information on performing Supervisor tasks that 
are specific to this command, including setting exceptions.
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● Chapter 8, ACD Administration — teaches you how to use the ACD 
Administration command and gives information on performing 
Supervisor tasks that are specific to this command including activating 
agent traces, working with Call Work Codes, changing agent 
splits/skills, moving agents/extensions, setting up call profiles, and 
changing trunk group and VDN assignments.

● Chapter 9, CMS System Setup — teaches you how to use the CMS 
System Setup tool.

● Chapter 10, Maintenance — teaches you how to use the Maintenance 
tool and gives information on performing Supervisor tasks that are 
specific to this command including running the Error Log report and 
performing data translations.

● Chapter 11, User Permissions — teaches you how to use the User 
Permissions tool and gives information on performing Supervisor tasks 
that are specific to this command including all the steps involved in 
setting up a new CMS user.

● Chapter 12, Options — teaches you how to use the Options tool and 
gives information on performing Supervisor tasks that are specific to 
this command, including using the General, Report Colors, Threshold 
Colors, and Name Format tabs to define how your report output 
displays.

● Chapter 13, Editing the Toolbar— teaches you how to customize your 
toolbar including reorganizing toolbar buttons and creating new toolbar 
buttons.

● Chapter 14, Bookmarks — describes the Bookmarks feature of 
Supervisor and teaches you how to use bookmarks in the product.

● Chapter 15, Real-Time Report Descriptions — gives an example of 
each of the Real-Time Supervisor reports.

● Chapter 16, Historical Report Descriptions — gives an example of each 
of the Historical Supervisor reports.

● Chapter 17, Integrated Report Descriptions — gives an example of 
each of the Integrated Supervisor reports.
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● Chapter 18, CentreVu Terminal — gives you general information about 
the CentreVu Terminal application and teaches you how to set up the 
CentreVu Terminal to connect to the CMS server.

● Chapter 19, Error Messages — gives you information on error messages 
that you might receive from Supervisor and outlines basic 
troubleshooting procedures for the error messages.
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The following conventions are used in this book:

● This document assumes that you are familiar with your computer and 
the Windows operating system including standard window conventions, 
such as using the F1 key to activate Help.

● Windows 3.x refers to the following operating systems:

— Windows 3.1

— Windows for Workgroups 3.11

— Windows NT 3.51.

● Unless the right mouse button is specified, use the left mouse button 
whenever you are instructed to click or select an item.

● Menu names and option names are shown in bold text. For example: 
Choose Save from the File menu.

● References to windows are capitalized. For example, Manual Login 
window.

● Italics are used to reference other documents, to reference file names, 
and to indicate trademarks.

● Sections and chapters that are referred to in text are shown in quotes. 
For example: See Chapter 1, “Introduction,” for an outline of the 
information in this book.

● A graphic of each Supervisor window is not included in this book. 
Graphics are provided to give you general information about a type of 
window or to help clarify a procedure that is being described. The 
examples in this book are taken from Supervisor running in Windows 95.

● The DEFINITY® Enterprise Communications Server is referred to as 
ECS. Earlier versions of this product are referred to as “switch” (for 
example, “… an ECS or switch without EAS”).
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The following documents include additional information about the CMS or 
Supervisor:

● CentreVu Supervisor Version 5 User Guide (585-215-829*)

● CentreVu Supervisor Version 5 Installation and Getting Started
(585-215-830)

● CentreVu Report Designer Version 5 User Guide (585-215-831)

● CentreVu Supervisor Version 5 Change Description (585-215-832)

● CentreVu CMS R3V5 Administration (585-215-820)

● CentreVu CMS R3V5 Real-Time and Historical Reports (585-215-821)

● CentreVu CMS R3V5 Custom Reports (585-215-822)

● CentreVu CMS R3V5 Change Description (585-215-823)

● CentreVu CMS R3V5 External Call History Interface (585-215-824)

● CentreVu CMS R3V5 Forecast (585-215-825)

● CentreVu CMS R3V5 Upgrades and Migration (585-215-826)

● CentreVu CMS R3V5 Sun SPARCserver Computers Installation and 
Maintenance (585-215-827)

● CentreVu CMS R3V5 Sun SPARCserver Computers Connectivity Diagram 
(585-215-828).

● CentreVu CMS R3V5 Real-Time and Historical Reports, International 
Version (585-215-833†)

*This document is also available in the following languages: French (FR), Dutch 
(NL), Japanese (JA), Portuguese (PTB), German (DE), and Columbian Spanish 
(ESC). A two- or three- letter code after the ordering number indicates the 
language of the document.
†This document is not available in English. A two- or three- letter code (see 
above) after the ordering number indicates the language of the document.
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Supervisor Basics 2

Introduction 2

This chapter outlines the features of the Supervisor application and teaches 
you general procedures for using Supervisor.

The sections in this chapter are as follows:
● Starting Supervisor
● Logging Into the CMS Server
● Logging Off of the CMS Server
● Exiting Supervisor
● The Controller — Not Logged Into the CMS Server
● The Controller — Logged Into the CMS Server
● Using the System Tray Icon
● Using Supervisor Menus
● Using Supervisor Selector Windows
● Adding Bookmarks
● Completing Input Windows
● Completing Input Fields
● Using the Browse Buttons
● Using the History List
● Closing Supervisor Windows.
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Based on which version of Windows* you are running, use the steps below to 
start the Supervisor application.

● For Windows 3.x:

1. Double click on the Lucent CentreVu Supervisor Program Group.

2. Double click on the CentreVu Supervisor icon .

● For Windows 95 and Windows NT 4.0:

1. Select Start from the task bar.

2. Select Programs from the Start menu.

3. Select the Lucent CentreVu Supervisor program group.

4. Select CentreVu Supervisor from the menu .

The Supervisor application opens and is running. The Controller (shown 
below) displays. Supervisor is now running, but you are not yet logged into 
the CMS server.

The Controller is the Supervisor main window. You will use the toolbar 
buttons and pull-down menus to access the CMS server. The following 
figure illustrates how the Controller appears before logging into the CMS 
server:

*Windows is a registered trademark of Microsoft Corp.

Note See the “The Controller — Not Logged Into the CMS Server” and 
“The Controller — Logged Into the CMS Server” sections in this 
chapter for more information on using the Controller.
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Logging Into the CMS Server 2

From the Supervisor Controller, you can connect to the CMS server in either 
of the following ways:

● Automatically — opens an input window in which you enter your login 
ID and password. Once you select OK, the connection to the CMS server 
is automatically started.

● Manually — opens a login window that requires you to enter your login 
ID, your password, the terminal type, and then to manually log into 
CMS. Manual login is typically used for troubleshooting and for the 
CMS Services and CMS Administration login IDs. 

You can use the Connect menu or the Login button to log into the CMS 
server.

Note If you use Automatic Login to connect to the CMS server and 
the connection is broken or dropped while you are logged into 
the server, Supervisor attempts to restore the connection.

1 2

1. Connect Menu
2. Login Button
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To start the CMS server connection using the automatic login, do the 
following steps:

1. Select Login from the Connect menu, or click the Login button  on 
the toolbar.

2. The Login Information window appears:

3. Type your CMS login ID in the Login ID: text box, or select your login 
ID from the drop-down list.

4. Tab to the Password: text box. 

5. Type your CMS password in the Password: text box.

At this point, you may see the Confirm Password window. This window 
reports that your password has expired and must be changed. Follow 
the prompts and type in a new password.

6. Select OK.

A message box indicates that Supervisor is connecting to the CMS 
server.

7. The Supervisor Controller displays. It now includes the Commands and 
Bookmarks menus and additional items, which relate to CMS, in the 
Tools menu.

Note The buttons that appear on the toolbar and the menu items available 
in the Commands and Tools menus depend on how your CMS user 
permissions are set up.

Login ID Text Box

Drop-Down List
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Manual Login 2

To start the CMS server connection using the manual login, do the following 
steps:

1. Select Login from the Connect menu, or click the Login button  on 
the toolbar.

2. The Manual Login window appears.

3. At the login: prompt, enter your CMS Login ID.

4. At the Password: prompt, enter your CMS password.

5. If the Enter Terminal Type: prompt displays, enter cvsup .

6. If the UNIX* prompt displays, enter cms.

7. At the Input Terminal Type: prompt, confirm that the terminal 
type is cvsup and press Enter. If it does not default to cvsup, enter 
cvsup.

8. The Supervisor Controller displays. It now includes the Connect, 
Commands, Tools, Bookmarks, and Help menus.

*UNIX is a registered trademark of Novell, Inc. in the United States and other 
countries licensed exclusively through X\Open Corporation.

Note The buttons that appear on the toolbar, and the menu items 
available in the Commands and Tools menus depend on how your 
CMS user permissions are set up.

3

4

5

6

7
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To log off of the CMS server, do any of the following steps:

● Select Logout from the Connect menu, 

● Click on the Logout button  on the toolbar, or 

● Select Exit from the Connect menu.

If you select the Logout button or select Logout from the Connect menu, the 
application responds with an “Are you sure you want to logout?” message. 
Select OK to log off of the CMS server, but keep the Supervisor application 
running.

If you select Exit from the Connect menu, the application responds with a 
“You are currently logged in. Are you sure you want to exit?” message. 
Select Yes to log off of the CMS server and to close the Supervisor 
application.

Connect Menu Logout Button
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Exiting Supervisor 2

To exit from the Supervisor application, do the following steps:

1. Select Exit from the Connect menu.

If you try to exit from the Supervisor application before logging off of the 
CMS server, the following message displays:

If you select Yes, Supervisor automatically logs you off of the CMS server 
and then exits from the application.

If you select No, you are returned to the Controller and remain logged into 
the CMS server.
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The Controller — Not Logged Into the CMS  
Server 2

This section details the Controller window as it appears when you are not 
logged into the CMS server. The following graphic illustrates the basic 
Controller window:

System Menu Box 2

A common Windows convention. The system menu box allows you to 
perform common windows conventions, such as closing the current 
window or application.

Title Bar 2

A common Windows convention. The title bar shows the name of the 
application.

4

2
3

1

1. System Menu Box
2. Title Bar
3. Maximize/Minimize/Close Window Sizing Buttons
4. Status Bar
5. Toolbar
6. Menu Bar
7. Login Status Indicator

5 6 7
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Toolbar 2

The toolbar contains buttons that are used for quick access to specific 
features of the application. When you are not logged into the CMS server, 
the two buttons available on the toolbar are as follows:

When you move your cursor over a toolbar button, a tooltip displays next to 
your mouse pointer with a brief description of the command the button 
performs. The status bar also displays a description of the command that 
particular button performs.

Maximize, Minimize, and Close Buttons 2

A common Windows convention. These buttons adjust the size of the 
window, or close the window.

Status Bar 2

The status bar is located at the bottom of the Controller window. It displays 
a brief description of each of the toolbar buttons when the cursor is over the 
button. The status bar also includes a Login Status Indicator, which shows a 
green light if you are currently logged into the CMS server, or shows a gray 
light if you are not logged into the CMS server.

Button Name Command

Options Accesses the window needed to change 
your login options. 

See Chapter 10, “Options,” for more 
information.

Login Initiates a connection to the CMS server.
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Menu Bar 2

A common Windows convention. The menu bar lists the available drop-
down menus. When you are not logged into the CMS server, the menu bar 
has the following menus available:

● Connect

● Tools

● Help.

The following sections outline the options available from each menu.

Connect 2

From this menu, you can initiate or discontinue a connection to the CMS 
server. The Connect menu, shown below has the following options:

Menu Item Action

Login Selecting the Login from the Connect menu displays 
the Manual Login window if the Manual Login Option 
is set and displays item in the Automatic Login 
window if the Manual Login Option is not set.

Logout Selecting Logout from the Connect menu allows you 
to log out of the CMS server. This menu item is 
disabled because you are not currently logged into the 
CMS server.

Exit Selecting Exit from the Connect menu closes the 
Supervisor application.
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Tools 2

The Tools menu (shown below) has the following options:

Menu Item Action

Options... Selecting Options from the Tools menu or selecting 
the Options button on the toolbar, opens the Options 
window. When you are not logged into the CMS 
server, you can set standard Supervisor 
communications options in the Options window. The 
Communication and Modem tabs are available when 
you are not logged into the CMS server.

For more information on the Options tool, see Chapter 
12, “Options.”

Advanced... Selecting Advanced... from the Tools menu opens the 
Advanced window. This menu item is used for 
debugging purposes. Do not change the settings on 
the Advanced window unless you are instructed to do 
so by a Lucent Technologies associate.

Add 
Button...

Selecting the Add Button tool starts the Add Button 
wizard, which steps you through the process of 
creating a button and adding it to the toolbar.

For more information on the Add Button tool, see 
Chapter 13, “Editing the Toolbar.”

Remove 
Button...

Selecting the Remove Button tool displays a window 
that tells you how to remove a button from the 
toolbar.
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Help 2

You can access Supervisor on-line help from all windows by doing any 
of the following steps:
● Pressing the F1 key — displays help specific to the current window.
● Selecting the Help button (if available) — displays help specific to 

the current window.
● Selecting Help from the menu bar (shown below) — allows you to 

choose from the following options:

Menu Item Action

Contents Selecting Contents opens the Supervisor on-
line help table of contents.

Search for Help On... Selecting Search opens the Search window. 
Follow the instructions within this window to 
easily select specific help information on a 
given topic.

Index Selecting Index opens a Supervisor help 
alphabetical index.

Technical Support Selecting Technical Support opens a window 
that provides Technical Support information.

About... Selecting About opens the Supervisor Help 
About window, which shows the software 
version number.
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The Controller — Logged Into the CMS Server 2

This section details the Controller window as it appears when you are 
logged into to the CMS server. The following graphic shows the basic layout 
of the Supervisor Controller once you have logged into the CMS server.

Depending on what your CMS user permissions are, some menu items and 
toolbar buttons may not be accessible to you. 

Note The System Menu Box, Title Bar, and Maximize/Minimize buttons 
are not defined below because they work the same when you are 
logged into the CMS server as they do when you are not logged into 
the server.

6

2

9 107

5

8

1

1. System Menu Box
2. Title Bar
3. Menu Bar
4. Toolbar
5. Maximize/Minimize

6. Status Bar
7. Login Status Indicator
8. Exception Count
9. ACD Status Indicators
10. Current CMS Date and Time

Window Sizing Buttons

3 4
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Toolbar 2

The toolbar contains buttons that are used for quick access to specific CMS 
commands and tools. Based on your CMS user permissions, some or all of 
the following buttons will appear on your toolbar.

Button Name Command

Options Accesses the window needed to change 
your environment options. 

See Chapter 10, “Options,” for more 
information.

Logout Disconnects from the CMS server.

Reports Initiates the Reports command.

See Chapter 5, “Reports,” for more 
information.

Dictionary Initiates the Dictionary command.

See Chapter 6, “Dictionary,” for more 
information.

Exceptions Initiates the Exceptions command.

See Chapter 8, “Exceptions.” for more 
information.

ACD Administration Initiates the ACD Administration 
command.

See Chapter 9, “ACD Administration,” 
for more information.

CMS System Setup Initiates the CMS System Setup tool.

See Chapter 12, “CMS System Setup,” for 
more information.
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When you move your cursor over a toolbar button, the status bar gives a 
description of what the toolbar button does.

Status Bar 2

The status bar is located at the bottom of the window and is used to display 
CMS application status. It is also used to display a brief description of each 
of the toolbar buttons when the mouse pointer is over the button. 

● Login Status Indicator — shows a green light if you are connected to 
the CMS server, or shows a gray light if you are disconnected from the 
CMS server.

● Exception Count — gives you the current count of exceptions for all 
ACDs for which you have exception permissions. The exceptions count 
is cleared to zero at the beginning of the interval. For information on 
CMS exceptions, refer to the CentreVu CMS Administration 
(585-215-820) document.

● ACD Status Indicators — shows which ACDs are active/inactive. 
There can be up to four ACD icons showing, depending on how many 
ACDs this CMS supports. If the link to any one of the ACDs is down, the 
icon will be crossed out. If you place your mouse over the ACD Status 
Indicator, a tooltip will pop up and tell you the name of the current 
ACD.

● Current Date and Time — shows the current date and time of the CMS 
server you are logged into.

Maintenance Initiates the Maintenance tool.

See Chapter 13, “Maintenance,” for more 
information.

User Permissions Initiates the User Permissions tool.

See Chapter 14, “User Permissions,” for 
more information.

Button Name Command
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Menu Bar 2

A common Windows convention. The menu bar lists the available menus. 
When you are logged into the CMS server, there are four menus available on 
the menu bar:

● Connect

● Commands

● Tools

● Help.

The following paragraphs outline the options available from each menu.

Note The Commands menu item is available only when you are logged 
into the CMS server. All of the options in the Commands menu are 
CMS-specific.
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Connect 2

The Connect menu shown below has the following options:

Menu Item Action

Login When you select Login from the Connect menu, a 
login to the CMS server is started. This menu item is 
disabled when you are connected to the CMS server.

This Login should not be confused with the login of 
any other application or network that you can perform 
on your PC.

Logout Selecting Logout from the Connect menu or the 
Logout button on the toolbar allows you to log out of 
the CMS server. When you select Logout, a message 
box confirming the logout action displays. If you select 
OK, the logout sequence begins. Once the logout is 
complete, Supervisor is still open but you are not 
connected to the CMS server.

Exit Selecting Exit from the Connect menu closes the 
Supervisor application. If you are logged into the CMS 
server when you select Exit, a message box notifies 
you that you are logged in and asks if you wish to 
continue the exit. If you select Yes, you are 
automatically logged out of the CMS server and 
Supervisor is closed. If you select No, the exit is 
cancelled and you are returned to the Controller, still 
logged into the CMS server.
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Commands 2

The Commands menu shown below gives you access to the Reports, 
Dictionary, Exceptions, and ACD Administration subsystems in CMS. 

Menu Item Action

Reports When you select Reports from the Commands menu 
or select the Reports button on the toolbar, the Reports 
selector window opens. You will see the following 
tabs to choose from:

● Real-Time

● Historical

● Integrated.

Note Any Custom Reports you have created are 
ported to Supervisor. You can view and print the 
reports in Supervisor. To edit the reports, or 
create new ones, use the Terminal Emulator or a 
CMS terminal.

From the Reports command, you can view, print, and 
export data from all of the standard CMS reports, 
Custom CMS Reports, Supervisor Integrated and 
Graphical reports, and Report Designer reports.
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Dictionary When you select Dictionary from the Commands 
menu or select the Dictionary button on the toolbar, 
the Dictionary selector window opens. You will see 
the following tabs to choose from:

● Operations

● Reports.

From the Dictionary command, you can assign names 
to splits/skills, trunk groups, call work codes, reason 
codes, ACDs, VDNs and vectors, enter and edit agent 
names and agent groups, view and define CMS 
database items and calculations, and modify 
split/skill and trunk string values.

For more information on the Dictionary command, 
see Chapter 7, “Dictionary,” in this book and refer to 
the CentreVu CMS Administration (585-215-820) 
document.

Exceptions When you select Exceptions from the Commands 
menu or select the Exceptions button on the toolbar, 
the Exceptions selector window opens. You will see 
the following tabs to choose from:

● Operations

● Reports.

From the Exceptions command, you can administer 
timing or counting-based thresholds for exceptions 
and report on those exceptions.

For more information on the Exceptions command, 
see Chapter 8, “Exceptions,” in this book and refer to 
the CentreVu CMS Administration (585-215-820) 
document.
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ACD 
Administration

When you select ACD Administration from the 
Commands menu or select the ACD 
Administration button on the toolbar, the ACD 
Administration selector window opens. You will 
see the following tabs to choose from:

● Operations

● Reports.

From the ACD Administration command, you 
can view, add, delete, or modify ACD-related 
parameters on the switch.

For more information on the ACD Administration 
command, see Chapter 9, “ACD Administration,” 
in this book and refer to the CentreVu CMS 
Administration (585-215-820) document.
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Tools 2

The Tools menu, in addition to accessing the Options window and the 
Add Button and Remove Button wizards, gives you access to the CMS 
System Setup, Maintenance, and User Permissions subsystems. The 
Tools menu has the following options:.

Menu Item Action

Options... When you select Options from the Tools menu or 
select the Options button on the toolbar, the Options 
window opens. You can set standard Supervisor 
preferences in the Options window. You will see the 
following tabs to choose from:

● General

● Report Colors

● Threshold Colors

● Name Format.

The Communications and Modems tabs are grayed-
out because the Supervisor connection is already 
established.

For more information on the Options tool, see 
Chapter 12, “Options.”

Advanced... This menu item is used for debugging purposes. Do 
not change the settings on the Advanced window 
unless you are instructed to do so by a Lucent 
Technologies associate.
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Add 
Button...

Selecting the Add Button... tool starts the Add 
Button wizard, which steps you through the process 
of creating a button and adding it to the toolbar.

For more information on the Add Button... tool, see 
Chapter 13, “Editing Your Toolbar.”

Remove 
Button...

Selecting the Remove Button tool displays a window 
that tells you how to remove a button from the 
toolbar.

CMS 
System 
Setup

When you select CMS System Setup from the Tools 
menu or select the CMS System Setup button on the 
toolbar, the CMS System Setup selector window 
opens. The only active tab in the CMS System Setup 
tool is the Operations tab.

From CMS System Setup you can view and modify 
information relevant to how the CMS and switch 
were configured during installation.

For more information on the CMS System Setup 
tool, see Chapter 12, “CMS System Setup,” in this 
book and refer to the CentreVu CMS Administration 
(585-215-820) document.

Menu Item Action

829.bk : superbasics.fm  Page 22  Wednesday, November 20, 1996  3:09 PM



 The Controller — Logged Into the CMS Server 2-23

Supervisor Basics

C
ha

pt
er

 2

Maintenance When you select Maintenance from the Tools menu 
or select the Maintenance button on the toolbar, the 
Maintenance selector window opens. You will see 
the following tabs to choose from:

● Operations

● Reports.

Maintenance is where you perform routine 
maintenance of the CMS, including backing up data, 
checking on the status of the connection to the 
switch, and scanning the error log.

For more information on the Maintenance tool, see 
Chapter 10, “Maintenance,” in this book and refer to 
the CentreVu CMS Administration (585-215-820) 
document.

User 
Permissions

When you select User Permissions from the Tools 
menu or select the User Permissions button on the 
toolbar, the User Permissions selector window 
opens. The only active tab in the User Permissions 
tool is the Operations tab.

User Permissions is where the CMS Administrator 
defines CMS user IDs and access capabilities each 
user will have.

For more information on the User Permissions tool, 
see Chapter 11, “User Permissions,” in this book and 
refer to the CentreVu CMS Administration 
(585-215-820) document.

Menu Item Action
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Bookmarks 2

The Bookmarks menu gives you access to the Edit Bookmarks window 
and shortcuts to any operations or reports for which you have added 
bookmarks. The Bookmarks menu, prior to assigning any bookmarks, 
appears as follows:

Help 2

The Help menu is the same when you are logged into the CMS as it is 
when you are not connected.

Menu Item Action

Edit 
Bookmarks

When you select Edit Bookmarks from the 
Bookmarks menu, the Edit Bookmarks window is 
opened. 

From the Edit Bookmarks window, you can view and 
rearrange the bookmarks you have assigned in 
Supervisor. 

For more information on Bookmarks, see Chapter 14, 
“Bookmarks.””

List of 
assigned 
bookmarks

When you select the Add Bookmark button on a 
selector window, the report or operation that was 
highlighted at the time is added to your list of 
available bookmarks. You can use the bookmarks list 
to bypass the selector window and go directly to the 
input window for the report or operation.
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Using the System Tray Icon 2

If you are running Supervisor with Windows 95 or Windows NT 4.0, the 
Supervisor icon resides in the system tray while the application is running. 

You can use the system tray icon in the following ways:

● When a real-time report threshold highlight Caution or Warning 
condition is met, the system tray icon will change to the 
Caution/Warning icon (as appropriate).

● Select the system tray icon to display a list of all of the Supervisor 
windows that you have open. You can then select a window from the list 
to make it the current window.

If a report threshold highlight Caution or Warning condition has been 
met, the Caution/Warning icon (as appropriate) is displayed next to the 
report(s) affected by that condition.

Depending on the state shown for the system tray icon, one of the following 
things happens when you double click on the icon:

● If the Supervisor icon is shown, the Controller becomes the current 
window.

● If the Caution icon is shown, all reports that are currently running with 
a caution condition are brought to the front.

● If the Warning icon is shown, all reports that are currently running with 
a warning condition are brought to the front.

You can control the sort order of the system tray icon menu and turn the 
feature on and off on the Tools | Options General tab. For more 
information, see Chapter 12, “Options.”
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Using Supervisor Menus 2

Each Supervisor menu item can be selected by doing any of the following 
steps: 

● Clicking on the item

● Using the arrow keys to highlight the item and then pressing Return 

● Using the assigned Windows shortcut key (hold down the Alt or Ctrl key 
and press the letter that is underlined in the word you want to select).
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Using Supervisor Selector Windows 2

A selector window is the window that displays after you select an item from 
the Commands or Tools menu. An example (the Command | Exceptions 
Operations tab selector window) is shown below.

Tab Folders 2

Typically, there are two tab folders, Operations and Reports, on any 
Commands or Tools selector window. The exceptions to this are the 
Commands | Reports selector window, which has Real-Time, Historical, 
and Integrated tabs and the Tools | Options window, which has General, 
Report Colors, Threshold Colors, Name Format, Communications, and 
Modem tabs.

Select the appropriate tab to bring that folder to the front.

1

2

1. Tab Folders
2. Available Windows
3. Current ACD
4. Add Bookmark Button
5. OK, Cancel, Help (and Apply) Buttons 

3

5
4
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Available Windows 2

Highlight an item from the list of available windows (usually operations or 
reports) using your up and down arrow keys or the mouse, and then select 
OK to open that window.

Current ACD 2

This text box shows the ACD that is currently selected.

Add Bookmarks Button 2

Bookmarks are tags you can use to easily access operations and reports you 
use often. To insert a bookmark on a report or operation, do the following 
steps: 

1. Highlight the item in the selector box.

2. Select the Add Bookmark button.

For more information on using the Bookmarks feature of Supervisor, see 
Chapter 14, “Bookmarks.”

OK, Apply, Cancel, and Help Buttons 2

The OK, Apply, Cancel, and Help buttons you see on Supervisor windows 
perform standard Windows actions. When you select each button, the result 
is the following:

● OK — accepts the current input and continues to the next window.

● Apply — applies the current input, but does not continue to the next 
window.

● Cancel — cancels the current input and returns you to the previous 
window.

● Help — opens the help topic specific to this window.
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Completing Input Windows 2

Once you have selected an operation or report, an input window displays. 
The information required on the input window depends on where you are 
in the system. An example of an input window is shown below.

1. Menu Bar
2. Toolbar Action(s)
3. Input Field(s)
4. Browse Button
5. History List
6. Current ACD

1

2

3

4

5

6
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Input windows have all or some of the following items:

● Menu Bar — includes menus for CMS Actions (Add, Delete, Find One, 
Next, Previous, List All, and Exit), Edit options (Cut, Copy, Paste, and 
Clear All), and Supervisor Help.

● Toolbar Action Buttons — let you perform CMS actions (Add, Delete, 
Find One, Next, Previous, List All, and Exit) by clicking on a button. See 
Chapter 3, “Operations Basics,” for more information on the action 
buttons.

● Input Fields — text boxes where you type in the information needed to 
complete the CMS action.

● History List — displays a list of inputs you have previously used in the 
input field.

● Browse Button — lets you browse through all possible items for the 
input field. See the “Using the Browse Button” section in this chapter, 
and the “Selecting Report Run Dates” and “Selecting Report Run 
Times” sections in Chapter 4, “Reports Basics,” for more information.

● Current ACD — displays the ACD on which you are working.
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Completing Input Fields 2

Below is an example of an input window with the items related to 
completing input windows labeled.

You can complete an input field by doing one of the following actions:

● Type in the information requested.

● Select the information from the history list of previously used items.

During each CMS session, Supervisor recalls the items you have 
previously selected for each input field. If an input field has an 
associated history list, you can use the history list to select an item for 
the input field.

● Use the Browse button to view all available items for the input field, 
and then select an item(s) for the input field. See the “Using the Browse 
Button” section in this chapter, and the “Selecting Report Run Dates” 
and “Selecting Report Run Times” sections in Chapter 4, “Reports 
Basics,” for more information.

1 321. Input Field(s)
2. History List
3. Browse Button

829.bk : superbasics.fm  Page 31  Wednesday, November 20, 1996  3:09 PM



2-32 Using the Browse Button

Supervisor Basics

Using the Browse Button 2

When you select the Browse button, a window opens that lets you select 
items for the input field. 

● If the input is for a single entity (split/skill, vector, agent, VDN, trunk, 
or trunk group), a browse selection window similar to the following 
example displays: 

To use this window, do the following steps:

1. Click on the name/number of the entity that you want to work 
with.

2. Select OK.

The input window displays and the input field is populated with 
the name/number of the entity that you selected in the Browse 
window.
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● If the input allows for multiple entries of the entity (split/skill, vector, 
agent, VDN, trunk, or trunk group), a browse selector window similar 
to the following examples displays:

To use this window, do the following steps:

1. In the Choices box, click on the entity names/numbers you want to 
work with. 

You can select the entities individually or by selecting a range. To 
select a range, do the following steps:

a. Select the Range of... option.

b. In the First: input field, type the beginning entity number for 
the range.

c. Tab to the to Last: input field.

d. In the to Last: input field, type the ending entity number for the 
range.

For example, if your call center has skills 1, 2, 3, 4, and 5 and you 
want to select all of them, you can type 1 in the First: input field 
and type 5 in the to Last: input field.

2. Select Add>>.

Note You can use a combination of selecting entities from the 
Choices box and selecting a range of entity numbers.
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The entities that were highlighted in the Choices box are now listed 
in the Selected ... box.

3. Select OK.

The input window displays and the input field is populated with 
the name/number of the entities that you selected in the Browse 
window.
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Using the History List 2

To the left of each entity input field, there is a drop-down history list. The 
history list shows values you have previously entered in this field.

You can use the history list to select the entity that you would like to include 
for the report/operation that you are running by doing the following steps:

1. Place the cursor in the input filed.

2. Select the history list button.

3. Point and click the mouse cursor on the item that you would like to add 
to the input field.

The history list closes and the item is added to the input field.

1 321. Input Field(s)
2. History List
3. Browse Button
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Closing Supervisor Windows 2

To close Supervisor windows, use any of the standard Windows methods or 
select Exit from the Connect menu. Selecting Exit from the Connect menu 
closes all windows and quits the application.

If the Controller is closing a window due to the CMS server shutting down 
or changing to single-user mode, a warning message is issued and then any 
open windows are closed. 
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3
Operations Basics 3

Introduction 3

This chapter gives you general information about how to use the windows 
you access from the Supervisor Operations tabs. You will find Operations 
tabs available under the following commands and tools:

● Commands|Dictionary

● Commands Exceptions

● Commands|ACD Administration

● Tools|CMS System Setup

● Tools|User Permissions

● Tools|Maintenance.

Note If information applies to a specific Operations tab (Dictionary, 
Exceptions, ACD Administration, CMS System Setup, User 
Permissions, or Maintenance), then that information is in the 
appropriate chapter. For instance, ACD Administration has 
several procedures specific to that command, so those procedures 
are located in the “ACD Administration” chapter.
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No matter which command or tool you use to select an operation, how you 
perform the operation is the same. The information in this chapter teaches 
you about the menus and inputs you will find when performing CMS 
operations in Supervisor. The sections in the chapter are as follows:

● Running an Operation

● Operations Menus

● Adding Items in an Operations Window

● Finding Items from an Operations Window (using Find one and List all)

● Modifying Items in an Operations Window

● Deleting Items from an Operations Window.
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Running an Operation 3

To run an operation, do the following steps:

1. Select one of the following windows:
● Commands | Dictionary Operations tab
● Commands | Exceptions Operations tab
● Commands | ACD Administration Operations tab
● Tools |CMS System Setup Operations tab
● Tools | User Permissions Operations tab
● Tools | Maintenance Operations tab.

2. Select an operation from the Operations list box.

3. Select the ACD for which you want to perform the operation.

4. Select OK.

The operation input window displays. The inputs required will vary, 
depending on which operation you are running. 

5. Complete the operation input window. 

The following example (from the Commands | Dictionary Operations 
tab) shows the possible types of information that might be required to 
complete an operation input window.

1 321. Input Field(s)
2. History List
3. Browse Button
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● Fill in the input field(s). Input fields are where you specify the 
information that you would like to view, add, modify, or delete. 

To complete the input fields, you can use any of the following 
methods:

— Type in the name or number of the input requested.

— Press the Browse button to view all of the available inputs.

— Use the history list to select an input that you have 
previously used.

● Ensure that the correct ACD is selected. The current ACD (selected 
on the Operations selector window) is displayed at the bottom of 
the input window.

If you want to perform an operation for a different ACD than is 
currently selected, do the following steps:

a. If you are in an input window, select the Cancel button to exit 
the input window.

b. Go to the selector window you chose in Step 1.

c. Change the ACD on the selector window.

d. Select the operation you want to perform.

e. Select OK.

The input window displays again and the input fields are populated 
with any inputs that you may have previously entered.

6. Select OK.

The operation runs.
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Operations Menus 3

The Actions and Edit menu options are commonly found on windows that 
you access from the Operations tab. 

Actions Menu 3

The Actions menu is found in the Dictionary, Exceptions, Maintenance, 
CMS System Setup, User Permission, and some ACD Administration 
operations windows. Actions are used to perform CMS-related functions. When 
the Actions menu item is available, the menu bar looks like this:

This menu contains all of the CMS actions that are available in your current 
window. The menu items and their associated buttons on the toolbar are in 
the same order. For example, Add, Delete and Modify are grouped together 
as are Find One, Next, Previous, and List All. The Exit selection is always 
last in the menu and the last button on the toolbar.

The following table lists the Actions menu items, their associated buttons, 
and a definition of each action. Not all of the actions will be available to you 
all of the time. If an action is not available in the current window, it is 
grayed-out on the Actions menu list and does not appear on the toolbar.
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Action Button Description

Add Adds the data entered in your current 
window to the database.

Cancel Cancels the operation that is in progress.

Copy Group/ 
Create

Creates a new group from an existing one.

Delete Removes the entry on your current window 
from the database.

Exit Exits the window and other associated 
windows.

Find one Searches the database for entries that match 
the input values in your current window.

Get contents Provides access to the members of the agent 
group.

List All Lists all the entries that matched the current 
field values.

List Devices Lists all the devices which have been 
specified in the Backup/Restore Devices 
window.

Modify Changes the database entry to reflect the 
new values entered in your current window.

Next Once you have used the Find One function, 
this displays the next match found. 
Otherwise, this button is disabled.

Previous Once you have used the Find One function, 
this displays the previous match found. 
Otherwise, this button is disabled.

Run/Start Starts the process for your current window.

Select tables Allows you to select specific tables to Back 
Up or Restore.
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Edit Menu 3

The Edit menu is found in the Dictionary, Exceptions, Maintenance, CMS 
System Setup, User Permission, and some ACD Administration 
operations windows. Edit options are used to perform functions that are related to 
Microsoft* Windows†. When the Edit menu item is available, the menu bar 
(and Edit menu) looks like this:

The Edit menu has the following options:

*Microsoft is a registered trademark of Microsoft Corporation.
†Windows is a registered trademark of Microsoft Corporation.

Menu Item Shortcut Action

Cut Ctrl + X A standard Windows feature that 
removes selected text and places it on the 
clipboard. This item is available on 
windows that have input fields.

Copy Ctrl + C A standard Windows feature that copies 
selected text to the clipboard. This item is 
available when text is selected in the 
window or the cell is selected in a List 
All window.
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Paste Ctrl + V A standard Windows feature that inserts 
a copy of the contents of the clipboard at 
the insertion point or replaces the 
selection (if any) with the text on the 
clipboard. This item is available only on 
windows that have input fields and 
when the clipboard is not empty.

Clear all Ctrl + E A feature that is available only on 
windows that have input fields. This 
menu item clears all of the values 
entered in the input fields. Option 
buttons are returned to the default value.

Menu Item Shortcut Action
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Adding Items to the CMS Database 3

Once you have selected an operation, an input window displays. You may 
want to add an item to the CMS (such as an agent group, a CMS user ID, or 
agent login IDs). To add items from an operations input window, do the 
following steps:

1. Fill in the information required in the input fields.

2. Select Add from the Actions menu, select the Add button  on the 
toolbar, or press Ctrl+A.

If the Add is successful, the status bar at the bottom of the window 
reads “Successful.” If you do not have the required write permissions to 
perform the Add you attempted, the status bar reads “Failed” and an 
error message displays.
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Finding Items in the CMS Database 3

Once you have selected an operation, an input window displays. You may 
want to work with an item in the CMS (such as an agent group, a CMS user 
ID, or agent login IDs), but do not recall how that entity is named or specific 
details about the entity. You can use List all or Find one from the Actions 
menu to locate items in the CMS.

The following sections teach you how to use List all and Find one in 
Supervisor.

List All 3

You will use List all when you do not recall any of the specific information 
about an entity, or to list all of the entities of a specific type to see if any 
already exist that meet your needs. 

To list all of the items related to an operations window, do the following 
steps:

1. Leave the text boxes on the input window blank to list all of this type of 
entity that exist on the CMS, or complete specific text boxes to refine the 
list to a specific range of output.

2. Select List all from the Actions menu, select the List all button  on 
the toolbar, or press Ctrl+L.

A list displays all of the items that exist on the CMS and match any 
criteria of the you entered on the input window displays.

Find one 3

You will use Find one when you know some (or all) of the specific 
information about an entity, or when you want to list all of the entities of a 
specific type one-by-one. 

To find one entity at a time, do the following steps:
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1. Complete all or some of the text boxes on the input window to try to 
find a match, or leave the text boxes blank to list, one-by-one, all of this 
type of entity that exist on the CMS.

This is your find criteria.

2. Select Find one from the Actions menu, select the Find one button  
on the toolbar, or press Ctrl+F.

The text boxes are completed with information related to the first entity 
that matches the find criteria for which you have permissions.

3. If there is more than one match, the status bar reads “xx matches 
found.” You can scroll through the find one matches by selecting Next 
and Previous from the Actions menu, by selecting the Next button  
and Previous button  on the toolbar, or by pressing F3 for Next or 
Shift-F3 for Previous.

Note For more information on List all and Find one, refer to the CentreVu 
CMS Administration (585-215-820) document.
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Modifying Items in the CMS Database 3

Once you have selected an operation, an input window displays. You may 
want to modify the information for an item that already exists in the CMS 
(such as an agent group, a CMS user ID, or agent login IDs). To modify items 
from an operations input window, do the following steps:

1. Depending on the information you know about the entity to be 
modified, do one of the following actions:
● If you know all or part of the specific information required for the 

input text boxes:

a. Complete the text boxes for which you have information.

b. Select Find one from the Actions menu, select the Find one 
button  on the toolbar, or press Ctrl+F. The input window 
displays with the appropriate information.

● If you do not know the specific information required for the input 
text boxes, do the following:

a. Select List all from the Actions menu, select the List all button 
 on the toolbar, or press Ctrl+L. 

b. Locate the information for the entity that you want to modify 
and note the relevant information.

c. Close the List all window. The input window displays.

d. Complete the text boxes for which you have information.

e. Select Find one from the Actions menu, select the Find one 
button  on the toolbar, or press Ctrl+F. The input window 
displays with the appropriate information.

2. Update the information in the text boxes.

3. Select Modify from the Actions menu, select the Modify button  on 
the toolbar, or press Ctrl+M. If the Modify is successful, the status bar at 
the bottom of the window reads “Successful.” If you do not have the 
required write permissions to perform the Modify you attempted, the 
status bar reads “Failed” and an error message displays.
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Deleting Items from the CMS Database 3

Once you have selected an operation from the Operations tab, an input 
window displays. You may want to delete an item that already exists in the 
CMS (such as an agent group, a CMS user ID, or agent login IDs). To delete 
items from an operations input window, do the following steps:

1. Depending on the information you know about the entity to be deleted, 
do one of the following:
● If you know all or part of the specific information required for the 

input text boxes:

a. Complete the text boxes for which you have information.

b. Select Find one from the Actions menu, select the Find one 
button  on the toolbar, or press Ctrl+F.

The input window displays with the appropriate information.
● If you do not know the specific information required for the input 

text boxes, do the following:

a. Select List all from the Actions menu, select the List all button 
 on the toolbar, or press Ctrl+L. 

b. Locate the information for the entity that you want to delete and 
note the relevant information.

c. Close the List all window.

The input window displays.

d. Complete the text boxes for which you have information.

e. Select Find one from the Actions menu, select the Find one 
button  on the toolbar, or press Ctrl+F.

The input window displays with the appropriate information.

2. Select Delete from the Actions menu, select the Delete button  on 
the toolbar, or press Ctrl+D.

3. If the delete is successfully completed, “Successful” displays in the 
status bar.

Warning
No warning message will display when you select Delete. The 
item you have specified for deletion from the CMS database 
will automatically be deleted.
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Reports Basics 4

Introduction 4

This chapter gives you general information about how to use Supervisor 
reports. You will find reports available under the following menus and tabs:

● Commands | Reports | Real-Time, Historical, or Integrated tab

● Commands | Dictionary | Reports tab

● Commands | Exceptions | Reports tab

● Commands | ACD Administration | Reports tab

● Tools | Maintenance | Reports tab.

Note Procedures that apply to reports that are located in a specific 
Command or Tool are located in the appropriate chapter. For 
instance, Threshold Highlights apply only to the Reports Real-Time 
and Integrated tabs, so the information regarding Threshold 
Highlights is located in Chapter 5, “Reports.” Likewise, Exceptions 
reports have specific procedures, which are located in Chapter 8, 
“Exceptions.”
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CMS reports display, report, and summarize the performance of any 
measured subset of the ACD, including agents, splits/skills, trunks/trunk 
groups, VDNs, and vectors.

No matter where you run a report from, the way you select, run, edit, and 
view a report is the same. The information in this chapter teaches you how 
to use all Supervisor reports. The sections are as follows:

● Running a Report

● Selecting Report Run Dates

● Selecting Report Run Times

● Report Menu Bar

● Report Layouts

● Formatting Grid Reports

● Formatting Chart Reports

● Minimizing Report Output Windows

● Right Mouse Button Pop-Up Menus

● Rotating a 3D Chart

● Exporting Reports

● Copying Chart Reports

● Resizing Report Windows

● Changing Column Widths

● Selecting a Printer

● Using Page Setup

● Exiting and Restarting Reports.
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Running a Report 4

To run a CMS report, do the following steps:

1. Select one of the following windows:
● Commands | Reports |Real-Time, Historical, or Integrated tab
● Commands | Dictionary | Reports tab
● Commands | Exceptions | Reports tab
● Commands | ACD Administration | Reports tab
● Tools | Maintenance | Reports tab

2. Select a report from the Reports list box.

3. Select the ACD for which you want to run the report.

4. Select OK.

The report input window displays. The inputs required will vary, 
depending on which report you are running. 

5. Complete the report input window. 
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The following example shows possible types of input that might be 
required to run a report.

● Fill in the input field(s). Input fields are where you specify the 
information you are running the report for. 

To complete the input fields, you can do any of the following steps:

— Type in the name or number of the input requested.

— Press the Browse button to view all of the available inputs.

— Use the history list to select an input that you have previously 
used.

● For all reports other than Commands | Reports Real-Time and 
Integrated tabs, select the report destination. Reports can be viewed 
on screen or printed to any printer your PC is connected to. 

1. Report Title

1

2. History List
3. Browse Button
4. Destination Selection

2 3

5. Input Field(s)
6. Current ACD

4 5 6
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To select the report destination, do one of the following steps:

— Select the View Report on Screen destination

OR

— Select the Print Report on: destination and choose a printer (if 
you want to print on a printer other than the one displayed).

● Ensure that the correct ACD is selected. The current ACD (selected 
on the selector window) is displayed at the bottom of the input 
window.

If you want to run a report for a different ACD than is selected, do 
the following:

a. If you are in an input window, select Cancel to exit the report 
input window.

b. Go to the selector window you chose in step 1.

c. Change the ACD on the selector window.

d. Select the Report you want to run.

e. Select OK.

6. Select OK.

The report runs.
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Selecting Report Run Dates 4

When you run historical reports, you need to select the date or dates for 
which to run the report. To do this, you can do any of the following steps:

● Type the date or date range in the Date(s): input field.

● Type a relative date (for example, -2 for two days ago).

● Select the date(s) from the history list of previously used date(s) for this 
report.

● Select the Browse button .

— If you press the Browse button and the input needed is a single date, 
the following window displays:

To select a specific date, use your mouse to point at a day and click. 
The day is highlighted.

If you want to choose a date that is not in the current month, use the 
arrow keys at the bottom of the window to scroll through the 
months.
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— If the input needed is for more than one date, the following window 
displays:

To select specific dates, use your mouse to point at a day and click. 
The day highlights. You can select as many days as you want. 

To select a range of dates, select the Range button, point-and-click 
on the first day of the desired range, then point-and-click on the last 
day of the desired range. The dates selected highlight. You can select 
as many ranges as you want to, but you must select the Range 
button in order to define each range.

If you want to choose a date that is not currently displayed, use the 
arrow keys at the bottom of the window to scroll through the 
months.

To clear your current selections, select Clear.

829.bk : reportsbasics.fm  Page 7  Wednesday, November 20, 1996  3:09 PM



4-8 Selecting Report Run Dates

Reports Basics

— If the input needed is for one month, the following window 
displays:

This window is used in monthly reports where the data is for a 
single month. The form is initialized to the values in the input field 
or to the month previous to the current month when the input field 
is empty. Select a single month and year for the report. The 
minimum date is January 1980 and the maximum date is December 
2055.

— If the input needed is for more than one month, the following 
window displays:

This window is available in monthly reports where the data is for 
one or more months. The report runs, beginning with the month 
entered in the First Month: field and going through as many months 
as are specified in the Number of Months: field.

The months are in calendar order in the drop-down box, with the 
minimum date being January 1980 and the maximum date 
December 2055.
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Selecting Report Run Times 4

When you run interval historical reports, you need to select the time period 
for which to run the report. To do this, do any of the following steps:

● Type the time range in the Times: input field.

● Select the times from the history list of previously used times for this 
report.

● Select the browse button  next to the Times: field.

If you select the browse button, the following window displays:

Complete the following fields:

— Starting Interval — select the time you want the report to begin 
with from the drop-down list. The report data will begin with the 
interval that begins immediately after the time you enter.

— Ending Interval — select the time you want the report to end with 
from the drop-down list. The report data will go through the 
interval during which the time you enter falls.
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Report Menu Bar 4

When you run a report, the menu bar at the top of the window has the 
following options:

● Report

● Edit

● Format

● Tools

● Options

● Help.

The following paragraphs detail the menu items that are available in each of 
these menus.
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Report 4

The Report menu has the following options that relate specifically to the 
report you are running.

Menu Item Action

Restart Closes the current report output window and displays 
the input window for the current report. This allows you 
to run the same report, changing inputs as needed.

The Restart menu item will be grayed out if you are 
currently running a drill-down report.

Page Setup Displays the Page Setup window. See the “Using Page 
Setup” section in this chapter for more information on 
Page Setup.

Print Displays the Print window. See the “Selecting a Printer” 
section in this chapter for more information on the Print 
window. 

When you select Print from the Report menu, the report 
that is active will be printed according to the options you 
choose in the Print window. If the report is a real-time 
report, only one refresh of the report will be printed. 
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Design If you have purchased the Report Designer software and 
your CMS User ID is authorized to use the Report 
Designer, you can access the Report Designer Design 
Mode window from any report using this menu item.

When you select Design from the Report menu, the 
report that is currently running remains visible, but you 
are placed in the Design Mode, where you can edit the 
report. For more information on the Design Mode, see 
the CentreVu Report Designer (585-215-831) book.
The Design menu item will be grayed out if you are 
currently running a drill-down report.

Exit Closes the active report output window. The location of 
the report output window is saved when the report is 
exited, and that is where the report will display the next 
time you run it.

Menu Item Action
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Edit 4

The Edit menu has the following standard Microsoft* Windows† editing 
options.

*Microsoft is a registered trademark of Microsoft Corporation.
†Windows is a registered trademark of Microsoft Corporation.

Menu Item Action

Copy The image of the currently selected chart is copied to the 
clipboard in Windows metafile format. This allows you to 
paste the chart picture into most Windows applications, 
such as a word processor. You can also access Copy from 
the right mouse button pop-up menu. See the “Copying 
Chart Reports” section in this chapter for instructions on 
using Copy.

Export 
Chart Data

The Data Export Options window is shown to allow you 
to export the data in the currently selected chart. If the 
report is a real-time report, only one refresh of the data 
will be exported. You can also access the Data Export 
Options window from the right mouse button pop-up 
menu. If there is more than one chart on this report, this 
option will be grayed out until you select a chart. For 
more information on exporting data, see the “Exporting 
Reports” section in this chapter.
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Export Grid 
Data

The Data Export Options window is shown to allow you 
to export the grid data. If the report is a real-time report, 
only one refresh of the data will be exported. You can 
also access the Data Export Options window from the 
right mouse button pop-up menu. If there is more than 
one grid on the report, this option will be grayed out 
until you select a grid. For more information on 
exporting data, see the “Exporting Reports” section in 
this chapter.

Export All 
Data

The Data Export Options window is shown to allow you 
to export all data in the report. You will also be allowed 
to include labels and headers in the data that are 
exported. If the report is a real-time report, only one 
refresh of the data will be exported. You can also access 
the Data Export Options window from the right mouse 
button pop-up menu. For more information on exporting 
data, see the “Exporting Reports” section in this chapter.

Menu Item Action
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Format 4

The Format menu contains the following actions for modifying the display 
format of the currently selected object. If one (or more) of the actions does 
not apply to the selected object, it will be grayed out.

Menu Item Action

Chart Allows you to format a chart. You can also access the 
Format Chart window from the right mouse button 
pop-up menu.

Grid Allows you to format a grid. You can also access the 
Format Grid window from the right mouse button
pop-up menu.

Sort by Allows you to sort the grid by several parameters 
specific to the information in the selected grid. You can 
also access the Sort by window from the right mouse 
button pop-up menu.
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Tools 4

The Tools menu contains the following additional actions that affect the 
currently selected object. You can also access the Tools actions from the right 
mouse button.

Menu Item Action

Available 
Drill-Down 
Reports

If you are running a report that allows you to access 
one or more drill-down reports, the available drill-
down reports will be accessible from the Tools menu.

See the “Drill-Down Reports” section in Chapter 5, 
“Reports,” for more information on drill-down reports.

Threshold Settings Opens a window that allows you to view or modify 
threshold highlight settings. Threshold highlight 
settings apply only to some real-time data items in real-
time and integrated reports. For information on setting 
threshold highlights, see the “Setting Threshold 
Highlights” section in Chapter 5, “Reports.”

Change Agent 
Splits/Skills

If the current ACD supports Expert Agent Selection 
(EAS), this menu item reads Change Agent Skills; 
otherwise, it reads Change Agent Splits.
This menu item is enabled only when the selected grid 
cell in a report is an agent name or agent login ID; 
otherwise, it is disabled. If you do not have write 
permission for ACD Administration, then this menu 
item is not shown.

This action opens the Change Agent Skills window 
(EAS) or Change Agent Split Assignments window 
(non-EAS) for the selected agent. You can then modify 
the split/skill assignments for the agent. See Chapter 8, 
“ACD Administration,” for more information.
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Options 4

The Options menu contains the following actions that affect the basic 
display of the report.

Menu Item Action

Thresholds Turns threshold highlighting on or off for this real-
time report.
When threshold highlighting is on (there is a check 
by the menu item), the report shows the colors 
(icons if the report is minimized) specified in the 
Threshold Settings window.

When threshold highlighting is off (there is no check 
by the menu item), the report shows none of the 
threshold highlights (or icons if the report is 
minimized).

Status Bar Shows or hides the status bar. 
When the status bar is hidden, the window remains 
the same size but the contents are resized to fill the 
window. You would choose this to get a larger 
viewing area for the report.
When the status bar is made visible, the window 
remains the same size but the contents are resized to 
fill the smaller window area.

The status bar setting is saved in the report view.

Restore Original 
View

Restores the Report View to the original settings. All 
changes made to the format of this report are 
discarded.
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Report Layouts 4

There are two types of report layouts in Supervisor:

● Grids — the Supervisor presentation of standard CMS reports.

● Charts — the Supervisor presentation of Graphical reports.

A report can consist of only a grid(s), only a chart(s), or a combination of 
grids and charts.

In addition to the grids and charts that make up the main body of reports, 
reports can include text and field names that are followed by single data 
items. Text and data fields are used on both grid and chart reports.

The following sections describe each type report layout.
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Grids 4

Most standard CMS reports (reports that are not prefaced by “Graphical”) 
are displayed in grids. The information on a standard report window is 
organized as follows:

Standard real-time reports can be sorted. See the “Formatting Grid Reports” 
section in this chapter.

2

4

1

3

1. Menu Bar
2. Headings
3. Grid
4. Columns
5. Current ACD

5
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Charts 4

The Graphical CentreVu Supervisor reports are displayed in charts. The 
information on a chart report window is organized as follows:

There are several options for formatting the appearance of the charts 
(graphical reports). See the “Formatting Chart Reports” section in this 
chapter for more information.

4

1

5

6

1. Bar Chart
2. Line Chart
3. Grid
4. Pie Chart
5. Legend
6. Current ACD

2

3
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Formatting Grid Reports 4

If you are in a report containing a grid, you can format how the report is 
displayed. The formatting is done in the Grid Format Options window, 
which is accessed by either of the following steps:

● Double clicking on a column heading in the report 

OR

● Selecting Format Grid or Sort by from the Format menu or the right 
mouse button pop-up menu.

The Grid Format Options window allows you to make layout changes to a 
grid. All changes you make are saved as part of the report view when the 
report exits.

The following sections describe the General and Sort tabs.

Note The changes you make to a report’s format affect only your view of 
the report. The changes do not affect how other CMS users see the 
report.

Note If you select Format Grid, the Grid Format Options window 
displays with the General tab active.
If you select Sort by, the Grid Format Options window displays 
with the Sort tab active.
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General Tab 4

The General tab allows you to make format changes to a grid.

The following grid parameters can be changed:

● Show Gridlines — specifies whether or not grid lines are to be shown in 
the grid.

● Fixed Region, Columns — specifies the number of columns from the 
left of the grid that are fixed in place and do not scroll. Valid values are 
in the range of 0 through 99. You can use the spin boxes to select a valid 
value or type the value in.

● Fixed Region, Rows —specifies the number of rows from the top of the 
grid that are fixed in place and do not scroll. Valid values are in the 
range of 0 through 99. You can use the spin boxes to select a valid value 
or type the value in.

Spin Box
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Sort Tab 4

The Sort tab allows you to specify the order in which the following 
information on the real-time grid report is displayed. 

When you are setting up display order for a real-time report, specify the sort 
column (Sort By) and the sort order (Ascending or Descending). The drop-
down list for the Sort By lists all of the database table and item names used 
in the report. Some examples of sorting are as follows:
● Viewing a list of agents alphabetically — select “Agent Name” from the 

first Sort By drop-down list, select Ascending as the sort order, and 
leave the other two Sort By boxes set to “(none).”

● Searching for agents who have been in a certain state for too long — 
select “State” from the first Sort By drop-down list, then select “Time” 
from the second Sort By drop-down list, and then select Descending as 
the sort order for the second Sort By.

Note Sorting may cause report refreshes to take longer. If you wish to 
speed up the refresh rate, turn off the sort options by selecting 
“(none)” for all of the Sort By criteria.

1. Sort By Criteria Drop-Down Lists
2. Sort Order

21
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Formatting Chart Reports 4

Charts (found in Graphical reports) provide a graphical representation of 
data. Values or data points are displayed in formats such as bars, lines, filled 
areas, and pie charts. These data points are grouped into series that are 
identified with unique colors. In many chart types, one data point from each 
series is grouped together by category across an axis. A chart can also have a 
title and a legend. Categories are plotted along the x-axis, values are plotted 
along the y-axis. A two-dimensional chart shows series next to each other, 
while a three-dimensional chart plots series along the z-axis. 

If you double click on a chart, the Chart Format window displays. 

If you are in a Graphical (chart) report, you can format how the report is 
displayed. The formatting is done in the Chart Format Options window, 
which is accessed by the following steps:

● Double clicking on a chart in the report 

OR

● Selecting Format Chart or Sort by from the Format menu list or the right 
mouse button pop-up menu.

The Chart Format window has seven tabs: General, 3D Effects, Axis, Type, 
Title, Legend, and Data Point Labels. The following sections describe each of 
the tabs.

Note The changes you make to a report’s format affect only your view of 
the report. The changes do not affect how other CMS users see the 
report.
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General Tab 4

The General tab allows you to specify several general options that apply to 
the chart.

The following chart parameters can be changed:

● Background Color — specifies whether the backdrop of the chart is a 
solid color or whether it is displayed as a gradient, a smooth transition 
from one color to another. The gradient transition can be one of the 
following: Horizontal, Vertical, Rectangle, or Oval. The quality of the 
gradient effect will vary depending on the video card installed in the 
PC, or the capabilities of the printer for printed reports.

● Real-Time — if the chart is a rolling chart, you can specify the number 
of data points to be displayed in the chart. Permitted values are 2 
through 100, with 10 being the default. A rolling chart is a line chart that 
is initially displayed with no data points. For each refresh of the report, 
a data point is added. As data points are added, the chart “rolls” from 
left to right. When enough refreshes have occurred so that the chart is 
displaying the number of specified data points, at the next refresh, the 
oldest data point is dropped from the display and the newest data point 
is displayed.
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3D Effects Tab 4

The 3D Effects tab allows you to control the 3D appearance of the chart. If 
the current chart is a 2D chart, this tab is disabled. 

The following chart parameters can be changed:

● Elevation — a number from 0 through 90 degrees that describes the 
relative height from which a chart is viewed. An elevation of 90 looks 
directly down on the top of the chart, while an elevation of 0 looks 
directly at the side of the chart. The example charts throughout this 
document use an elevation of 30 degrees.

● Rotation — a number from -360 through 360 degrees that specifies the 
angle that the chart is turned relative to the viewing position. The 
example charts throughout this document use a rotation of 60 degrees. 
Rotation does not apply to 3D pie charts.

● Projection — selects one of three mathematical algorithms used to give 
a 3D appearance on a 2D sheet of paper or computer screen. You can 
choose the following values:

— Oblique: The chart has depth but the X-Y plane does not change 
when the chart is rotated or elevated.
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— Orthogonal: Perspective is not applied to the chart, resulting in less 
of a 3D effect. The advantage of using this type of projection is that 
vertical lines remain vertical, making some charts easier to read.

— Perspective: This provides the most realistic 3D appearance. Objects 
farther away from you converge toward a vanishing point.

● Viewing Distance — a number from 50 through 1000 that represents the 
distance from which the chart is viewed as a percentage of the depth of 
the chart.

● Width to Height — a number from 5 through 2000 that represents the 
percentage of the chart’s height that is used to draw the chart’s width.

● Depth to Height — a number from 5 through 2000 that represents the 
percentage of the chart’s height that is used to draw the chart’s depth.

See the “Rotating a 3D Chart” section in this chapter for an easy way to 
change the elevation and rotation of a chart using the mouse.
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Axis Tab 4

The Axis tab allows you to specify the title that will display on each axis of 
the chart report.

The following chart parameters can be changed:

● Axis Display — makes each of the axes visible or invisible. The choices 
are X Axis, Y Axis, 2nd Y Axis, and Z Axis. 
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Type Tab 4

The Type tab lets you change the chart type.

The available options on the Type tab are as follows:

● 2D and 3D — changes the chart between 2-dimensional and 3-
dimensional views. 2D charts update faster than 3D charts, so if the 
drawing speed seems too slow, you may want to display charts as 2D.

● Chart Type — specifies how the data is presented. You choose a chart 
type from the list. The types of charts available vary slightly depending 
on whether a 2D or 3D chart has been selected. All possible chart types 
are as follows:

— Bar Chart (2D and 3D)

— Line Chart (2D and 3D)

— Area Chart (2D and 3D)

— Step Chart (2D and 3D)

— Horizontal Bar Chart (2D and 3D)

— Clustered Bar Chart (3D only).

— Pie Chart (2D and 3D).
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● Stacked check box — causes the data for all series to be stacked rather 
than shown separately. This check box is disabled for pie charts.

● % Axis check box — causes the value axis (y-axis) to be displayed as 
percentages rather than as actual data values. This can be combined 
with the stacked check box to produce a percentage stacked chart.
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Title Tab 4

The Title tab allows you to control the location of the chart title.

The available options on the Title tab are as follows:

● Visible check box — allows you to display or not display report titles. 

● Location of title — if you elect to have report titles visible, you can select 
where the titles display. The available options are Top left, Top (center), 
Top right, Left, Right, Bottom left, Bottom (center), and Bottom right.

Note Since the title takes up space, the drawn chart will be smaller if you 
have selected Visible. If you wish to increase the size of the chart, do 
not select the Visible option.
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Legend Tab 4

The Legend tab allows you to control the location of the chart legend.

The available options on the Legend tab are as follows:

● Visible check box — allows you to display or not display report 
legends.

● Location of legend — if you elect to have report legends visible, you can 
select where the legend displays. The available options are Top left, Top 
(center), Top right, Left, Right, Bottom left, Bottom (center), and Bottom 
right.

Note Since legends take up space, the drawn chart will be smaller if you 
have selected Visible. If you wish to increase the size of the chart, do 
not select the Visible option.
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Data Labels Tab 4

The Data Point Labels tab allows you to control the location of the data point 
labels. 

The following parameters can be specified:

● None — labels are not displayed.

● Above Point — displays the label above the data point. This location is 
valid only for bar, line, area, and step charts.

● Below Point — displays the label below the data point. This location is 
valid only for bar, line, area, and step charts.

● Center — displays the label centered on the data point. This location is 
valid only for bar, line, area, and step charts.

● Base — displays the label along the category axis, directly beneath the 
data point. This location is valid only for bar, line, area, and step charts. 

● Inside — displays the label inside a pie slice. This location is valid only 
for pie charts.

● Outside — displays the label outside a pie slice. This location is valid 
only for pie charts.
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If data point labels are displayed, you can specify that they include one of 
the following:

● Value — the value of the data point appears in the label.

● Percent — the value of the data point appears in the label as a 
percentage.

● Series Name — the series name is used to label the data point.

● Category Name — the category name is used to label the data point.

Note The position of data point labels can affect the readability of the 
chart. The label text may overlap in some situations, making it 
difficult or impossible to read the labels.
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Minimizing Report Output Windows 4

To minimize a report window, select the minimize button which is located in 
the upper right-hand corner of the window.

When a report output window is minimized, the report’s icon is displayed. 
Depending on the category of the report, one of the following icons will be 
displayed: 

Icon Report Type

ACD Administration Reports

Agent Real-Time, Historical, and Integrated Reports

Dictionary Reports

Exceptions Reports

Maintenance Reports

Other, Queue/Agent, and Custom Real-Time and 
Historical Reports

Split/Skill Real-Time, Historical, and Integrated 
Reports

Trunk/Trunk Group Real-Time and Historical Reports
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Minimized Report Thresholds 4

If Report Thresholds are enabled, real-time and integrated reports continue 
to update while they are minimized. The report threshold highlighting will 
work in one of the following ways, depending on the version of Windows 
you are running:

● Windows 3.x or Windows NT 3.51 — if no Caution or Warning 
threshold conditions are currently being met, the report’s normal icon 
displays, as shown on the previous table. If thresholds are currently 
being met, the Caution or Warning threshold symbol appears instead of 
the standard report icon. The threshold symbols are as follows:

● Windows 95 or Windows NT 4.0 — if no Caution or Warning threshold 
condition is currently being met, the report’s normal icon, as shown on 
the previous table, displays on the toolbar and in the system tray. If 
thresholds are being met, the report’s icon on the toolbar remains the 
same, but the Caution or Warning threshold symbol appears in the 
system tray. 

For more information on how the Supervisor icon in the system tray 
works, see Chapter 2, “Supervisor Basics.”

VDN Real-Time, Historical, and Integrated Reports

Vector Real-Time and Historical Reports

Icon Threshold Type

Caution Threshold

Warning Threshold

Icon Report Type
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Right Mouse Button Pop-Up Menus 4

The right mouse button pop-up menu is available only in running reports. 
When you click the right mouse button, a pop-up menu displays. The menu 
that displays is dependent on where your cursor is located. It can include 
options from the Edit, Format, and Tools menus on the Reports menu bar. 
The applicable menu items for the input field are enabled. If a report object 
is not selected, a menu is not displayed when you hold down the right 
mouse button.

The right mouse button pop-up menu is available when you do any of the 
following actions:

● Select a cell in a grid and hold down the right mouse button — a 
dotted border is drawn around the cell and the following menu 
displays:

Note To deselect a selected object, click anywhere else on the report.

Note If you select a cell that displays an agent name, agent number, or 
work mode, the available drill-down reports for that cell display 
at the top of the right mouse button menu. See examples of these 
later in this section.
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● Select an output field or label and hold down the right mouse button 
— a dotted border is drawn around the field and the following menu 
displays:

● Select a data point in a chart and hold down the right mouse button — 
the data point is highlighted using selection handles (dots along the 
edges of the data point) and the following menu displays:

If you selected a data point that allows report threshold highlighting to 
be set, the menu item will not be grayed out.

Note The Threshold Settings menu item is enabled if the highlighted 
field has related threshold settings. See the “Setting Report 
Threshold Highlights” section in Chapter 5, “Reports,” for 
information on setting report threshold highlights.
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● Select an agent name or agent number in a grid and hold down the 
right mouse button — a dotted border is drawn around the agent name 
and the following menu displays:

From this menu, you can access either the Real-Time or the Integrated 
Agent Graphical Information report. If you double click on the agent 
name and you are running a real-time report, the default drill-down 
report is the Real-Time Agent Graphical Information report. For 
descriptions of the reports, see Chapter 15, “Real-Time Reports,” and 
Chapter 17, “Integrated Reports.”

You can change an agent’s splits/skills while you are in a report using 
this method of selection. See the “Changing an Agent’s Splits/Skills 
While in a Report” section of Chapter 5, “Reports,” for more 
information.

Note If you do not have the EAS feature on your Enterprise 
Communications Server (ECS) or switch, the drill-down reports 
available will be the Real-Time Agent Information report and 
the Integrated Agent Information report.
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● Select a cell on a grid or a point on a chart that displays agent work 
state information and hold down the right mouse button — the data 
point is highlighted using selection handles (dots along the edges of the 
data point) and the following menu displays:

From this menu, you can access the Real-Time Split/Skill Work State 
Report, which also displays when you double click on a work state in 
the report. For a description of the reports, see Chapter 15, “Real-Time 
Reports.”

● Select a cell on a grid or a point on a chart that displays Top Agent 
work state information and hold down the right mouse button — the 
data point is highlighted using selection handles (dots along the edges 
of the data point) and the following menu displays:

From this menu, you can access the Real-Time Split/Skill Top Agent 
Work State Report, which also displays when you double click on the 
work state in the report. For a description of the reports, see Chapter 15, 
“Real-Time Reports.”

Note If you have the ECS or switch with the EAS feature, the Real-
Time AUX Agent drill-down report will also be available. 

Note If you have the ECS or switch with the EAS feature, the Real-
Time AUX Top Agent drill-down report will also be available. 
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Rotating a 3D Chart 4

The rotation and elevation of any 3D chart can be changed interactively 
using the mouse. This is easier than using the 3D Effects tab of the Chart 
Format window (see the “Formatting Chart Reports” section in this chapter 
for information on using the 3D Effects tab). To change the rotation and 
elevation of a 3D chart, do the following steps:

1. Place the pointer over a 3D chart.

2. Press and hold the CTRL key. The pointer changes to indicate that the 
chart can be rotated.

3. Click and hold the left mouse button. A dotted 3D outline appears 
around the chart.

4. Move the pointer up and down to change the chart elevation, and left 
and right to change the chart rotation. The dotted 3D outline shows the 
position of the chart as you move the mouse.

5. When you find the rotation and elevation you want, release the mouse 
button. The chart is redrawn in the new position.

The 3D rotation and elevation of each chart is saved as part of the report 
view.
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Exporting Reports 4

You can export the data from both standard (grid) and graphical (chart) 
reports, either to a file or to the Windows clipboard. Once you have exported 
a report, you can copy the report information into another application (for 
instance, a spreadsheet).

Reports are exported from CentreVu Supervisor in the following format:

● Data is exported as ASCII characters.

● For grid reports, each row of data is written as one line, terminated by a 
carriage return (ASCII value 13).

● The field separator character is written between fields.

● The field separator does not follow the last character in the line.

● Text strings are delineated according to the specified text delimiter.

To export the data from a report, do the following steps:

1. Click on the grid or chart within a report.

2. Select Export Grid Data or Export Chart Data or Export All Data, as 
appropriate, from the Edit menu or the right mouse button pop-up 
menu.

3. Fill out the Export Data window.

Note By default, only the data from the chart or grid is exported. You can 
select the Include Labels and Headers check box on the Export Data 
window to include that information in the export of data.
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The Export Data window allows you to copy the data from a report to 
the clipboard or a file. The window displays when you choose to export 
data from within a report output window. The parts of the Export Data 
window that you must complete are as follows:
● Destination selection box — choose to export the report to the 

clipboard or to a file. If you are exporting the report to a file, you 
need to type in a name for the file.

● Export Format selection box — define the export format of the 
report. The character you choose from the drop-down list in the 
Field Separator text box is what will be placed between each field in 
the report. The character you choose for the Text Delimiter 
determines what is used around text strings in the exported file. If a 
text delimiter is specified, no special checks are done to ensure that 
the data does not contain that character and the data is written 
unmodified.

Note You can select the File button  to browse the files on 
your PC, or use the history list to select a file you previously 
used.
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● Export Null Values as Zero — select this check box to include data 
that is null as a zero in the export of information. This is helpful if 
you are exporting a grid report because a null value that is not 
included in the export of the data could disrupt the order of the 
rows/columns in the data.

● Include Labels and Headers check box — select this check box to 
include the text information (such as column headers in grid 
reports) in the export of the report’s data.

If you want to export data to Microsoft Excel, choose 
“Tab” as the field separator and “None” as the text 
delimiter.

Tip
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Copying Chart Reports 4

You can copy chart reports to the Windows clipboard. The copy of the 
selected chart report is copied to the clipboard in the Microsoft Windows 
metafile (*.wmf) format. This allows you to paste the chart image into any 
Windows application that can read the metafile format. For instance, you can 
copy chart reports and import the files into word processing files to be used 
as viewgraphs.

To copy a chart report to the metafile format, do the following steps:

1. Run a chart (Graphical) report.

2. Select the image that you want to copy by clicking on it.

3. Select Copy from the Edit menu or use the right mouse button menu to 
select Copy.

The chart you selected is copied to the clipboard.
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Resizing Report Windows 4

You can resize report windows by moving the cursor to the edge of the 
window and, when the resize arrow appears, holding down the left mouse 
button and moving the mouse to size the window. When the window is the 
size you want it, release the mouse button.

You can also use the maximize and minimize buttons at the top of the 
window to size the window.

When you resize a Supervisor report output window, the resulting effect 
depends on the type of report (standard CMS or Graphical) you are running. 
The following paragraphs outline the effects of resizing each type of report 
window.

Standard CMS Reports 4

When you resize the window of a standard report, the contents of the 
window do not change in size to reflect the new window size. 

If you made the window smaller than the size of the report, scroll bars will 
appear to allow you to view the entire contents of the report.

Graphical Reports 4

When you resize the window of a Graphical report, the contents of the 
window will change in size to reflect the new window size.

If a window is made too small, some elements may shrink in such a way to 
become unreadable. If this happens, resize the window to a more 
appropriate size. You may also choose to turn chart legends or data labels off 
to make more room for the chart itself. 

The window size is saved as part of the report view.

829.bk : reportsbasics.fm  Page 46  Wednesday, November 20, 1996  3:09 PM



 Changing Column Widths 4-47

Reports Basics

C
ha

pt
er

 4

Changing Column Widths 4

You can change the width of an individual grid column in a grid or chart 
report by positioning the mouse pointer between the column headers. The 
pointer will change to indicate that a resize is possible, and you can then 
drag the mouse to change the column size. 
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Selecting a Printer 4

The Print Setup window is a standard Windows print window. 

To access the Print Setup window, do the following steps:

1. Select a report (from Reports, Dictionary, Exceptions, ACD 
Administration, or Maintenance).

2. On the report input window, select the Print Setup button .

The Print Setup window displays.

The following options are available in the Print Setup window:

● Default Printer — the default printer assigned by you in the Windows 
Control Panel will be used.

● Specific Printer — you can choose any printer that has been installed in 
the Windows Control Panel. All installed printers are included in the 
drop-down list. Depending on what printers are installed, non-printer 
devices such as files and fax may appear here.

Other entries in this window will vary depending on the capabilities of the 
chosen printer. The Windows system software determines what is available 
here and what happens if the Options button is selected. These variations 
are not described here since Windows is in control of this.
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Using Page Setup 4

The Page Setup window allows you to specify how each page of a report is 
positioned when printed. The changes you make in this window apply only 
to printed reports and do not affect reports displayed on-screen.

The Page Setup window is a standard Windows print window. 

To access the Page Setup window, do the following steps:

1. Select a report (from Reports, Dictionary, Exceptions, ACD 
Administration, or Maintenance).

2. Complete the report input window, selecting View Report On Screen as 
the destination.

3. Select OK to run the report.

4. Once the report is running, select Page Setup from the Report menu.

The Page Setup window displays.

The following options are available in the Page Setup window:

● Margins — allows you to define the spaces at the edges of the page 
where nothing will be printed. The margin settings behave as follows:

— Top — the margin is measured from the top of the page. The report 
is offset by this amount at the top of each page.
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— Bottom — the margin is measured from the bottom of the page. 
When a printed grid reaches the bottom of the page, it will continue 
printing at the top of the next page, with the grid titles repeated. If a 
chart would overlap the bottom margin, it will be scaled smaller so 
that it fits within the margin. Text that reaches the bottom of the 
page will be printed on the next page.

— Left — the margin is measured from the left of the page. The report 
is offset by this amount on the left of each page.

— Right — the margin is measured from the right of the page. Grids 
and text that are too wide to fit on the printed page are truncated at 
the right margin. Charts that would overlap the right margin are 
scaled smaller to fit within the margin.

● Page Numbers — allows you to choose whether or not to display page 
numbers. The following settings are valid:

— Yes — page numbers will be displayed.

— No — no page numbers will be displayed. This is equivalent to the 
way CMS currently prints reports.

● Box Around Grids — allows you to choose whether or not to display a 
box around report grids when printed. The following settings are valid:

— Box — boxes will be displayed.

— No Box — boxes will not be displayed.
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Exiting and Restarting Reports 4

To exit a report (return to the Controller), do one of the following steps:

● Double click the System button.

● Select Close from the System button menu.

● Select Exit from the Report menu.

To restart a report (return to the report input window), do the following 
step:

● Select Restart from the Report menu.

Note If the system shuts down due to an error, any changes you have 
made to the report(s) you are running are saved.

Note Work State drill-down reports cannot be restarted.
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Reports... 5

Introduction 5

This chapter teaches you to run real-time, historical and integrated reports 
from the Reports command. It also teaches you how to perform operations 
that are specific to the Reports command.

This chapter includes the following sections:
● About Reports
● Starting Reports
● Report Selector Window and Report Manager
● Reports Real-Time Tab
● Running a Real-Time Report
● Reports Historical Tab
● Running a Historical Report
● Reports Integrated Tab
● Running an Integrated Report
● Drill-Down Reports
● Changing Agent Splits/Skills While in a Report
● Setting Report Threshold Highlights.
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Use the reports you run from the Reports command to help you do the 
following actions:

● Determine how many agents are currently needed to handle incoming 
calls.

● Manage call volume fluctuations.

● Configure the software to make changes automatically and to meet 
unexpected demands.

● Change, add, or delete such measured entities as trunks, VDNs, vectors, 
agents, and splits without downtime in the link between the CMS and 
the Enterprise Communications Server (ECS) or switch. 

● Initiate agent audit trails.

The table on the following page lists the real-time, historical, and integrated 
reports that are available through the Supervisor application. This table lists 
all possible reports that might be available through the Supervisor 
application. The reports that actually display on your Reports selector 
window will vary, depending on the switch type and your CMS User 
Permissions.

For information on the standard CMS reports, please refer to the CentreVu 
CMS Real-Time and Historical Reports (585-215-821) document. For 
information on the graphical and integrated report, see the appropriate 
chapters of this book.

Note Reports are also available in the following Supervisor commands 
and tools:

● Commands | Dictionary

● Commands | Exceptions

● Commands | ACD Administration

● Tools | Maintenance.

Please see the appropriate chapter for information on reports that 
are run from other Commands and Tools.
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If you have accessed CMS using the terminal interface, you will find that the 
Supervisor Graphical reports provide information similar to the graph 
reports that are available with the optional graphics feature of CMS.

Category Report Name

R
ea

l-T
im

e 

H
is

to
ric

al

In
te
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at

ed

Agent Agent Group Report ❏

Agent Report ❏

Attendance ❏

AUX ❏

Event Count ❏

Graphical Information ❏ ❏

Graphical Time Spent Daily ❏

Group Attendance ❏

Group AUX ❏

Group Summary ❏

In/Outbound ❏

Information ❏ ❏

Login/Logout (Split/Skill) ❏

Split/Skill ❏

Summary ❏

Trace ❏

Other Call Records ❏

Call Work Code ❏

Event Count Summary ❏

Multi-ACD Report ❏

Multi-ACD Top Agent ❏

Queue/Agent Queue/Top Agent Status ❏

Status ❏

Summary ❏
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Split/Skill Call Profile ❏ ❏ ❏

Comparison ❏

Graphical ASA ❏

Graphical AUX Agents ❏

Graphical AUX Top Agents ❏

Graphical Call Profile ❏

Graphical Call Profile Daily ❏

Graphical EWT ❏

Graphical Queue ❏

Graphical Service Level Interval ❏

Graphical Skill Time Spent 
Daily

❏

Graphical Split/Skill View ❏

Graphical Status ❏

Graphical Top Skill Status ❏

Outbound ❏

Report ❏

Skill AUX Report ❏

Skill Top Agent ❏

Split/Skill Status ❏

Split/Skill Report ❏

Top Agent Status ❏

Summary ❏

System Multi-ACD ❏

Multi-ACD by Split/Skill ❏

System ❏

Category Report Name
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Trunk/Trunk Group Busy Hour ❏

Trunk ❏

Trunk Group ❏ ❏

Trunk Group Summary ❏

VDN Busy Hour ❏

Call Profile ❏ ❏

Graphical Call Handling ❏

Graphical Call Profile ❏

Graphical Call Profile Daily ❏

Graphical Service Level Interval ❏

Multi-ACD Flow ❏

Report ❏

Skill Preference ❏ ❏

VDN Report ❏

Vector Vector ❏ ❏

Note  Some reports may not be available if they are not valid for your 
switch type or the features you purchased.

Category Report Name
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Real-Time Reports have the following characteristics:

● Show the current status of ACD activity. The types of data for reports 
are status, cumulative, and administrative. (See Appendix A, “Database 
Items and Calculations” in the CentreVu CMS Real-Time and Historical 
Reports document (585-215-821) for a description of the data types and 
database items used in reports.)

● Display data for the current interval for agent, split/skill, trunk/trunk 
group, vector, and VDN activities, such as number of ACD calls, 
abandoned calls, average talk time, and so on.

Cumulative real-time report data are based on the current interval (15, 30, or 
60 minutes). The length of the current interval can be changed in the CMS 
System Setup — Storage Intervals window by a CMS Administrator.

The real-time reports that are available in the Supervisor application include 
the standard CMS reports and a variety of Supervisor Graphical reports. For 
definitions of the standard CMS reports, see the CentreVu CMS Real-Time and 
Historical Reports (585-215-821) document. For definitions of the Supervisor 
Graphical reports, see Chapter 15, “Real-Time Reports.”

Note All database items and calculations that are used for real-time 
reports are taken from the current interval tables.
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About Historical Reports 5

Historical Reports display, report, and summarize the past performance of 
any measured subset of the ACD. Historical reports display past data for 
various agent, split/skill, trunk/trunk groups, VDN, and vector activities, 
such as number of ACD calls, abandoned calls, average talk time, and 
average speed of answer.

The information in historical reports will give you a sound basis for the 
following types of decisions:

● Mix of trunk facilities

● Split or skill size

● Agent assignments

● Consistent and objective performance standards

● Performance evaluations.

Historical reports are available in interval, daily, weekly, and monthly 
formats. All four types are not available for each report. The Select a Report 
window lists reports based on which types are available (for example: Call 
Profile Daily, Call Profile Weekly, Call Profile Monthly).

The historical reports that are available in the Supervisor application include 
the standard CMS reports and a variety of Supervisor Graphical reports. For 
definitions of the standard CMS reports, see the CentreVu CMS Real-Time and 
Historical Reports (585-215-821) document. For definitions of the Supervisor 
Graphical reports, see Chapter 16, “Historical Reports.”
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Integrated Reports show the current status and accumulated data for up to 
the past 24 hours of ACD, agent, split/skill, trunk/trunk group, vector, and 
VDN activities.

The integrated reports that are available in the Supervisor application are 
specific to the Supervisor application and cannot be accessed through a 
terminal interface to the CMS. For definitions of the Supervisor Integrated 
reports, see Chapter 17, “Integrated Reports.”

About Designer Reports 5

The Report Designer feature can be purchased with the CentreVu 
Supervisor software. The Report Designer allows you to create reports that 
are tailored to your call center’s needs. Using the Report Designer, you can 
create new reports, edit standard CMS and Supervisor reports, and copy 
items from one report to another report. The reports you create using the 
Report Designer can be run from the Supervisor application.

For instructions on using the Report Designer, see the CentreVu Report 
Designer User’s Guide (585-215-831).

About CMS Custom Reports 5

Any Custom Reports you have created are ported to Supervisor. You can 
view, print, and export the reports in Supervisor. To edit the reports, or 
create new ones, use the Terminal Emulator or a CMS terminal.

For information on creating and editing Custom Reports, see the CentreVu 
CMS Custom Reports (585-215-822) document.

829.bk : reports.fm  Page 8  Wednesday, November 20, 1996  3:09 PM



 Starting Reports 5-9

Commands | R eports

C
ha

pt
er

 5

Starting R eports 5

To start Reports do the following steps:

1. Select Reports from the Commands menu. 

OR

Select the Reports button  on the toolbar.

2. The Reports window appears. You will see the following tabs to choose 
from:
● Real-Time
● Historical
● Integrated.

3. Select the ACD you want to run reports for from the Run Report for 
ACD text box.

4. Select the type of report you want to run from the Category box.

5. Select the specific report from the Report list box.

6. Select OK.

The report input window displays.

See the following sections for specific information on real-time, 
historical, and integrated reports and their associated input windows.
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The report manager is the feature of the Supervisor application that allows 
you to view report properties, copy reports, and access the Report Designer 
to edit reports or create new reports.

The report manager is incorporated into the Reports selector window, as 
shown below:

You can use the Properties, Copy, and Edit buttons on the Report selector 
window to manage the standard CMS and Supervisor reports and to copy 
reports to the Designer category for editing. You can use the New button to 
create a new Designer report. You can use the Delete button to delete 
reports from the Designer category.

Note For information on using the Add Bookmark button, see 
Chapter 14, “Bookmarks.”
For information on using the Copy, Delete, Edit, and New buttons, 
please see the “Using the Report Manager” chapter in the CentreVu 
Report Designer (585-215-831) book.
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Using the P roperties Button 5

The Report Manager gives you the ability to view report properties, such as 
the report name, type (global or private), and the folder the report is stored 
in.

To view a report’s properties, do the following steps:

1. Open the Report Selector window.

2. Select the report for which you want to view properties.

3. Click the Properties button.

The Properties window for the report displays:

From the Properties window, you can change the Name, Description, 
Owner or Scope scope of a report.

To change the Name, Description, or Owner of a report, place the cursor in 
the appropriate field and make your edits. To change the Scope of a report, 
select either the Global or Private radio button. When you are done making 
your changes, select the OK button to save the changes. Permissions will be 
checked and changes will be saved if the requested modifications are 
permitted for the user.
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Reports Real-Time Tab 5

The Reports Real-Time tab is where you select reports that refresh in real-
time. The following graphic shows the Real-Time tab.

From the Real-Time tab, you can select the items that are listed on the 
following table:

Note The options available in the Real-Time tab vary depending on what 
switch and switch options you have.

Note For more detail on the following reports, refer to the CentreVu CMS 
Real-Time and Historical Reports (585-215-821) document and Chapter 
15, “Real-Time Reports,” in this book.
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Category Report Name Description

Agent Agent Group 
Report

Shows the status of agents in an 
agent group and the reason codes 
for AUX agents.

Agent Report Shows the status of agents in a 
selected split/skill and the reason 
codes for AUX agents.

Graphical 
Information

Graphically shows information and 
statistics for the specified agent.

Information Shows information and statistics for 
the specified agent.

Other Event Count 
Summary

Shows the number of times during 
the current interval that an agent in 
a split/skill pressed any of the 
Event Count (Stroke Count) keys 
while on an ACD call or in ACW.

Multi-ACD 
Report

Shows call-handling information on 
up to six splits/skills and up to four 
ACDs.

Multi-ACD Top 
Agent

Shows call-handling information 
for the top agents in up to six 
splits/ skills on up to four ACDs.

Queue/
Agent

Queue/Top 
Agent Status

Summarizes the status of a 
split/skill and the top agents in that 
split/skill.

Status Shows skill status for a selected skill 
and agent status with reason codes 
for AUX agents.

Summary Summarizes the status of a 
split/skill and the agents in that 
split/skill.
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Split/Skill Call Profile Shows the wait times for incoming 
calls handled and abandoned in a 
split/skill during the current 
interval.

Graphical AUX 
Agents Report

Graphically shows all agents with 
this skill who are in AUX, the 
reason, and the time in AUX. 
Available with the ECS only.

Graphical AUX 
Top Agents 
Report

Graphically shows all top agents 
with this skill who are in AUX, the 
reason, and the time in AUX. 
Available with the ECS only.

Graphical Call 
Profile

Graphically shows how well the 
split/skill you specify is performing 
compared to your predefined 
Acceptable Service Level.

Graphical EWT Graphically shows the current EWT 
for the splits/skills you specify.

Graphical Queue Graphically shows the number of 
calls waiting in the queue and the 
amount of time the oldest call in 
queue has waited for the 
splits/skills you specify.

Graphical Status Graphically shows the status of a 
single split/skill and the status of 
individual agents in that split/skill 
in both graphical and grid formats.

Graphical Top 
Skill Status

Graphically shows the work state of 
top agents, status of top agents, and 
reason codes for top agents who are 
in AUX. Available with the ECS 
only.

Category Report Name Description
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Skill AUX Report Shows the number of agents in 
AUX for each reason code for the 
selected skills.

Skill Status Shows the status of one skill.

Skill Top Agent Shows the number of top agents in 
each work mode and skill status for 
each of the selected skills.

Split/Skill Report Shows the status of up to six 
splits/skills.

Split Status Shows the status of one split.

Top Agent Status Shows all of the agents with the 
selected top skill and their skill 
status.

Trunk/Trunk 
Group

Trunk Group 
Report

Shows the status of each trunk in a 
selected trunk group.

VDN Call Profile Shows the numbers of 
answered/connected and 
abandoned calls to the specified 
VDN within the current interval.

Graphical Call 
Profile

Graphically shows the numbers of 
answered/connected and 
abandoned calls to the specified 
VDN within the current interval.

Skill Preference Shows information about the call 
handling for the VDN as a whole.

VDN Report Shows information about how calls 
to the specified VDNs have been 
handled.

Vector Vector Report Shows information about how calls 
to the specified vectors have been 
handled.

Category Report Name Description
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When you select a report to run from the Real-Time tab an input window 
displays. The real-time report input windows vary, based on the type of 
report you are running. Below is an example of the input windows you will 
see.

To run the real-time report do the following steps:

1. Fill in the input field(s).

Input fields are where you specify the information you are running the 
report for. Most real-time reports have one input field. The input field 
can ask for split/skill, agent group, trunk group, VDN, or vector. You 
must complete the input field(s) in order to run the report.

To complete the input field, do any of the following steps:
● Type in the name or number of the input requested.

1 32

1. Input Field(s)
2. History List
3. Browse Button
4. Refresh Rate
5. Check-Boxes
6. Current ACD

4

5

6
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● Press the Browse button to view all of the available inputs for which 
you have permissions.

● Use the history list to select an input that you have previously used.

2. Select a Refresh Rate.

The refresh rate determines how often the report is updated to display 
new data.

Your fastest allowable refresh rate is defined in the User Permissions — 
User Data window. For any user, the fastest rate that may be defined is 
every 3 seconds. The actual speed at which a report refreshes may be 
slower than the defined speed, since the number of active terminals, the 
number of active windows, and the number of real-time reports can 
have an impact on refresh rates.

The default refresh rate when you bring up the report input window is 
your minimum refresh rate plus 15 seconds. You can change the default 
refresh rate on the report input window. To modify your minimum 
refresh rate, contact your CMS administrator.

To change the refresh rate, you can do either of the following steps:
● Type in the number of seconds you want to pass between updates.
● Use the up/down arrows to select a number of seconds.

3. Enable/Disable the check boxes.

● Enable Report Thresholds — lets you display specific thresholds 
for items displayed on reports. See the “Setting Report Threshold 
Highlights” section in this chapter for more information on setting 
and using report threshold highlights.

● Run Minimized — starts the report minimized, if checked. To open 
a minimized report, double click on the report icon.

4. Ensure that the correct ACD is selected.

Note The processor speed of and the amount of RAM on your PC can 
affect refresh rates. Slower PCs or ones with little RAM may 
require that you use a slower refresh rate. The processor speed 
of the CMS server can also affect refresh rates.
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The current ACD (selected on the Reports selector window) is 
displayed at the bottom of the input window.

If you want to run a report for a different ACD than is selected, do the 
following steps:

a. If you are in a report input window, select Cancel to exit the report 
input window.

b. Select Reports from the Commands menu.

c. Change the ACD on the Reports selector window.

d. Select the Category of report you want to run.

e. Select the Report you want to run.

f. Select OK.

5. Select OK.

The report runs.
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Reports Historical Tab 5

The Reports Historical tab is where you select and run reports that will give 
you information tabulated over a period of time. The following graphic 
shows the Historical tab.

From the Historical tab, you can select the items that are listed in the 
following table:

Note The options available in the Historical tab vary depending on what 
ECS or switch and what ECS/switch options you have.

Note For more detail on the following reports, please refer to the 
CentreVu CMS Real-Time and Historical Reports (585-215-821) 
document and Chapter 16, “Historical Reports,” in this book.
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Category Report Name Description

Agent Attendance Shows the staffed time, ACD time, ACW 
time, AUX time, time in RING, EXTN 
time, AVAIL time, and number of calls 
handled by an agent for a specified time 
period for all split/skills to which the 
agent belongs.
(Daily, Monthly, Weekly) 

AUX Shows time that an agent spent in each 
AUX reason code.
(Daily, Interval, Monthly, Weekly)

Event Count Shows the total number of times that an 
agent has pressed an Event Count 
(Stroke Count) key for all splits/skills.
(Daily, Interval, Monthly, Weekly)

Graphical Time 
Spent Daily

Graphically shows the time spent by an 
agent in each work state and in each 
AUX reason for the specified day.

Group Attendance Shows the staffed time, ACD time, ACW 
time, AUX time, time in RING, EXTN 
time, AVAIL time, and number of calls 
handled for each agent in an agent 
group for a specified time period for all 
split/skills to which the agent belongs.
(Daily, Monthly, Weekly)

Group AUX Shows, for all agents in a group, time in 
each AUX reason code.

Group Summary Summarizes the daily activities of every 
agent within a specific agent group.
(Daily, Monthly, Weekly)

In/Outbound Shows a detailed breakdown of the 
inbound and outbound calls handled by 
an agent.
(Daily, Interval, Monthly, Weekly)
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Login/Logout 
(Skill)

Shows the agent login and logout times 
for agents in a skill on a specified day.

Login/Logout 
(Split)

Shows the agent login and logout times 
for agents in a specified split on a 
specified day.

Split/Skill Shows an individual agent’s 
performance by split/skill.
(Daily, Interval, Monthly, Weekly) 

Summary Shows the activities and performance of 
an individual agent for all splits/skills 
in which the agent is a member.
(Daily, Interval, Monthly, Weekly) 

Trace Lists each agent activity and the time it 
occurred.

Other Call Records Shows information about a specific call.

Call Work Code Reports on the call work codes that 
agents entered.
(Daily, Monthly, Weekly) 

Split/Skill Call Profile Shows the number of calls answered 
and abandoned in time increments you 
administer.
(Daily, Monthly, Weekly) 

Graphical ASA Shows the average speed of answer for 
ACD calls answered in the specified 
splits/skills.

Graphical Call 
Profile Daily

Graphically shows how well the 
split/skill you specify performed 
compared to your predefined service 
levels.

Category Report Name Description
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Graphical Service 
Level Interval

Graphically shows the percentage of 
ACD calls answered within the 
predefined acceptable service levels and 
the percentage of abandoned ACD calls.

Graphical Skill 
Time Spent Daily

Graphically shows the amount of time 
agents spent in each work state and in 
each AUX reason for the specified skill 
on the specified day.

Outbound Shows the numbers and average talk 
times for each type of outbound call for 
a spit/skill.
(Daily, Interval, Monthly, Weekly)

Report Shows the calls handled, agent time and 
assists, and transfers and holds for each 
agent in a split/skill.
(Daily, Monthly, Weekly)

Summary Summarizes the activity for an entire 
split/skill by time.
(Daily, Interval, Monthly, Weekly)

System Multi-ACD Summarizes data over all splits/skills in 
the ACD for each ACD requested.
(Daily, Monthly, Weekly) 

Multi-ACD by 
Split/Skill 

Summarizes call-handling information 
for different splits/skills and different 
ACDs.
(Daily, Monthly, Weekly) 

System Summarizes the activity for a set of 
split/skills for the same ACD.
(Daily, Monthly, Weekly) 

Trunk/
Trunk 
Group

Busy Hour Shows the busiest hour of the day for 
each trunk group you select.

Category Report Name Description
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Trunk Shows call traffic data for a single trunk.
(Daily, Interval, Monthly, Weekly) 

Trunk Group Summarizes the incoming and 
outgoing traffic of every trunk in a trunk 
group for the specified time period.
(Daily, Monthly, Weekly) 

Trunk Group 
Summary

Shows the level of incoming and 
outgoing call traffic for an individual 
trunk group.
(Daily, Interval, Monthly, Weekly)

VDN Busy Hour Shows call handling data for the busiest 
hour in the selected day for each 
selected VDN.

Call Profile Shows, in segments of progressively 
longer wait time, the numbers of 
answered/connected and abandoned 
calls that are processed by the VDN in 
the selected time period.
(Daily, Monthly, Weekly)

Graphical Call 
Profile Daily

Graphically shows how calls to the 
specified VDN are being handled 
compared to the predefined acceptable 
service level.

Graphical Service 
Level Interval

Graphically shows the percentage of 
ACD calls answered within the 
predefined acceptable service level and 
the percentage of abandoned ACD calls.

Multi-ACD Flow Shows call-handling data for the VDNs 
and the ACDs you select.
(Daily, Monthly, Weekly)

Category Report Name Description
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Report Shows historical information for a 
specified VDN and time frame.
(Daily, Interval, Monthly, Weekly)

Skill Preference Shows the number of calls answered, 
average talk time, and average after call 
time for calls, by skill preference, to the 
specified VDN.
(Daily, Interval, Monthly, Weekly)

Vector Vector Shows, for one vector, how well calls on 
that vector have been handled.
(Daily, Interval, Monthly, Weekly)

Category Report Name Description
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Reports Historical Input Windows 5

When you select a report to run from the Historical tab, an input window 
displays. The historical report input windows vary, based on which category 
(agent, split/skill, trunk/trunk group, VDN, vector, or other) and type 
(interval, daily, weekly, monthly) of report you are running. Below is an 
example of each type of input window you will see.

1 2

1. Input Field(s)
2. History List
3. Browse Button
4. Destination Selection
5. Current ACD

3

4 5
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To run the historical report, do the following steps:

1. Fill in the input field(s).

2. Input fields are where you specify the information you are running the 
report for. 
● Interval historical reports usually have the following input fields:

— One for the kind of information on the report (split/skill, agent, 
trunk, trunk group, vector, or VDN)

— One for the date for which the report will be run 

— One for the time intervals to be included in the report.
● Daily historical reports usually have the following input fields:

— One for the kind of information on the report (split/skill, agent, 
trunk, trunk group, vector, or VDN)

— One for the date for which the report will be run.

Note The input windows for Weekly and Monthly reports is similar to the 
Daily input window shown above.
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● Weekly and Monthly historical reports usually have the following 
input fields:

— One for the kind of information on the report (split/skill, agent, 
trunk, trunk group, vector, or VDN) 

— One for the start date for which the report will be run.

To complete the input fields, do any of the following steps:
● Type in the name or number of the input requested.
● Press the Browse button to view all of the available inputs.
● Use the history list to select an input that you have previously 

used for this report.

3. Select the report destination.

Historical reports can be viewed on screen or printed to any printer 
your PC is connected to, or any PC on your LAN. You can specify the 
destination for individual reports on the report input window. If you 
want to view the report on screen, select the View Report On Screen 
option. If you want to print the report, select the Print Report On: 
option. If you want to print the report on a printer other than the one 
shown in the Print Report On: field, select the Print Setup button  
and select a different printer.

4. Ensure that the correct ACD is selected.

The current ACD (selected on the Reports selector window) is 
displayed at the bottom of the input window.

If you want to run a report for a different ACD than is selected, do the 
following steps:

a. If you are in a report input window, select Cancel to exit the report 
input window.

*Microsoft is a registered trademark of Microsoft Corporation.
†Windows is a registered trademark of Microsoft Corporation.

Note Supervisor Print Setup works the same as the Print Setup in 
other Microsoft* Windows† applications.
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b. Select Reports from the Commands menu.

c. Change the ACD on the Reports selector window.

d. Select the Category of report you want to run.

e. Select the Report you want to run.

f. Select OK.

5. Select OK.

The report runs.
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Reports Integrated Tab 5

The Reports Integrated tab is where you select reports that refresh in real-
time and show information that is accumulated from any point in time in 
the past 24 hours. The following graphic shows the Integrated tab.

From the Integrated tab, you can select the items that are listed on the 
following table:

Note The options available in the Integrated tab vary depending on what 
ECS or switch and what ECS/switch options you have.

Note For more detail on the following reports, refer to Chapter 17, 
“Integrated Reports,” in this book.
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Category Report Name Description

Agent Graphical 
Information

Graphically shows information and 
statistics for an agent since a 
specified start time.

Information Shows information and statistics for 
an agent since a specified start time. 
This report is not available with the 
EAS feature.

Split/Skill Comparison 
Report

Shows the current status and 
cumulative data for one or splits or 
skills.

Graphical 
Split/Skill View

Graphically shows the status of 
agents in the split/skill, and 
cumulative split/skill statistics. 

VDN Graphical Call 
Handling

Graphically shows, for each VDN, 
the cumulative number of calls that 
are answered, abandoned, 
considered outflow calls, and 
includes ASA.
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Reports Integrated Input Windows 5

When you select a report to run from the Integrated tab, an input window 
displays. The integrated report input windows vary, based on which type of 
report you are running. Below is an example of an integrated report input 
window.

To run the integrated report, do the following steps:

1. Fill in the input field(s).

Input fields are where you specify the information you are running the 
report for. Most integrated reports have one input field. The input field 
can ask for split/skill, agent group, trunk group, VDN, or vector. You 
must complete the input field(s) to run the report.

1 32

6

5

4

1. Input Field(s)
2. History List
3. Browse Button
4. Start Time

5. Refresh Rate
6. Check-Boxes
7. Current ACD

7
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You can use any of the following methods to complete the input field:
● Type in the name or number of the input requested.
● Press the Browse button to view all of the available inputs for which 

you have permissions.
● Use the history list to select an input that you have previously used.

2. Select the Report Start Time, which is the time of day, within the past 24 
hours, from which you want the report to begin accumulating data.

3. Select a Refresh Rate.

The refresh rate determines how often the report is updated to display 
new data.

Your fastest allowable refresh rate is defined in the User Permissions — 
User Data window. For any user, the fastest rate that may be defined is 
every 3 seconds. The actual speed at which a report refreshes may be 
slower than the defined speed, since the number of active terminals, the 
number of active windows, and the number of real-time reports can 
have an impact on refresh rates.

The default refresh rate when you bring up the report input window is 
your minimum refresh rate plus 15 seconds. You can change the default 
refresh rate on the report input window. To modify your minimum 
refresh rate, contact your CMS administrator.

To change the refresh rate, you can do either of the following steps:
● Type in the number of seconds you want to pass between updates.
● Use the up/down arrows to select a number of seconds.

4. Enable/Disable the check boxes.
● Enable Report Thresholds — lets you display specific thresholds 

for items displayed on reports. See the “Setting Report Threshold 

Note The processor speed of and the amount of RAM on your PC can 
affect refresh rates. Slower PCs or ones with little RAM may 
require that you use a slower refresh rate. The processor speed 
of the CMS server can also affect refresh rates.
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Highlights” section in this chapter for more information on setting 
and using report threshold highlights.

● Run Minimized — starts the report minimized, if checked. To open 
a minimized report, double click on the report icon.

5. Ensure that the correct ACD is selected.

The current ACD (selected on the Reports selector window) is 
displayed at the bottom of the input window.

If you want to run a report for a different ACD than is selected, do the 
following steps:

a. If you are in a report input window, select Cancel to exit the report 
input window.

b. Select Reports from the Commands menu.

c. Change the ACD on the Reports selector window.

d. Select the Category of report you want to run.

e. Select the Report you want to run.

f. Select OK.

6. Select OK.

The report runs.

Note Because Integrated reports require that information be collected 
from the historical database tables, they may be slower to initialize 
than are real-time reports.
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Drill-Down Reports 5

Supervisor reports allow you to “drill-down” to very detailed information 
from a variety of places. A “drill-down” report is a report that gives you 
very specific information on an agent or a work state in a split/skill. 

You can access drill-down reports in the following ways:

● Double click on an element in a report that allows you to access a drill-
down report

● Single click on an element in a report that allows you to access a drill-
down report and then using the right mouse button menu to select a 
specific drill-down report

● Use the Tools menu to select any of the drill-down reports that are 
accessible from the currently running report.

You can tell if the report you are currently running accesses a drill-down 
report(s) (and which drill-down reports are available) by moving the mouse 
cursor over information on the report and reading the status bar at the 
bottom left-hand side of the report window. The following two graphics 
give examples of the types of report elements you can use to access drill-
down reports and the drill-down reports that will display. 

There are two basic elements on reports that you can double click or single 
click on and use the right mouse button menu to access drill-down reports:

● Agent names or Login IDs — drill-down to agent-specific information 
reports

● Work states (AUX, Avail, ACD, ACW, Ring, Other) — drill-down to 
work state reports or AUX Agents reports (ECS only).

See the following paragraphs for information on which drill-down reports 
are accessible from specific reports.
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Status bar description
of accessible drill-down report
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Many reports allow you to access more than one drill-down report. You can 
use the Tools menu or the right mouse button menu to see all of the drill-
down reports that are available for the current report.

The type of drill-down report that you access depends on what kind of 
report you are currently running and where on the report you double click 
to access the drill-down report. 

Status bar description
of accessible drill-down report
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Drill-Down Reports Descriptions 5

The following table gives a brief description of each of the reports you can 
access using the drill-down procedures. Note that the Agent Work State and 
Top Agent Work State Real-Time reports are not available from the Reports 
selector window. They can be accessed only through other reports.

Real-Time Drill-Down Reports

Category Report Name Description

Agent Graphical 
Information

Shows graphical information and 
statistics for the specified agent.

Information Shows information and statistics for 
the specified agent.

Split/Skill Graphical AUX 
Agents

Shows all agents with the specified 
skill who are in AUX, the reason for 
being in AUX, and the time in AUX.

Graphical AUX Top 
Agents

Shows all top agents with the specified 
skill who are in AUX, the reason for 
being in AUX, and the time in AUX.

Work State Shows all of the agents who are in the 
specified work state and the time in 
that state.

Top Agent Work 
State

Shows top agents who are in the 
specified work state and the time in the 
state. Also shows all of the agents who 
are staffed even if they are not in a 
particular state for the specified 
split/skill.

Integrated Drill-Down Report

Agent Graphical 
Information

Shows, since a specified start time, 
information and statistics for an agent.
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Real-Time Reports Drill-Down Information 5

The following table gives you information about which drill-down reports 
are accessible from specific Real-Time reports.

This Real-Time report: Drills-down to this report:

Agent Agent Group 
Report

● Real-Time Agent Information
● Integrated Agent Information

Agent Report ● Real-Time Agent Information
● Integrated Agent Information
● Real-Time Agent Work State
● Real-Time Split/Skill Graphical AUX 

Agents (ECS with EAS only)

Split/Skill Graphical AUX 
Agents Report

● Real-Time Agent Information
● Integrated Agent Information

Graphical AUX 
Top Agents Report

● Real-Time Agent Information
● Integrated Agent Information

Graphical Status ● Real-Time Agent Information
● Integrated Agent Information
● Real-Time Agent Work State
● Real-Time Split/Skill Graphical AUX 

Agents (ECS with EAS only)

Graphical Top 
Skill Status

● Real-Time Agent Information
● Integrated Agent Information
● Real-Time Agent Top Work State
● Real-Time Split/Skill Graphical AUX 

Top Agents (ECS with EAS only)

Skill AUX Report ● Real-Time Split/Skill Graphical AUX 
Agents (ECS with EAS only)

Skill Status ● Real-Time Agent Information
● Integrated Agent Information
● Real-Time Agent Top Work State
● Real-Time Split/Skill Graphical AUX 

Top Agents (ECS with EAS only)
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Skill Top Agent ● Real-Time Agent Top Work State
● Real-Time Split/Skill Graphical AUX 

Top Agents (ECS with EAS only)

Split Status ● Real-Time Agent Information
● Integrated Agent Information
● Real-Time Agent Work State

Split/Skill Report ● Real-Time Agent Work State
● Real-Time Split/Skill Graphical AUX 

Agents (ECS with EAS only)

Top Agent Status ● Real-Time Agent Information
● Integrated Agent Information
● Real-Time Agent Top Work State
● Real-Time Split/Skill Graphical AUX 

Top Agents (ECS with EAS only)

Other Event Count 
Summary

● Real-Time Agent Information
● Integrated Agent Information

Multi-ACD Report ● Real-Time Agent Work State
● Real-Time Split/Skill Graphical AUX 

Agents (ECS with EAS only)

Multi-ACD by 
Top Agent Report

● Real-Time Agent Top Work State
● Real-Time Split/Skill Graphical AUX 

Top Agents (ECS with EAS only)

This Real-Time report: Drills-down to this report:
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Historical Reports Drill-Down Information 5

The following table gives you information about which drill-down reports 
are accessible from specific Historical reports.

Queue/
Agent

Queue/Top Agent 
Status

● Real-Time Agent Top Work State
● Real-Time Split/Skill Graphical AUX 

Top Agents (ECS with EAS only)
● Real-Time Agent Work State
● Real-Time Agent Information
● Integrated Agent Information

Status ● Real-Time Agent Work State
● Real-Time Split/Skill Graphical AUX 

Agents (ECS with EAS only)
● Real-Time Agent Information
● Integrated Agent Information

Summary ● Real-Time Agent Work State

This Historical report: Drills-down to this report:

Agent Group AUX
(Daily, Weekly, Monthly)

● Real-Time Agent Information
● Integrated Agent Information

Group Attendance
(Daily, Weekly, Monthly)

● Real-Time Agent Information
● Integrated Agent Information

Group Summary
(Daily, Weekly, Monthly)

● Real-Time Agent Information
● Integrated Agent Information

Login/Logout ● Real-Time Agent Information
● Integrated Agent Information

Split/Skill Report
(Daily, Weekly, Monthly)

● Real-Time Agent Information
● Integrated Agent Information

This Real-Time report: Drills-down to this report:
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Integrated Reports Drill-Down Information 5

The following table gives you information about which drill-down reports 
are accessible from specific Historical reports.

This Integrated report: Drills-down to this report:

Split/Skill Graphical 
Split/Skill View

● Real-Time Agent Work State
● Real-Time Split/Skill Graphical AUX 

Agent
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Changing Agent Splits/Skills While in a Report 5

You can change an agent’s splits (non-EAS) or skills (EAS) from a running 
report while the agent is logged in by selecting the agent’s name and doing 
one of the following actions:

● Selecting Change Agent Skills from the Tools menu

● Selecting Change Agent Skills from the right mouse button menu.

Refer to the Supervisor on-line help for definitions of the agent state icons 
you see on some reports.

Note If you have the ECS or a G3V4 switch, the changes to agent skills 
will take place without the agent logging out. If you have any 
other switch that allows you to change agent splits/skills, the 
changes are not made until the agent logs out and logs back in.
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Setting Report Threshold Highlights 5

Report threshold highlights let you set visual flags to key you when a real-
time data item is out of acceptable bounds. This feature enables you to run a 
report minimized and be notified (through color/symbol changes) when an 
item has passed a specific threshold.

You can set threshold highlights only for real-time data items in real-time or 
integrated reports. The threshold highlights you set will tell you when data 
for an entity (split/skill, agent, agent group, or VDN) has reached a certain 
level (threshold), as defined by you.

Threshold highlight settings apply to a single entity on a specific ACD. For 
example, if you run a real-time split report for Split 17 on ACD 1 and set the 
threshold highlights, the threshold settings apply to Split 17 on ACD 1 for all 
reports you run for that split and ACD. Also, the threshold highlight 
settings are saved on the PC you are currently using. So, if you move to 
another PC, you need to set up the threshold highlights on that PC. If 
multiple users log into the same PC, each user’s threshold highlight settings 
are saved individually.

By default, the thresholds for each report are turned on, but the threshold 
highlight settings are empty and the sample size threshold is zero. 
Therefore, no threshold highlights show on any reports until you create 
them using the Threshold Settings window. You can turn thresholds on and 
off for each report by selecting/deselecting the Thresholds Settings check 
box in the report input window, or by selecting Threshold Settings from the 
Options menu in the report output window.

An example of setting report threshold highlights is to set thresholds for 
Time on ACD Calls in the skill named Sales. You might set the High Caution 
threshold to 50 seconds and the High Warning threshold to 60 seconds. If an 
agent spends more than 50 seconds, but less than 60 seconds, on an ACD call 
in the Sales skill, the item on the report will highlight with the High Caution 
threshold color. If the time exceeds 60 seconds, the item on the report will 
highlight with the High Warning threshold color. However, if the agent 

Note Report threshold highlights are not the same as CMS Exceptions 
Thresholds. The threshold highlighting you can do with this feature 
is available through the Supervisor interface only.
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spends more than 50 seconds on an ACD call in any other skill (that does not 
have the same thresholds), the item on the report will not display any 
threshold highlighting.

To set report threshold highlights do the following steps:

1. Run a report that contains real-time data (a real-time or integrated 
report)

2. Select on a data item in the report for which you can set threshold 
highlights

3. Select Threshold Settings from the right mouse button or from the 
Tools menu.

4. Complete the Threshold Settings window:

Note When a data item(s) for which threshold highlights can be set is 
selected, the Threshold Settings menu item is enabled. When 
the data item that is selected does not allow thresholds, an error 
message will display. See the tables later in this section for a list 
of the report outputs that allow threshold highlighting.
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The Threshold Settings window includes the following information and 
text boxes:
● Item: — shows the name of the report threshold that applies to the 

selected data value. In most cases, this box contains a single entry. If 
the data value is agent “Time in State” or “Time in Workmode,” or 
agent group “Time in State” or “Time in Workmode,” then this list 
box contains multiple names, one for each possible agent state or 

Note Depending on which data item you have selected, the Sample 
Size box at the bottom of the Threshold Settings window may or 
may not be visible. If you selected a data item that is a 
percentage or an average, the Sample Size box is present.

3

5

2

1 
 

4

1. Data Item Threshold Definition
2. Item
3. Description
4. Icons
5. Thresholds
6. Sample Size

6
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workmode. Threshold highlights can be set for each individual state 
and workmode.

● Description: — shows a description of the threshold currently 
selected.

● Thresholds — shows the colors (as defined in the Options 
Threshold Colors tab, accessed from the Tools menu), symbols, and 
current numerical settings for the threshold highlights of this item. 
For thresholds that are time-related, the numbers you enter are in 
seconds. For example, if you are entering a High Caution threshold 
for three minutes, type 180 (for 180 seconds) in the High Caution 
field.

— Low Warning — contains the current value for the Low 
Warning threshold for the selected data item. If no value is 
defined, the field is blank. You can set the value to any positive 
integer from 0 to 999,999,999 or leave it blank. If the field is 
blank, no threshold is set.

— Low Caution — contains the current value for the Low Caution 
threshold for the selected data item. If no value is defined, the 
field is blank. You can set the value to any positive integer from 
0 to 999,999,999 or leave it blank. If the field is blank, no 
threshold is set.

— High Caution — contains the current value for the High 
Caution threshold for the selected data item. If no value is 
defined, the field is blank. You can set the value to any positive 
integer from 0 to 999,999,999 or leave it blank. If the field is 
blank, no threshold is set.

— High Warning — contains the current value for the High 
Warning threshold for the selected data item. If no value is 
defined, the field is blank. You can set the value to any positive 
integer from 0 to 999,999,999 or leave it blank. If the field is 
blank, no threshold is set.

● Sample Size — contains the current value for the Sufficient Sample 
Size value. You can set this to any value from 0 to 999. When you set 
Sufficient Sample Size value, you are defining a minimum number 
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of items that must be currently tracked before the threshold 
highlighting is enabled.

5. Select OK.

Tips for Setting Report Threshold Highlights 5

Keep the following tips in mind when you are setting report threshold 
highlights.

● Before you can administer threshold highlights for a data item, you 
must first click on the data item in the report to select it. When a data 
item is highlighted in a grid (standard) report, it is outlined with a 
dotted line. When a data item is highlighted in a chart (Graphical) 
report, it has “pull-bars” around the perimeter.

● See the “Available Agent Threshold Settings,” “Available Split/Skill 
Threshold Settings,” and “Available VDN Threshold Settings” sections 
in this chapter for more information on the real-time data items in 
reports for which you can set threshold highlights.

● In standard reports, you can select items from the grid or from the 
output information at the top of the report.

● In chart reports, you can select items from the pie charts, bar charts, 
graphical reports, or grids.

● When you set threshold highlights for an entity (split/skill, agent, agent 
group, or VDN), that set of threshold highlights applies to every report 
that is run specifically for that entity.

● The report threshold highlights are updated with each refresh of the 
report, but not between report refreshes.

● The numbers you define for the threshold highlights must increase from 
left to right (the number you use for Low Warning must be less than the 
number you use for High Warning).
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● You can set the label colors by choosing Options from the Tools menu 
on the Controller. Depending on how you define the colors, the sample 
size threshold can behave in the following ways: 

— If you want to be alerted to the fact that a particular calculation is 
not statistically significant, set the Insufficient color to a different 
color than any other threshold condition. This causes data with 
insufficient sample size to be highlighted in a special color.

— If you want to ignore values with insufficient sample sizes, set the 
Insufficient color to be black text on a gray background. This causes 
the value with insufficient sample size to not be highlighted. 

● Setting report threshold highlights affects how report data is displayed 
in the following ways:

— If the data calculation contains a non-zero Sample Size threshold, 
the denominator of the specified calculation is compared to the 
Sample Size threshold. If the denominator is less than the Sample 
Size threshold, the value displays in the “Insufficient” color, 
indicating that the sample size is insufficient for the value to be 
significant. 

— If the sample size is sufficient or if there is no sample size associated 
with the data, then the data value is compared to the Low Warning, 
Low Caution, High Caution, and High Warning threshold values to 
determine which band applies. The value is displayed in the color 
associated with the appropriate threshold.
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Available Agent Threshold Settings 5

All of the data that Supervisor uses for agent threshold highlights are 
retrieved from the cagent (current interval agent) database table. See 
Appendix A of the CentreVu CMS Real-Time and Historical Reports
(585-215-821) document for more information on the database tables. The 
agent threshold highlights you can set are as follows:

Threshold Description/Database Item or Calculation

Time in AUX State Description — Amount of time the agent is in the 
Auxiliary Work state. 
Measures — DURATION while AGSTATE = AUX

Time in AUX-IN 
State

Description — Amount of time the agent is on an 
incoming call while in the Auxiliary Work state. 
Measures — DURATION while AGSTATE = 
AUX-IN

Time in AUX-OUT 
State

Description — Amount of time the agent is on an 
outgoing call while in the Auxiliary Work state.
Measures — DURATION while AGSTATE = 
AUX-OUT

Time in ACW State Description — Amount of time the agent is in the 
After Call Work state. 
Measures — DURATION while AGSTATE = ACW

Time in ACW-IN 
State

Description — Amount of time the agent is on an 
incoming call while in the After Call Work state.
Measures — DURATION while AGSTATE = 
ACW-IN

Time in ACW-OUT 
State

Description — Amount of time the agent is on an 
outgoing call while in the After Call Work state.
Measures — DURATION while AGSTATE = 
ACW-OUT

Time in AVAIL State Description — Amount of time the agent is in the 
Available state.
Measures — DURATION while AGSTATE = 
AVAIL.
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Time in ACD State Description — Amount of time the agent is in the 
ACD state. 
Measures — DURATION while AGSTATE = ACD

Time in ACD-IN 
State

Description — Amount of time the agent is in the 
ACD-IN state. 
Measures — DURATION while AGSTATE = 
ACD-IN

Time in ACD-OUT 
State

Description — Amount of time the agent is in the 
ACD-OUT state. 
Measures — DURATION while AGSTATE = 
ACD-OUT

Time in DACD State Description — Amount of time the agent is in the 
DACD state.
Measures — DURATION while AGSTATE = 
DACD

Time in DACD-IN 
State

Description — Amount of time the agent is in the 
DACD-IN state.
Measures — DURATION while AGSTATE = 
DACD-IN

Time in DACD-OUT 
State

Description — Amount of time the agent is in the 
DACD-OUT state. 
Measures — DURATION while AGSTATE = 
DACD-OUT

Time in DACW State Description — Amount of time the agent is in the 
DACW state.
Measures — DURATION while AGSTATE = 
DACW

Time in DACW-IN 
State

Description — Amount of time the agent is in the 
DACW-IN state. 
Measures — DURATION while AGSTATE = 
DACW-IN

Threshold Description/Database Item or Calculation
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Time in DACW-OUT 
State

Description — Amount of time the agent is in the 
DACW-OUT state. 
Measures — DURATION while AGSTATE = 
DACW-OUT

Time in RING State Description — Amount of time the agent is in the 
RING state. 
Measures — DURATION while AGSTATE = RING

Time AUX 
Workmode

Description — Amount of time the agent is in the 
Auxiliary Work workmode, including incoming 
and outgoing calls. This time measures the entire 
time the agent remains in AUX, regardless of any 
incoming or outgoing calls handled.
Measures — AGTIME while WORKMODE = AUX.

Time in ACD 
Workmode

Description — Amount of time the agent is in the 
ACD workmode, including incoming and 
outgoing calls. This time measures the entire time 
the agent remains in ACD, regardless of any 
incoming or outgoing calls handled.
Measures — AGTIME while WORKMODE = ACD

Time in ACW 
Workmode

Description — Amount of time the agent is in the 
ACW workmode, including incoming and 
outgoing calls. This time measures the entire time 
the agent remains in ACW, regardless of any 
incoming or outgoing calls handled.
Measures — AGTIME while WORKMODE = ACW

Time in AVAIL 
Workmode

Description — Amount of time the agent is in the 
AVAIL workmode, including incoming and 
outgoing calls. This time measures the entire time 
the agent remains in AVAIL, regardless of any 
incoming or outgoing calls handled.
Measures — AGTIME while WORKMODE = 
AVAIL

Threshold Description/Database Item or Calculation
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*Sample Size thresholds apply.

Time in DACD 
Workmode

Description — Amount of time the agent is in the 
Direct ACD workmode. This time measures the 
entire time the agent remains in DACD, regardless 
of any incoming or outgoing calls handled. 
(Applies only to Generic 3 switches.)
Measures — AGTIME while WORKMODE = 
DACD

Time in DACW 
Workmode

Description — Amount of time the agent is in the 
Direct After Call Work workmode, including 
incoming and outgoing calls. This time measures 
the entire time the agent remains in DACW, 
regardless of any incoming or outgoing calls 
handled.
Measures — AGTIME while WORKMODE = 
DACW

Calls in Direct Agent 
Queue

Description — Number of Direct Agent calls that 
are queued to the agent. DA_INQUEUE is the 
current number of Direct Agent calls waiting in 
any split/skill queue for a specific agent. (Applies 
only to Generic 3 switches.)
Measures — DA_INQUEUE

Time call waiting in 
Direct Agent Queue

Description — Amount of time the caller has waited 
in the Direct Agent queue. DA_OLDESTCALL is 
the length of time that the oldest Direct Agent call 
has waited in any split/skill queue for this agent. 
(Applies only to Generic 3 switches.)
Measures — DA_OLDESTCALL

Average talk time* Description — Average length of time the agent 
spends talking on ACD calls. 
Measures — AVG_AGENT_TALK_TIME 
calculation.

Threshold Description/Database Item or Calculation
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Available Split/Skill Threshold Settings 5

All of the data that Supervisor uses for split/skill threshold highlights are 
retrieved from the csplit (current interval split) database table. See 
Appendix A of the CentreVu CMS Real-Time and Historical Reports 
(585-215-821) document for more information on the database tables. The 
split/skill threshold highlights you can set are as follows:

Threshold Description/Database Item or Calculation

Oldest call waiting Description — Amount of time the oldest call to 
this split/skill has waited in queue. 
OLDESTCALL is the number of seconds the 
oldest split/skill ACD call has waited in queue or 
ringing.
Measures — OLDESTCALL

Number of calls 
waiting in Queue

Description — Number of calls queued to this 
split/skill. The computation measures the number 
of calls in queue or ringing at an agent position.
Measures — INQUEUE + INRING

Number of calls 
abandoned

Description — Number of calls that were queued 
to this split/skill and then abandoned. 
ABNCALLS is the number of calls offered to a 
split/queue which were subsequently abandoned 
by the caller.
Measures — ABNCALLS

Average Speed of 
Answer*

Description — Number of seconds, on average, 
before a call to this split/skill is answered. 
Average speed of answer is the ANSTIME (time 
spent by callers in queue or ringing before being 
answered) divided by the ACDCALLS (number of 
calls queued to the split/skill that were answered 
by an agent at this split/skill).
Measures — AVG_ANSWER_SPEED

Average Talk Time* Description —Average length of time spent on 
ACD calls to the split/skill.
Measures — AVG_ACD_TALK_TIME
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Average time to 
abandon*

Description — Average length of time callers 
waited before abandoning calls to the split/skill. 
Measures — AVG_ABANDON_TIME

Number of calls 
forced busy

Description — Number of calls to the split/skill 
that were given a busy signal by the switch. 
Measures — BUSYCALLS

Number of calls 
disconnected

Description — Number of calls to the split/skill 
that were disconnected by the switch.
Measures — DISCCALLS

Percent of calls 
answered in service 
level*

Description — Percentage of ACD calls to the 
split/skill that were answered within the service 
level. 
Measures — PERCENT_SERV_LVL_SPL

Percent of calls 
abandoned*

Description — Percentage of ACD calls to the 
split/skill that were abandoned.
Measures — PERCENT_CALL_ABAN

Number of agents 
staffed

Description — Number of agents logged into the 
split/skill.
Measures — STAFFED

Percent of calls 
answered*

Description — Percent of ACD calls offered to the 
split/skill that were answered.
Measures — PERCENT_CALL_ANS

Call Profile Abandon 
per service level 
increment

Description — Number of abandoned calls to the 
split/skill for any service level increment. A single 
report threshold applies to all of the values. If the 
number of abandoned calls for the split/skill 
reaches the threshold for any of the service level 
increments, the value for that service level 
increment is highlighted.
Measures — ABNCALLS1 through ABNCALLS10

Threshold Description/Database Item or Calculation
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*Sample Size thresholds apply

Rolling Average 
Speed of Answer

Description — Switch-based Rolling Average 
Speed of Answer for this split/skill. The Rolling 
Average Speed of Answer is the average speed of 
answer across intervals.
Measures — ASA

Expected Wait Time 
(Low)

Description — Expected Wait Time for a call 
queued to this split/skill at a low priority level.
Measures — EWTLOW

Expected Wait Time 
(Medium)

Description — Expected Wait Time for a call 
queued to this split/skill at medium priority level.
Measures — EWTMEDIUM

Expected Wait Time 
(High)

Description — Expected Wait Time for a call 
queued to this split/skill at high priority level.
Measures — EWTHIGH

Expected Wait Time 
(Top)

Description — Expected Wait Time for a call 
queued to this split/skill at top priority level.
Measures — EWTTOP

Threshold Description/Database Item or Calculation
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Available VDN Threshold Settings 5

All of the data that Supervisor uses for VDN threshold highlights are 
retrieved from the cvdn (current interval VDN) database table. See 
Appendix A of the CentreVu CMS Real-Time and Historical Reports
(585-215-821) document for more information on the database tables. The 
VDN threshold highlights you can set are as follows:

Threshold Description/Database Item or Calculation

Number of calls 
abandoned during the 
interval

Description — Number of calls that were queued 
to this VDN and then abandoned.
Measures — ABNCALLS

Number of calls 
forced busy during 
the interval

Description — Number of calls to the VDN that 
were given a busy signal by the switch.
Measures — BUSYCALLS

Number of calls 
disconnected during 
the interval

Description — Number of calls to the VDN that 
were disconnected by the switch via the vector 
“disconnect” command.
Measures — DISCCALLS

Oldest call waiting Description — Number of seconds the oldest call 
has waited in this VDN.
Measures — OLDESTCALL

Number of calls 
waiting

Description — Number of calls queued to this 
VDN that have not been answered by an agent.
Measures — INPROGRESS - ATAGENT

Percent of calls 
answered in service 
level*

Description — Percentage of ACD calls to the 
VDN that were answered within the service level.
Measures — 100*(ACCEPTABLE / INCALLS)

Percent of calls 
abandoned*

Description — Percentage of ACD calls to the 
VDN that were abandoned.
Measures — 100*(ABNCALLS / INCALLS)

Percent of calls 
answered*

Description — Percentage of ACD calls offered to 
the VDN that were answered.
Measures — 100*[(ACDCALLS + 
CONNECTCALLS) / INCALLS]
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Call Profile Abandon 
per service level 
increment

Description — Number of abandoned calls to this 
VDN for any service level increment. A single 
report threshold applies to all of the values. If the 
number of abandoned calls for the VDN reaches 
the threshold for any of the service level 
increments, the value for that service level 
increment is highlighted.
Measures — ABNCALLS1 through ABNCALLS10

Average Speed of 
Answer*

Description — Number of seconds, on average, 
before a call to this VDN is answered. This value 
is the time callers spent in queue or ringing 
before being answered divided by the number of 
calls queued to the VDN that were answered by 
an agent at this VDN.
Measures — AVG_ANSWER_SPEED

Average Talk Time* Description — Average length of time spent on 
ACD calls to the VDN.
Measures — AVG_ACD_TALK_TIME

Average Time to 
Abandon*

Description — Average length of time callers 
waited before abandoning calls to the VDN.
Measures — AVG_ABANDON_TIME

Rolling Average 
Speed of Answer

Description — Switch-based Rolling Average 
Speed of Answer for this VDN. The Rolling 
Average Speed of Answer is the average speed of 
answer across intervals.
Measures — ASA

Threshold Description/Database Item or Calculation
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Introduction 6

This chapter teaches you how to use the Operations and Reports tabs in the 
Dictionary command. It also gives you information on performing tasks 
that are specific to the Dictionary command.

The sections in this chapter are as follows:
● About Dictionary
● Starting Dictionary
● Dictionary Operations Tab
● Dictionary Operations Input Windows
● Dictionary Reports Tab
● Dictionary Report Input Windows
● Assigning Names Using Dictionary
● Creating Agent Groups
● Deleting Agents from an Agent Group.

How Dictionary works in CMS is not described in detail in this chapter. For 
more information on Dictionary operations and reports, please refer to the 
“Dictionary” chapter in the CentreVu CMS R3V5 Administration
(585-215-820) document.
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About D ictionary 6

From the Dictionary command, you can perform the following functions:

● Enter CentreVu CMS login IDs and corresponding agent names.

● Assign names to splits/skills, trunk groups, call work codes, ACDs, 
AUX reason codes, logout reason codes, VDNs, and vectors.

● Create agent groups.

● Modify agent, split/skill, and trunk string values.

● View standard CentreVu CMS database items and calculations. 

● Define your own calculations, constants, and custom database items.

● Globally search for anything in the Dictionary subsystem and search for 
patterns from any data entry field.

● Obtain a report on most parts of the Dictionary subsystem.

Note Items that are not administered in Dictionary do not show up as 
global search items.
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Starting D ictionary 6

To select any Dictionary item do the following steps:

1. Choose Dictionary from the Commands menu.

OR

Select the Dictionary button  on the toolbar.

2. The Dictionary window appears. You will see the following tabs to 
choose from:
● Operations
● Reports.
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Dictionary Operations Tab 6

The following graphic shows the Dictionary Operations available in 
Supervisor. Splits/Skills, Standard CMS Items, Trunk Groups, Trunk String 
Values, VDNs, and Vectors are not shown in the visible window area when 
the window first opens. Use the scroll bar to the right of the Operations list 
box to display these options.

You may choose the following items from the Dictionary Operations tab.

● ACDs — use to assign names to any real or pseudo ACDs located on the 
switch or in ACD administration.

● Agent Groups — use to create and name, copy, or delete agent groups. 
Use this window to add, delete, or list the agents in a group.

● Agent String Values — use to modify the descriptive words (that 
appear as field values) on reports dealing with agents. For example, you 
may modify names of agent states such as “ACD,” “ACW,” or “AVAIL.”

Note For more detail on the following Dictionary items, please refer to the 
“Dictionary” chapter of the CentreVu CMS R3V5 Administration 
(585-215-820) document.
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● AUX Reason Codes — use to assign names to AUX reason codes. AUX 
reason codes enable a call center to track an agent’s time more precisely 
when the agent is in the AUX state.

● Calculations — use to define names for calculations that are used in 
reports on CentreVu CMS.

● Call Work Codes — use to assign names to call work codes.

● Constants — use to define items with fixed numerical values that you 
can enter into the database and use in custom reports.

● Custom Items — use to define your own database items which are 
stored in their own tables within the CMS database.

● Global Search — use to search for anything in Dictionary (for example, 
a Login ID).

● Login Identifications — use to assign agent names to CMS login IDs.

● Logout Reason Codes — use to assign names to logout reason codes. 
These codes enable an agent to specify the reason for logging out, such 
as the end of a shift or training.

● Split/Skill String Values — use to modify the descriptive words (that 
appear as field values) on the Split/Skill Call Profile reports.

● Splits/Skills — use to assign names (to make your reports easier to 
identify and read) to your ACD splits or skills.

● Standard CMS Items — use to display the names of columns in CMS 
database tables. CMS uses the database tables to collect, store, and 
retrieve report information.

● Trunk Groups — use to assign names (to make your reports easier to 
identify and read) to your trunk groups.

● Trunk String Values — use to modify the descriptive words (that 
appear as field values) on trunk reports.

● VDNs — use to assign names to VDNs so that names, instead of VDN 
numbers, appear on VDN reports and administration windows.

● Vectors — use to assign names to vectors so that names, instead of 
vector numbers, appear on vector reports and administration windows.
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When you select an item from the Dictionary Operations list, an input 
window displays. Below is an example of one of the input windows that you 
will see.

The input window that displays is dependent on the operation you selected. 

● Menu Bar — includes pull-down lists for CMS Actions (Add, Delete, 
Modify, Find One, Next, Previous, List All, and Exit), Edit options (Cut, 
Copy, Paste, and Clear All), and Supervisor Help.

● Toolbar Action Buttons — let you perform CMS actions (Add, Delete, 
Find One, Next, Previous, List All, and Exit) by clicking on a button. See 
Chapter 3, “Operations Basics,” for more information on the action 
buttons.

● Input Fields — are text boxes where you type in the information needed 
to complete the CMS action.

● Current ACD — displays the ACD affected by the current operation.

1. Menu Bar

1

2

3

4

2. Toolbar Action Buttons
3. Input Fields
4. Current ACD
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Dictionary Reports Tab 6

Use the Reports tab to access any reports you wish to display. The following 
graphic shows the Dictionary Reports available in Supervisor.

You may choose any of the following categories from the Reports tab.

● ACDs — gives you a report of the assigned ACD names and numbers.

● Agent Groups — lists the names of existing agent groups.

● Call Work Codes — lists currently administered call work codes with 
their names and descriptions.

● Custom Items — gives you a report of all the Custom Items.

● Login IDs — lists login IDs with their currently assigned names.

Note For more detail on the following Dictionary categories, please refer 
to the “Dictionary” chapter of the CentreVu CMS R3V5 
Administration (585-215-820) document. 
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● Splits/Skills — lists splits/skills with their assigned names and 
descriptions.

● Standard CMS Items — gives you a report of all the Standard CMS 
Items.

● Trunk Groups — lists the trunk groups with their names and 
descriptions.

● VDNs — lists VDNs with their names and descriptions.

● Vectors — lists vectors with their names and descriptions.

Note These reports list only items that have names assigned in the 
dictionary. Items that exist on the switch but do not have names 
assigned in the Dictionary subsystem will not appear in the reports. 
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Dictionary Report Input Windows 6

When you select an item from the Dictionary Reports list, an input window 
displays. Below is an example of one of the input windows that you will see.

● Destination — allows you to select where the report is produced (on 
screen or printed).

● Print Setup Button— allows you to select the printer on which the 
report prints. For more information on print setup, see the “Selecting a 
Printer” section of Chapter 4, “Reports Basics.”

● Current ACD — displays the ACD for which the report will run.

1. Destination Radio Buttons
2. Current ACD
3. Print Setup Button

1 2 3
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The Dictionary subsystem allows you to give names to ACDs, Call Work 
Codes, Agent Login IDs, Splits/Skills, Trunk Groups, VDNs, and Vectors. 
These items are given numbers when they are created on the switch. You can 
use the Dictionary command to name an item. For example, if your skills 
have names in Dictionary, then when you run a report that has skills as 
output, the skill names will appear instead of the skill numbers.

To assign a name in Dictionary, do the following steps:

1. Select Dictionary from the Commands menu, or select the Dictionary 
button  on the toolbar.

The Supervisor Dictionary window displays.

Note You must select the Operations tab, if it is not already selected, to 
display the list of operations.
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2. Select the desired item from the operations listed under the Operations 
tab.

3. Select OK.

The input window for the selected item displays. For example, the 
Login Identifications input window is shown below.

4. Complete the input fields:

● Number Text Box — Type in the number to which the name will 
correspond.

● Name Text Box — Type in the name you want displayed for this 
item in CentreVu reports.

● Description (optional) — You may type in a description of the item.

5. Select Add from the Actions menu, select the Add button  on the 
toolbar, or press Ctrl+A.

The name is loaded into the dictionary database.

1. Name Text Box
2. Number Text Box

1

2

3

3. Description
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Creating Agent Groups 6

To create an agent group, do the following steps:

1. Select Dictionary from the Commands menu, or select the Dictionary 
button  on the toolbar.

2. Select Agent Groups from the Operations tab.

3. Select the ACD for which you want to create an agent group.

4. Select OK.

The Agent Groups input window displays.

5. Type the name of the agent group you want to create.

6. Select Add from the Actions menu, select the Add button  on the 
toolbar, or press Ctrl+A.

7. Select Get contents from the Actions menu, or select the Get Contents 
button  on the toolbar.

The Dictionary Agent Groups — Get Contents window displays.
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8. Type the login IDs of the agents you want to add to this agent group in 
the text box.

9. Select Add from the Actions menu, select the Add button  on the 
toolbar, or press Ctrl+A.

The login IDs are added to the agent group.

10. When the last agent login ID is added to the desired agent group, close 
the window.

829.bk : dictionary.fm  Page 13  Wednesday, November 20, 1996  3:09 PM



6-14 Deleting Agents from an Agent Group

Commands | D ictionary

Deleting Agents from an Agent Group 6

To delete agents from an agent group, do the following steps:

1. Select Dictionary from the Commands menu, or select the Dictionary 
button  on the toolbar.

2. Select Agent Groups from the Operations tab.

3. Select the ACD for the agent group.

4. Select OK.

The Agent Groups input window displays:

Type the name of the agent group from which you want to delete agents.

5. Select Find one from the Actions menu, or select the Find One button 
 on the toolbar.

6. Select Get contents from the Actions menu, or select the Get Contents 
button  on the toolbar.

The Agent Groups — Get Contents window displays.
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7. Type the login IDs of the agents you want to delete from this agent 
group in the text box.

8. Select Delete from the Actions menu, or select the Delete button  on 
the toolbar.

9. When the last agent login ID is deleted from the desired agent group, 
close the window.
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Introduction 7

This chapter teaches you how to use the Operations and Reports tabs in the 
Exceptions command. It also gives you information on performing tasks 
that are specific to the Exceptions command.

The sections in this chapter are as follows:
● About Exceptions
● Starting Exceptions
● Exceptions Operations Tab
● Exceptions Operations Input Windows
● Exceptions Reports Tab
● Exceptions Report Input Windows
● Setting Exceptions
● About the Real-time Exception Log

How Exceptions works in CMS is not described in detail in this chapter. For 
more information on Exceptions operations and reports, please refer to the 
“Exceptions” chapter in the CentreVu CMS R3V5 Administration
(585-215-820) document.
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The Exceptions feature allows you to administer time- or count-based 
thresholds and to be alerted when times or counts exceed or fall below those 
thresholds. This allows monitoring “by exception,” by being alerted when 
something is not behaving as expected.

Use the Exceptions command to do the following actions:
● Define exception conditions for ACD activity for which you want 

notification. Activities may include agents, splits or skills, trunks or 
trunk groups, vectors, and VDNs. You do this using the Exception 
Operation windows.

● Generate reports on agent, split or skill, trunk and trunk group, vector, 
VDN, malicious call trace, and data collection exceptions.

● Run the Real-time Exception Log.

Note The exception conditions which you set in the Exceptions command 
are different from those which you define using report threshold 
highlights. For more information on report threshold highlights, see 
the “Setting Report Threshold Highlights” section of Chapter 5, 
“Reports.”

Note You can define exception conditions and generate reports for VDNs 
and vectors only if you have purchased the Vectoring feature.

Note The Real-time Exception Log is located under the Operations tab, 
not the Reports tab. In standard CMS, the log is a separate submenu 
item.
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Starting E xceptions 7

To select any exceptions item in Supervisor do the following steps:

1. Choose Exceptions from the Commands menu.

OR

Select the Exceptions button  on the toolbar.

2. The Exceptions window appears. You will see the following tabs to 
choose from:
● Operations
● Reports.
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The following graphic shows the Exceptions Operations available in 
Supervisor.

You may choose any of the following categories from the Exceptions 
Operations tab:.

● Agent Exceptions — use to define agent exceptions.
● Real-time Exception Log — use to list the exceptions as they occur.
● Split/Skill Exceptions — use to define split/skill exceptions.
● Trunk Group Exceptions — use to define trunk group exceptions.
● VDN Exceptions — use to define VDN exceptions.
● Vector Exceptions — use to define vector exceptions.

Note For more detail on the following Exceptions categories, please refer 
to the “Exceptions” chapter in the CentreVu CMS R3V5 
Administration (585-215-820) document. 
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Exceptions Operations Input Windows 7

When you select an item from the Exceptions Operations list, an input 
window displays. Below is an example of one of the input windows that you 
will see.

1

1. Toolbar Action Buttons
2. Menu Bar

2

3. Input Field
4. History List

3

5. Browse Button 

4 5

6. Exception Active Box
7. Exception Time Limit Field
8. Exception Threshold Field
9. Exception Type

6 7 8 9
10

10. Current ACD
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The input window that displays is dependent on the operation you 
selected.

● Menu Bar — includes menus for CMS Actions (Add, Delete, Modify, 
Find One, Next, Previous, List All, and Exit), Edit options (Cut, Copy, 
Paste, and Clear All), and Supervisor Help.

● Toolbar Action Buttons — let you perform CMS actions (Add, Delete, 
Modify, Find One, Next, Previous, List All, and Exit) by clicking on a 
button. See Chapter 3, “Operations Basics,” for more information on the 
action buttons.

● Input Fields — are text boxes where you type in the information needed 
to complete the CMS action.

● History List — displays a list of inputs you have previously used in the 
input field.

● Browse Button — lets you browse through all possible items for the 
input field.

● Exception Active — enables/disables tracking of this particular 
exception.

● Exception Time Limit — sets the time limit which an activity must 
exceed or fail to meet before being considered an exception.

● Exception Threshold — sets the number of times an activity can 
exceed/fall below the time limit (or, if no time limit is associated, the 
number of times the activity can occur) before being counted as an 
exception.

● Exception Type — defines the exception.
● Current ACD — displays the ACD for which you are setting exceptions.
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Setting E xceptions Conditions 7

You can set exception conditions for agents, splits/skills, trunk groups, 
VDNs, and vectors. By default, no exceptions are set.

To set exception conditions, do the following steps:

1. Select Exceptions from the Commands menu, or select the Exceptions 
button  on the toolbar.

2. Select the type of exceptions (agent, split/skill, trunk group, VDN, or 
vector) you want to set from the Operations tab.

The Exception Administration window appropriate to the type you 
selected displays.

3. Type in the name or use the Browse button or history list to select the 
item for which you want to set exceptions.

4. Select Find one from the Actions menu, select the Find one button  
on the toolbar, or press Ctrl+F to display exceptions information for the 
selected item (agent, split/skill, trunk group, VDN, or vector).

No exceptions are active (unless previously set).

5. Use the scroll bar to page through all of the exceptions administration 
screens (for this item).

Note You can set exceptions for more than one item at a time. To do 
this, use the Browse button to list all available split/skills, 
agents, trunk groups, VDNs, or vectors. See the “Using the 
Browse Button” section in Chapter 2, “Supervisor Basics,” for 
more information on selecting multiple items using the Browse 
button.
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6. Select the exceptions for which you want to be notified by clicking in the 
Active box(es) to enable the check box. 

7. Set the Time Limit (if applicable) for the exceptions of which you will be 
notified. The time limit is the amount of time that must pass before 
occurrences are counted against the threshold limit.

8. Set the Threshold for the exceptions of which you will be notified. The 
threshold is the number of acceptable occurrences. So, if you set the 
threshold to ten, then that particular exception can occur ten times 
before you will be notified. On the eleventh occurrence, you will receive 
an exceptions notification.

9. When you are done setting the thresholds, select Add from the Actions 
menu, select the Add button  on the toolbar, or press Ctrl+A to add 
the changes to CMS. 

Note If you are setting exceptions for an entity that has already had 
exceptions set, use the Modify action instead of Add.

Disabled

Enabled

829.bk : exceptions.fm  Page 8  Wednesday, November 20, 1996  3:09 PM



 Exceptions Reports Tab 7-9

Commands | E xceptions

C
ha

pt
er

 7

Exceptions Reports Tab 7

The following graphic shows the Exceptions Reports available in 
Supervisor.

You may choose any of the following categories from the Reports tab.

● Agent Exceptions — generates a report of agent exceptions.
● Data Collection Exceptions — generates a report of data collection 

exceptions.
● Malicious Call Trace — generates a report of malicious call trace 

exceptions.

Note For more detail on the following Exceptions categories, please 
refer to the “Exceptions” chapter of the CentreVu CMS R3V5 
Administration (585-215-820) document. 
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● Split/Skill Exceptions — generates a report of split/skill 
exceptions.

● Trunk Group Exceptions — generates a report of trunk group 
exceptions.

● VDN Exceptions — generates a report of VDN exceptions.
● Vector Exceptions — generates a report of vector exceptions.
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Exceptions Report Input Windows 7

To run an exceptions report, do the following steps:

1. Select Exceptions from the Commands menu, or select the Exceptions 
button  on the toolbar.

2. Select the Reports tab.

3. Select the type of exceptions report you want to run.

The report input window displays. Below is an example of an input 
window.

1. Input Fields 3. Destination
2. History List
3. Browse Button

4. Print Setup Button
5. Current ACD

1 2 3

4

5 6
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The input window that displays is dependent on the report you 
selected.

4. Complete the input fields.
● Input Fields — are text boxes where you type in the information 

needed to complete the CMS action.
● History List — displays a list of inputs you have previously used in 

the input field.
● Browse Button — lets you browse through all possible items for the 

input field.
● Destination — allows you to select where the report is produced 

(on screen or printed).
● Print Setup Button— allows you to select the printer on which the 

report prints. For more information on print setup, see the “Using 
Print Setup” section in Chapter 4, “Reports Basics.”

● Current ACD — displays the ACD for which you are setting 
exceptions.

5. The Exceptions check box list is where you select the exceptions you 
want to appear on the report. Enable the check box if you want an 
exception to appear on the report. Disable the check box if you do not 
want an exception on the report.

6. Select the report destination.

7. Select OK.

The report runs.
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About the Real-time Exception Log 7

The Real-Time Exception Log displays exception records for the last ten 
exceptions. The log lists exception records in chronological order, with the 
oldest exception listed first.

The Real-time Exception Log holds up to 100 exception records. As each 
new exception occurs, CentreVu CMS adds a new record to the log. If the log 
already contains 100 records, CentreVu CMS deletes the oldest exception 
record from the log at the same time that it adds the new exception record.

The log simultaneously displays exception records for all elements on the 
ACD or ACDs for which you have exceptions permissions, regardless of 
whether the exceptions involve agents, splits or skills, trunk groups, VDNs, 
or vectors.

You can use the Real-time Exceptions Log in two ways:
● Access the log periodically, or whenever you get notification of an 

exception, to see exactly what has happened.
● Maintain the log as an open window so you can monitor exceptions as 

they occur.

Each exception record in the Real-time Exception Log gives you the 
following information:
● The date and time the exception occurred.
● The ACD name for which the exception occurred.
● The specific ACD element, such as a specific agent, split/skill, or VDN 

that was involved in the exception. If you have defined names in the 
Dictionary subsystem, the names display. These names may be 
truncated if they are longer than the space allowed in the exception 
record. Otherwise, numeric identifiers display.

● The conditions you set up for exception checking in the associated 
Exceptions Administration window.

The record tells you only that an activity has fallen outside of the exception 
conditions you set. Thus, for a peg count exception, the exception record 
shows the occurrence threshold you set, even though the actual number of 
occurrences may be substantially greater. For a timed exception, the 
exception record shows the time limit you set, not the actual duration of an 
occurrence.
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This chapter teaches you how to use the Operations and Reports tabs in the 
ACD Administration command. It also teaches you how to perform tasks 
that are specific to the ACD Administration command.

The sections in this chapter are as follows:

● About ACD Administration

● Starting ACD Administration

● ACD Administration Operations Tab

● ACD Administration Operations Input Windows

● ACD Administration Reports Tab

● ACD Administration Reports Input Windows

● Activating an Agent Trace

● Listing Agents Traced

● Adding or Deleting Call Work Codes

● Changing an Agent’s Skills
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● Multi-Agent Skill Change

● Changing VDN Skill Preferences

● Change Extension Split Assignments

● Moving Extensions Between Splits

● Setting Split Parameters

● Setting Up Call Profiles

● Viewing Trunk Group Assignments

● Changing Trunk Group Assignments

● Changing VDN Assignments.

How ACD Administration works in CentreVu CMS is not described in detail 
in this chapter. For more information on ACD Administration and 
Configuration Reports, please refer to the “ACD Administration” chapter in 
the CentreVu CMS Administration (585-215-820) document.
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About A CD Administration 8

CentreVu CMS and the CentreVu Supervisor application are primarily used 
to collect information about ACD-related activities from the switch, store the 
information, and produce real-time and historical reports. However, you can 
also use Supervisor to view, add, delete, or modify ACD-related parameters 
on the switch. The following are some of the ACD administration tasks you 
can perform from Supervisor, assuming your switch supports the related 
features:

● Add agents to, remove agents from, or move agents (extensions) 
between splits or skills.

● Change an agent’s assigned skills or change one skill for as many as 32 
agents simultaneously.

● Start or stop an agent trace or list the agents being traced.

● View, change, or run a report that lists trunk group-to-VDN or VDN-to-
vector assignments.

● Set an acceptable service level, which is used to track answered and 
abandoned calls, for a split, skill, or VDN.

The CMS Vector Contents capability is not available through Supervisor. 
Use the CentreVu Terminal Emulator to perform Vector Contents actions.

Note The capabilities available in ACD Administration depend on which 
switch you have and on what user permissions have been assigned 
to you by your CMS Administrator. The capabilities on your CMS 
are reflected in the menu items included in ACD Administration. 
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Starting A CD Administration 8

To select any ACD Administration item in Supervisor, do the following 
steps:

1. Select ACD Administration from the Commands menu.

OR

Select the ACD Administration button  on the toolbar.

2. The ACD Administration selector window appears. You will see the 
following tabs to choose from:
● Operations
● Reports.
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ACD Administration Operations Tab —
Switches with EAS 8

If you have the DEFINITY® Enterprise Communications Server (ECS) 
Release 5 with the Expert Agent Selection (EAS) feature, or the Generic 3 
Version 4 switch with EAS, then the ACD Administration Operations tab 
displays the following operations:

● Activate Agent Trace — starts or stops CentreVu CMS tracing of agent 
activities, including agent state changes.

● Call Work Codes — adds, deletes, or lists the Call Work Codes for 
which CentreVu CMS collects data. 

Note The items that appear in the Operations list box vary depending on 
the ACD you choose and the features that are purchased and 
enabled on the ECS or the switch.

For more detail on the ACD Administration operation categories, 
please refer to the “ACD Administration” chapter of the CentreVu 
CMS Administration (585-215-820) document. 
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● Change Agent Skills — lets you change an agent’s assigned skill set. 
This operation is available only if you have the ECS with EAS or the 
Generic 3 Version 2 or later switch with the EAS feature.

● Change VDN Skill Preferences — changes the first, second, and third 
VDN skill preferences for a list of VDNs. You can also list the currently 
assigned skill preferences for VDNs, or list all the VDNs that currently 
have the specified skill preference assigned.

● List Agents Traced — lists the agents and dates for which agent trace 
data are available for the current ACD.

● Multi-Agent Skill Change — lets you change one skill for as many as 
32 agents. This operation is available only if you have the ECS with EAS 
or the Generic 3 Version 4 switch with the EAS feature.

● Split/Skill Call Profile Setup — sets a target acceptable service level (time 
limit in seconds) for calls to wait in queue before being answered and 
also allows you to define the service level increments for Split/Skill Call 
Profile reports and graphs. You can then use the Split/Skill Call Profile 
reports to see how many calls were either answered or abandoned 
within each increment.

● Trunk Group Assignments — lets you view trunk-group-to-VDN 
assignments. 

● VDN Assignments — changes VDN-to-vector assignments.

● VDN Call Profile Setup — sets up a VDN call profile and defines 
acceptable service levels (time limits in seconds) and service level 
increments (ranges of wait time) for VDNs.
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ACD Administration Operations Tab —
Switches Without EAS 8

If you have the ECS without EAS or a switch without EAS, the ACD 
Administration Operations tab displays the following operations:

● Activate Agent Trace — starts or stops CentreVu CMS tracing of agent 
activities, including agent state changes.

Note The items that appear in the Operations list box vary depending on 
the ACD you choose and the features that are purchased and 
enabled on the ECS or switch. For example, items related to VDNs 
or vectors appear only if the ECS or switch has the Call Vectoring 
feature. Also, if you have the Generic 2 switch with no vectoring, 
then the Split Parameters operation is available.

For more detail on the ACD Administration operation categories, 
please refer to the “ACD Administration” chapter of the CentreVu 
CMS Administration (585-215-820) document. 
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● Call Work Codes — adds, deletes, or lists the Call Work Codes for 
which CentreVu CMS collects data. 

● Change Extension Split Assignments — lists currently assigned splits 
for an extension and lets you change the assigned splits.

● List Agents Traced — lists the agents and dates for which agent trace 
data are available for the current ACD.

● Move Extensions Between Splits — lists current extension split 
assignments and lets you move measured extensions between splits.

● Split Parameters — lists and allows you to modify the delay time for 
prerecorded announcements and intraflow for ACD splits. This 
operation is available only if you have the Generic 2 switch with no Call 
Vectoring feature.

● Split/Skill Call Profile Setup — sets a target acceptable service level (time 
limit in seconds) for calls to wait in queue before being answered and 
also to define the service level increments for Split/Skill Call Profile 
Reports and graphs. You can then use the Split/Skill Call Profile reports 
to see how many calls were either answered or abandoned within each 
increment.

● Trunk Group Assignments — without vectoring, lets you view trunk 
group assignments (all switches) and move trunk groups from one split 
to another (Generic 2 and System 85 switches only).

With vectoring, lets you view (all switches) and change (Generic 2 and 
System 85 switches only) trunk group-to-VDN assignments. You assign 
automatic-in trunk groups to VDNs so that ACD calls arriving on those 
trunk groups can be linked to vectors. From vector processing, the calls 
are ultimately routed to other destinations—primarily splits.

● VDN Assignments — changes VDN-to-vector assignments.

● VDN Call Profile Setup — sets up a VDN call profile and defines 
acceptable service levels (wait time) and service level increments for 
VDNs.

Note If you have purchased and enabled the Call Vectoring feature, then 
the following operations are also available.
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ACD Administration Operations Input 
Windows 8

When you select an item from the ACD Administration Operations list, an 
input window displays. Below is an example of one of the input windows 
that you will see.

The input window that displays depends on the operation you selected.

Note If you select Change Agent Skills, the first input window requests only 
an agent name and then an interactive input window displays for you 
to change the skills. See the “Changing an Agent’s Skills” section in this 
chapter for more information.

If you select Multi-Agent Skill Change, an interactive input window 
displays in which you make the changes. See the “Multi-Agent Skill 
Change” section in this chapter for more information.

If you select Change Extension Split Assignments, the first input 
window requests only an extension number and then an interactive 
window displays for you to change the assignments. See the “Change 
Extension Split Assignments” section in this chapter for more 
information.

If you select Move Extensions Between Splits, an interactive input 
window displays for you to make the changes. See the “Moving 
Extensions Between Splits” section in this chapter for more information.

1 321. Input Field(s)
2. History List
3. Browse Button

4
5

4. Menu Bar
5 Toolbar
6 Current ACD 6
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● Menu Bar — includes pull-down menus for CentreVu CMS Actions 
(Add, Delete, Find One, Next, Previous, List All, and Exit), Edit options 
(Cut, Copy, Paste, and Clear All), and CentreVu Supervisor Help.

● Toolbar Action Buttons — let you perform CentreVu CMS actions (Add, 
Delete, Find One, Next, Previous, List All, and Exit). See Chapter 3, 
“Operations Basics,” for more information on action buttons.

● Input Fields — are text boxes where you type in the information needed 
to complete the CentreVu CMS action.

● History List — displays a pull-down list of inputs you have previously 
used in an input field.

● Browse Button — lets you browse through all possible items for the 
input field. See Chapter 2, “Supervisor Basics,” for more information on 
using the Browse Button.

● Current ACD — displays the ACD for which you are performing ACD 
Administration.
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Switches with EAS 8

From the Reports tab, you can choose any of the following reports to run in 
ACD Administration:

● Trunk Group Members — shows trunk group members and their 
equipment locations for a particular trunk group. This report helps you 
quickly find a trunk's location.

● Vector Configuration — lists the trunk groups and VDNs associated 
with the specified vector.

Note The items that appear in the Reports list box vary depending on the 
ACD you choose and the features that are purchased and enabled 
on the ECS or switch.

For more detail on the following ACD Administration reports, 
please refer to the “ACD Administration” chapter of the CentreVu 
CMS Administration (585-215-820) document. 
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ACD Administration Reports Tab — 
Switches Without EAS 8

From the Reports tab, you can choose any of the following reports to run in 
ACD Administration:

● Split Members — lists the selected splits in numerical order, each split's 
assigned name, and the extensions that are assigned to the split. 

● Trunk Group Members — shows trunk group members and their 
equipment locations for a particular trunk group. This report helps you 
quickly find a trunk's location.

● Vector Configuration — lists the trunk groups and VDNs associated 
with the specified vector.

Note The items that appear in the Reports list box vary depending on the 
ACD you choose and the features that are purchased and enabled 
on the ECS or switch. For example, items related to VDNs or vectors 
appear only if the switch has the Call Vectoring feature.

For more detail on the following ACD Administration reports, 
please refer to the “ACD Administration” chapter of the CentreVu 
CMS Administration (585-215-820) document. 

Note If you have purchased and enabled the Call Vectoring feature, then 
the following report is also available. 
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ACD Administration Reports Input Windows 8

When you select an item from the ACD Administration Reports list, an 
input window displays. Below is an example of one of the input windows 
that you will see.

The input window that displays is dependent on the report you selected.

● Input Fields — are text box(es) where you type in the information 
needed to run the report.

● History List — displays a pull-down list of inputs you have previously 
used in an input field.

● Browse Button — lets you browse through all possible items for the 
input field. See Chapter 2, “Supervisor Basics,” for more information on 
using the Browse Button.

● Destination — allows you to select where the report is produced (on 
screen or printed).

● Current ACD — displays the ACD for which you are running this ACD 
Administration report.

1 Input Field(s)

2

4

3

2 History LIst
3 Browse Button

4 Destination
5 Current ACD

5

1
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Activating an Agent Trace 8

To start or stop an agent trace, do the following steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. Choose the ACD for which you want to start or stop an agent trace.

3. Select Activate Agent Trace from the Operations tab.

4. Select OK.

The Activate Agent Trace window appears.

5. From the Agent names or logids list box, enter or select the name or 
login ID of the agent for whom you want to start or stop a trace.

6. To start an agent trace, select the On option. To stop an agent trace, select 
the Off option.

7. Select Modify from the Actions menu, select the Modify button  on 
the toolbar, or press Ctrl+M.
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Listing Agents Traced 8

To list agents who are being traced, do the following steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. Select the ACD that the agent traces reside on from the ACD list box.

3. Choose List Agents Traced from the Operations list box.

4. Select OK.

The List Agents Traced input window displays.

5. Type in the names or numbers of the agents you want to list, or use the 
Browse button  or drop-down list to select agents to list. Leave this 
field blank to list all agents for which there is trace data.

6. Type in the date(s) you want to include on the list, or use the Browse 
button  to select the date(s). Leave this field blank to list all dates for 
which there is trace data.

7. Select List all from the Actions menu or select the List all  button 
on the toolbar to list information on all the agents and dates you 
entered.

Select Find one from the Actions menu, select the Find one  button 
on the toolbar, or press Ctrl+F to list the first agent’s information.
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Adding or Deleting Call Work Codes 8

To add or delete Call Work Codes (CWCs), do the following steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. Select the ACD for which you want to add or delete CWCs from the 
ACD list box.

3. Select Call Work Codes from the Operations list box.

4. Select OK.

The Call Work Codes window appears.

5. In the Call work code(s) text box, enter the CWC(s) you want to add or 
delete, or use the Browse button  to choose from a list of CWCs.

6. To add CWCs, select Add from the Actions menu or select the Add 
button  on the toolbar.

To delete CWCs, select Delete from the Actions menu or select the 
Delete button  on the toolbar. 

Note If the number displayed in the Number of codes allocated: field 
is the same as the number displayed in the Number of codes 
administered: field, you cannot add more CWCs until you 
increase the amount of disk space allocated for storing CWCs. 
See the Data Storage Allocation section of the “System Setup” 
chapter in the CentreVu  CMS Administration (585-215-820) 
document for information about allocating more space.
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Changing an Agent’s Skills 8

To change the skills and the associated skill level/type, do the following 
steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. Select the ACD for which you want to change agent skills from the ACD 
list box.

3. Choose Change Agent Skills from the Operations list box.

4. Select OK.

The Select Agent window appears.

5. Enter the agent login ID or name or use the Browse button  to 
choose from a list of agents. You can also select an agent to change skills 

Note The Change Agent Skills operation is available only when the EAS 
feature has been purchased and enabled on the ECS or the switch.

If you have the ECS or the Generic 3 Version 4 switch, then agents 
do not have to log out for the skill changes to take effect. (Changes 
may be pending while the agent is on the phone or in ACW.)

The Change Agent Skills operation works differently than most 
ACD Administration operations.
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by highlighting the agent name in a running report, and then selecting 
“Change Agent Skills” from the right mouse button pop-up menu.

6. Select OK.

The Change Agent Skills window displays. The example shown here is 
for the ECS. If you have an earlier switch, your window will be 
different.

The skills for the agent you named in the previous window, along with 
the associated skill levels, are displayed in the Assigned Skills box.

Note You can do no other activity outside of the Select Agent window 
until you choose either the OK or Cancel button.

Note Skill names are shown for the skills that have been named in the 
Dictionary. Skill numbers are shown for the skills that have not 
been named in the Dictionary.
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7. Change the skill assignments for the selected agent(s), as follows:
● If you have the ECS and want to change the way in which it is 

decided which calls an agent gets first, select a different Call 
Handling Preference. The concept of “Top Skill” and the levels 
associated with skills are significant only for agents whose call 
handling preference is “Skill Level.” For more information on the 
difference between handling calls based on “Greatest Need” and 
“Skill Level,” see the EAS appendix in the CentreVu  CMS 
Administration (585-215-820) document.

● If you have the ECS and want to change the skill to be used to queue 
an agent’s direct agent calls, select the new Direct Agent Skill from 
the drop-down list of skills.

● If you want to change the level or type associated with an already-
assigned skill, do the following steps:

A. In the Assigned Skill list, select the skill for which you want to 
change skill level. (If you have the ECS, then an arrow icon to 
the left of the skill indicates the agent’s “Top Skill” assignment.)

B. If you have the ECS, click the Properties button to display the 
Agent Skill Properties window. The current skill level for this 
assigned skill is listed on the right. Move the slide control at the 
bottom of the window to the left (for more skilled) or right (for 
less skilled) to change the skill level associated with this agent’s 
assigned skill, or type in a new value for the skill level in the 
Skill Level: field.

If you have the Generic 3 Version 2, 3, or 4 switch, then select 
Primary or Secondary for each skill in the Assigned Skills box, 
as appropriate. You may also change the order of the assigned 
skills by clicking a skill and selecting Up or Down.

C. Select OK (or Cancel to ignore this change to skill level/type).

● If you want to change which skills are assigned to the selected 
agent(s), do the following steps:

A. Select the Assigned Skill that you no longer want to be assigned 
to the agent(s).
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B. If you have the ECS, click on the Delete button. (Note that if an 
agent has only one assigned skill, this skill cannot be deleted.) 

If you have the Generic 3 Version 2, 3, or 4 switch, click on the 
Remove button.

C. If you have the ECS and you want to assign one or more new 
skill(s), click on the Add button. In the Available Skills list, 
select the skill(s) you want to assign to the agent(s), and the Skill 
Level for these new skills.
If you have the Generic 3 Version 2, 3, or 4 switch, then in the 
Available Skills list, select the skill(s) you want to assign to the 
agent(s), and click on the Add button. Then select Primary or 
Secondary for each skill in the Assigned Skills box, as 
appropriate.

D. If you have the ECS, click on the OK button in the Available 
Skills window. If you have an earlier switch, go to step 8.

● If you have the ECS and want to make an assigned skill the “Top 
Skill” for this agent (which is only significant if the agent’s Call 
Handling Preference is based on Skill Level, and not on Greatest 
Need), then do the following:

A. Select the skill.

B. Click on the Make Top button.

8. When you are done updating the skills for this agent, select Apply. 

OR

If this is the only agent for whom you are updating skills, select OK.

(Note that no changes shown on this window are submitted to the 
CentreVu CMS server until the Apply or OK button on the “Change 
Agent Skills” window is selected.) If a move is pending, then you are 
notified that the operation will not occur until the pending conditions 
are resolved.

9. When you select Apply and the change is successfully made, a 
confirmation box displays, “Operation Successful.” Select OK.

The Change Agent Skills window displays again.

OR
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When you select OK, the “Change Agent Skills” window closes after 
“Operation Successful” confirmation.

10. If you selected Apply and are done making changes, select OK, or select 
Cancel to cancel any changes you have made since the last time you 
selected Apply or OK.

If you would like to make skill assignment changes for other agents:

11. Select Choose to select another agent.

12. Repeat steps 5 through 9.
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Multi-Agent Skill Change 8

Use the Multi-Agent Skill Change window to change one skill for as many 
as 32 agents at a time. You can also specify the associated skill level (1 to 16 
for the ECS) or type (primary or secondary for other switches) of a skill that 
is added or modified.

In addition to changing the agents assigned to skills, you can run reports 
from within the Multi-Agent Skill Change window. For example, you can 
double click on an agent name/number in a Skill window or the Agent List 
window to run the Real-Time Agent Graphical Information report for the 
selected agent. You can also highlight an agent and then select the Real-Time 
or Integrated Agent Graphical Information item from the Agent menu to 
run the selected report.

If you need to make several changes to one agent’s skill level assignments, 
you should highlight the agent in a Skill or Agent List window (or running 
report) and then select Change Agent Skills from the Agent menu (or right 
mouse button pop-up menu in reports). For more information, see the 
section on “Changing an Agent’s Skills.”

To change one skill for multiple agents, do the following steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. From the ACD list box, select the ACD for which you want to change 
agents’ skills.

3. From the Operations list box, choose Multi-Agent Skill Change.

Note The Multi-Agent Skill Change operation is available only when the 
EAS feature has been purchased and enabled on the ECS or the 
Generic 3 Version 4 switch.

If you have the ECS or the Generic 3 Version 4 switch, agents do not 
need to log out for the skill changes to take effect. (Changes may be 
pending while the agent is on the phone or in ACW.)

The Multi-Agent Skill Change operation works differently than 
most ACD Administration operations.
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4. Select OK.

The Multi-Agent Skill Change window appears.

The left-hand window within the Multi-Agent Skill Change Window is 
a list of all of the skills that are available on this ACD. To display agents 
assigned to a skill, either double click on the skill name or select the skill 
name and press enter. (The skills “customer service” and “shipping” are 
shown here.) To sort the agents differently, use the Options menu.

5. To move agents from skill to skill, or add agents in an existing skill to 
another skill, you can do the following:
● Click on one agent name/number, drag it to the skill you want to 

move the agent to, and let go of the mouse button. If you hold down 
the Ctrl key while dragging and dropping the agent name, then this 
agent will be added instead of moved to the destination skill.

● Hold down the Ctrl key and click to select multiple agent names (as 
many as 32) in one skill, then drag them to the new skill and let go 
of the mouse button. If you hold down the Ctrl key while dragging 
and dropping the agents, they will be added instead of moved.
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● Hold down the Shift key and click on two agent names to select the 
range of agents listed between the two you selected, then drag the 
agents (as many as 32) to the new skill and let go of the mouse 
button. If you held down the Ctrl key while dragging and dropping 
the agents to the destination skill, then they will be added instead of 
moved to that skill.

When you let go of the mouse button and drop the agent(s), a 
confirmation window displays. The following example is for moving 
agents between skills:

The agent(s) you moved are listed on the left-hand side of the window. 
The right-hand side shows the from-to skill information.

6. If you have the ECS and want to change the Skill Level that each agent 
you moved/added will have associated with this new skill, move the 
slide control at the bottom of the window to the left (for more skilled) or 
right (for less skilled), or type in a value in the Skill Level: field, as 
appropriate.

If you have the Generic 3 Version 2, 3, or 4 switch, then select Primary or 
Secondary to associate with this new skill, as appropriate.
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7. If the information is correct, select OK.

8. A confirmation message, “Operation Successful,” displays. Select OK.

9. The Multi-Agent Skill Change window displays.

If you are done moving agents from skill to skill, or assigning new skills 
to multiple agents, close the window. Otherwise, repeat the preceding 
steps.

Note For requests affecting multiple agents, some changes may take 
effect immediately, while other changes may be “pending.” 
Immediate changes show up in the Skill windows immediately. 
Pending changes may require one or more manual refreshes 
using the F5 hot key or by selecting the Refresh item on the 
Window menu before the Skill windows show that the changes 
have taken place.
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Changing VDN Skill Preferences 8

To change VDN skill preferences, do the following steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. Select the ACD for which you want to change VDN skill preferences 
from the ACD list box.

3. Select Change VDN Skill Preferences from the Operations list box.

4. Select OK.

The Change VDN Skill Preferences window appears.

5. In the VDN(s) text box, type or use the Browse button  or history list 
to select the numbers or names of the VDNs you want to modify.

Note The Change VDN Skill Preferences operation is available only when 
the Call Vectoring and EAS features have been purchased and 
enabled for the ECS or the switch.

Note If you use the Browse button  to search for VDN names, 
only the names that have been assigned in the Dictionary are 
shown. VDN numbers that exist, but have not been named in 
the Dictionary, do not display.
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6. In the Skill preferences list boxes, type or use the Browse button  to 
choose the skill preferences you want associated with the selected 
VDN(s).

7. Select Modify from the Actions menu, or select on the Modify button 
 on the toolbar.
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Change Extension Split Assignments 8

To change the splits assigned to a specific extension number do the 
following steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. Select the ACD for which you want to make the change from the ACD 
list box.

3. Select Change Extension Split Assignments from the Operations list 
box.

4. Select OK.

The Select Extension window displays:

5. Type in the number of the extension for which you want to change the 
splits, or use the history list to select from the extensions you have 
already worked with.

6. Select OK.

Note The Change Extension Split Assignments operation is available only 
on an ECS or switch that does not have the EAS feature. With EAS, 
“splits” do not apply.

Note You can do no other activity outside of the Select Extension window 
until you choose either the OK or Cancel button.
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The Change Extension Split Assignments window displays:

7. If you want to change splits for an extension other than the one 
displayed, select Choose to display the Select Extension window again.

The Move Extension From Split: box shows the split the extension is 
currently assigned to. The Move Extension To Split: box lists all of the 
available split names/numbers.

8. In the Move Extension From Split: box, select the split name/number 
that you no longer want associated with this extension.

9. In the Move Extension To Split: box, select the split name/number that 
you want the extension assigned to.

10. If you want to change split assignments for other extensions, select 
Apply. Then select Choose and enter the next extension number.

OR

If you do not want to change split assignments for any other extension, 
select OK.

Note If the extension is currently logged into the split shown in the 
“Move Extension From Split” list, the Logged-In icon shows. If 
the extension is not currently logged in, no icon is shown.

Logged-In
Icon
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Moving Extensions Between Splits 8

To move extensions between splits, do the following steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. Select the ACD for which you want to make the change from the ACD 
list box.

3. Select Move Extensions Between Splits from the Operations list box.

4. Select OK.

The Move Extensions Between Splits window displays:

5. In the Split List window (shown on the left), double click on the 
names/numbers of the splits you want to work with.

The Split windows open (shown to the right).

Note The Move Extensions Between Splits operation is available only on 
the ECS or on a switch that does not have the EAS feature. With 
EAS, “splits” do not apply.
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6. Once the windows are open for the splits you want to work with, you 
can move extensions between splits. Use one of the following methods 
to do this:
● Click on one extension number, drag it to the split to which you 

want to move the extension, and let go of the mouse button.
● Hold down the Ctrl button on your keyboard and click on multiple 

extension numbers in one split; then drag the extensions to the new 
split and let go of the mouse button.

● Hold down the Shift button on your keyboard and click on two 
extension numbers to select the range of extensions listed between 
the two you clicked on; then drag the agents to the new split and let 
go of the mouse button.

7. When you let go of the mouse button, the Move Extensions Between 
Splits confirmation window displays:

8. If you want to finalize the move, select OK. If you do not want to 
perform this move, select Cancel.

9. When you are done making changes, close the Move Extensions 
Between Splits operation by closing the window.
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Setting Split Parameters 8

You will see this window only if you have a Generic 2 switch without the 
Call Vectoring feature.

To modify split parameters, do the following steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. Select the ACD for which you want to set split parameters from the 
ACD list box.

3. Select Split Parameters from the Operations list box.

4. Select OK.

The Split Parameters window displays:

5. Enter a split name or number in the Split: text box, or use the Browse 
button  to view all available split names.

6. Select Find one from the Actions menu, or select the Find one button 
 on the toolbar.

The information regarding the split’s set parameters is displayed.

7. Make changes to the split parameters.

8. Select Modify from the Actions menu, or select the Modify button  
on the toolbar.

To be provided.
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Setting Up Call Profiles 8

To set up a split/skill call profile or a VDN call profile, do the following 
steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. From the ACD list box, select the ACD for which you want to set call 
profiles.

3. From the Operations list box, choose Split/Skill Call Profile Setup or 
VDN Call Profile Setup.

4. Select OK.

The Split/Skill Call Profile Setup or the VDN Call Profile Setup window 
displays (Split/Skill Call Profile Setup is shown below). The windows 
are identical, except for the first input field, a text box which will be 
labeled for VDN(s) if you selected the VDN Call Profile Setup.

5. Type in the name or number of the split(s)/skill(s) or VDN(s) for which 
you want to set service levels, or use the pull-down history list or the 
Browse button  to select the name(s)/number(s).

6. Type in the Acceptable service level.

7. Type in the Service level increments.

8. Select Add from the Actions menu, or select the Add button  on the 
toolbar.
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Viewing Trunk Group Assignments 8

To view trunk group assignments, do the following steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. Select the ACD for whose trunk group assignments you want to view 
from the ACD list box.

3. From the Operations list box, select Trunk Group Assignments.

4. Select OK.

The Trunk Group Assignments window displays:

5. To list all trunk group assignments, do the following:

a. Leave the Trunk Groups: text box blank.

b. Select List all from the Actions menu, or select the List all button 
 from the toolbar.

A list displays which shows all trunk groups and the splits or VDNs 
to which they are assigned.

6. To find one trunk group assignment do the following:

a. Leave the Trunk Groups: text box blank.

b. Select Find one from the Actions menu, or select the Find one 
button  on the toolbar.

The fields on the input window are filled in with information from 
the first match. To scroll through all trunk group assignments, use 
the Next  and Previous  buttons.
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Changing Trunk Group Assignments 8

If you have a Generic 2 switch, you can change trunk group assignments 
using CentreVu Supervisor. 

To change trunk group assignments, do the following steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. Select the ACD for which you want to view trunk group assignments 
from the ACD list box.

3. Select Trunk Group Assignments from the Operations list box.

4. Select OK.

The Trunk Group Assignments window displays:

● To list all trunk group assignments, do the following:

a. Leave the Trunk Groups: text box blank.

b. Select List all from the Actions menu, or select the List all button 
 from the toolbar.

A list displays of all trunk groups and the splits or VDNs to which 
they are assigned.

● To find one trunk group assignment, do the following:

a. Leave the Trunk Groups: text box blank.

b. Select Find one from the Actions menu, or select the Find one 
button  from the toolbar.
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The fields on the input window are filled in with information from 
the first match. To scroll through all trunk group assignments, use 
the Next  and Previous  buttons.

● To change the VDN or split to which a trunk group is assigned, do the 
following:

a. Do a Find one to display the trunk group information.

b. Enter the new VDN assignment by typing in the name/number, 
using the history list, or using the Browse button .

c. Select Modify from the Actions menu, or select the Modify button 
 on the toolbar.

When the modification is saved, the status bar reads Successful.
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Changing VDN Assignments 8

To change VDN-to-vector assignments, do the following steps:

1. Select ACD Administration from the Commands menu, or select the 
ACD Administration button  on the toolbar.

2. Select the ACD for which you want to change VDN assignments from 
the ACD list box.

3. Select VDN Assignments from the Operations list box.

4. Select OK.

The VDN-to-Vector Assignments window displays:

5. Type in the name or number of the VDN(s) for which you want to 
change vector assignments, or use the pull-down history list for a 
previously used VDN, or the Browse button  to view all possible 
VDNs.

6. Type in the name or number of the vector to which you want to assign 
the VDNs, or use the pull-down history list for a previously used vector, 
or use the Browse button  to view all your vector choices.

7. Select Modify from the Actions menu, or select the Modify button  
on the toolbar.
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Introduction 9

This chapter teaches you how to use the Operations tab in the CMS System 
Setup tool.

The sections in this chapter are as follows:
● About CMS System Setup
● Starting CMS System Setup
● CMS System Setup Operations Tab
● CMS System Setup Operations Input Windows.

How CMS System Setup works in CMS is not described in detail in this 
chapter. For more information on CMS System Setup operations, please 
refer to the “System Setup” chapter in the CentreVu CMS Administration 
(585-215-820) document.
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From the CMS System Setup tool you can view windows that display how 
your CMS was configured during installation. You can also do the following 
actions from this tool:

● Check the current state of CMS, and change the state to or from single-
user mode and multi-user mode.

● Turn data collection on or off.

● Allocate the amount of storage to be used for collecting historical data.

● Archive on demand for daily, weekly, and/or monthly summaries.

● Identify and specify where you would like to store specific CMS files.

● Load data into a pseudo-ACD.

● Define an ACD or pseudo-ACD to be used for unarchiving previously 
backed-up historical data.

● Migrate data from R2 CMS to CentreVu CMS.

● Migrate data from R3 CMS to CentreVu CMS.

● Specify the intervals of time for data to be stored (archived), and define 
what days of the week constitute a week for your call center (for 
example, Monday through Friday).

● View switch information.

Caution The CMS System Setup tool is not an area you should be 
working in daily because any changes you make in the CMS 
System Setup could affect the CMS server performance, disk 
space, or data collection.

Note The CMS System Setup operations affect the setup of the CMS, 
not the setup of your PC.
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Starting CMS S ystem Setup 9

To select any CMS System Setup item in Supervisor, do the following steps:

1. Choose CMS System Setup from the Tools menu.

OR

Select the CMS System Setup icon  on the toolbar.

2. The CMS System Setup selector window appears. The only tab 
available in the CMS System Setup selector window is the Operations 
tab.
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The following graphic shows the Operations tab, which contains the 
categories you can choose in CMS System Setup:

From the Operations tab, you may choose any of the following CMS System 
Setup categories:

● CMS State — allows you to bring CMS down to single-user mode and 
back to multi-user mode. You will also select your master ACD for clock 
synchronization in this window.

● Data Collection — allows you to turn data collection on or off for real 
ACDs.

● Data Storage Allocation — allows you to specify parameters for storing 
data on the CMS server. This affects disk space and is limited by your 
specific system configuration. Initially, these parameters are set during 
installation.

Note For more detail on the following CMS System Setup 
categories, please refer to the “System Setup” chapter of the 
CentreVu CMS Administration (585-215-820) document. 
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● Data Summarizing — allows you to archive data into the historical 
database on demand for daily, weekly, and monthly summaries.

● External Application Status — allows you to turn on or turn off the 
External Application feature, to start or stop external applications, or to 
view the status of external applications. 

● Free Space Allocation — allows you to identify and specify where you 
would like to store specific CMS files. For example, you can specify 
where to store all the files associated with trunks. This window is used 
to identify which file systems CMS uses.

● Load Pseudo-ACD Data — allows you to load ACD data into the 
pseudo-ACD created in the Pseudo-ACD Setup window.

● Pseudo-ACD Setup —allows you to create or delete an area on your 
CMS for a pseudo-ACD and give it a number. This area and number are 
used by CMS to restore previously backed-up ACD data using the Load 
Pseudo-ACD Data window. You can also use this window to take 
previously backed-up data on one CMS and then restore that data on 
another CMS. 

● R2 Migrate Data — allows you to migrate data from R2 3B CMS to 
CentreVu CMS. The following items can be included:

— Administration data (User Permission), Dictionary, and Custom 
Reports

— Historical Data and Forecast Administration Data.

● R3 Migrate Data — allows you to migrate data from R3 CMS to 
CentreVu CMS. The following items can be included:

— System Administration data

— ACD Administration data

— Historical data

Note External Application is a separately purchased CentreVu 
CMS feature.

Note  If you create a pseudo-ACD using Supervisor, you need to 
log out of Supervisor and then log back into Supervisor be 
able to see the new pseudo-ACD.
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● Storage Intervals — allows you to specify a 15-, 30-, or 60-minute 
storage interval for call data, thereby allowing you to choose the storage 
interval that best meets the needs of your call center. You will also select 
the days of the week that begin and end your call center’s week.

Storage intervals can be changed to affect how often intrahour data are 
archived as well as to affect the times at which the data are archived. For 
example, if there is a change in the hours of your call center, you could 
change the “daily start time” or “daily stop time” to change when data 
are collected. Also, if you have specified a 60-minute intrahour interval 
and then you require a more detailed intrahour report, you could select 
a 15- or 30-minute intrahour interval and CMS will automatically adjust 
your historical data to reflect the change and give you the 15- or 30-
minute interval data. 

● Switch Setup — displays the following switch setup information for the 
ACD you specify as it was assigned during installation:

— Switch Type

— Switch Release

— Purchased CMS release and version

— CentreVu CMS load

— Phantom abandon call timer setting

— CMS-administrable switch features (Call Vectoring, Call Prompting, 
and Expert Agent Selection).
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CMS System Setup Operations Input Windows 9

When you select an item from the CMS System Setup Operations list, an 
input window displays. Below is an example of one of the input windows 
that you will see.

The input window that displays is dependent on the category you selected.

● Menu Bar — includes pull-down lists for CMS Actions (Add, Delete, 
Find One, Next, Previous, List All, and Exit), Edit options (Cut, Copy, 
Paste, and Clear All), and Supervisor Help.

● Action Buttons — let you perform CMS actions (Add, Delete, Find One, 
Next, Previous, List All, and Exit) by clicking on a button. See Chapter 3, 
“Operations Basics,” for more information on the action buttons.

● Input Fields — are text boxes where you type in the information needed 
to complete the CMS action.

● Data Type — lets you define which type of data will be used (Daily, 
Weekly, or Monthly).

● History List — displays a list of predefined inputs from which you can 
select. 

1 2

3

4

5

6

1. Input Field
2. Browse Button
3. Menu Bar

4. Action Buttons
5. History List
6. Data Type
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● Browse Button — lets you browse through all possible items for the 
input field. See the “Using the Browse Button” section in Chapter 2, 
“Supervisor Basics,” for more information.

● Current ACD — displays the ACD that you are performing CMS 
System Setup work on.
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Introduction 10

This chapter teaches you how to use the Operations and Reports tabs in the 
Maintenance tool. It also gives you information on performing tasks that are 
specific to the Maintenance tool.

The sections in this chapter are as follows:
● About Maintenance
● Starting Maintenance
● Maintenance Operations Tab
● Maintenance Operations Input Windows
● Maintenance Reports Tab
● Running the Error Log Report
● Translating Data from the Switch to the CMS.

How Maintenance works in CMS is not described in detail in this chapter. 
For more information on Maintenance operations, please refer to the 
“Maintenance” chapter in the CentreVu CMS Administration
(585-215-820) document.
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About M aintenance 10

The Maintenance tool allows you to perform routine maintenance of the 
CMS server such as backing up data, checking on the status of the 
connection to the switch, and scanning the error log.

From the Maintenance tool, you can do the following:

● View the measurement status of a particular ACD.

● View information about the last archive done for a particular type of 
data.

● Initiate CMS backups.

● Assign a name and description to a full path name for a backup device. 
This device, such as a tape drive, is used for data backups.

● Monitor the data link between the CMS processor and the switch.

● Assign printer names and options for the CMS server’s printers.

● Initiate CMS restores.

● View the Error Log Report.

Note The Maintenance operations affect the CMS, not your PC.
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Starting M aintenance 10

To open Maintenance, do the following steps:

1. Choose Maintenance from the Tools menu.

OR

Select the Maintenance button  on the toolbar.

2. The Maintenance selector window appears. You will see the following 
tabs to choose from:
● Operations
● Reports.
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Maintenance Operations Tab 10

The following graphic shows the Operations (categories) you can choose in 
Maintenance:

From the Operations tab, you may choose any of the following Maintenance 
options:

● ACD Status — displays information about the current ACD selected in 
the window. From this window, you can find out the number of skills, 
number of skill members (agents logged in), trunk groups, trunks, 
VDNs, and vectors that CMS is measuring.

Note For more detail on the following Maintenance categories, please 
refer to the “Maintenance” chapter of the CentreVu CMS 
Administration (585-215-820) document. 

Note If CMS is connected to a non-EAS switch, then an additional 
field displays, which shows the maximum number of splits. 
If the CMS is connected to a G2.1 switch, then an additional 
field displays, which shows the number of measured splits.
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You can also use the ACD Status window to request a data translation 
from the switch to the CMS. You might want to do this if the link 
between the ACD and CMS is not properly brought up when you start 
CMS.

● Archiving Status — allows you to display (for the ACD you select) the 
status, date, and time of the last archive for interval, daily, weekly, 
and/or monthly data.

● Back Up Data — displays the number of backups completed for the 
current day and the status of the current or most recent backup. Allows 
you to initiate a backup, select a backup device, select which ACDs to 
back up (All or Current), select the types of data to back up, and select 
the type of backup (Full or Incremental). The Back Up Data window 
does not back up the software which supports the CMS product.

● Backup/Restore Devices — allows you to assign a name and 
description to a full path name for a device. The device name is used for 
data backup, data migration, data restore, and for loading a pseudo-
ACD.

● Connection Status — allows you to monitor the data link between the 
CMS and the ACD(s) from the Connection Status window. This window 
also displays the current status of the application, session, and 
connection layers of the link between the switch and CMS.

● Printer Administration — allows you to assign a name, description, 
and some options to a CMS printer in the Printer Administration 
window. This provides the information that CMS needs in order to print 
any CMS report or window.

● Restore Data — allows you to restore CMS data that has been lost or 
ACDs that have been removed due to system failure, disk crashes, 
power outages, and so forth. You can restore all CMS data files that you 
have previously backed up.

Note This printer cannot be used to print reports from the Supervisor 
application. You can use it to print reports from the Terminal 
Emulator or from another CMS terminal.
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Maintenance Operations Input Windows 10

When you select an item from the Maintenance Operations list, an input 
window displays. Below is an example of an input window that you may 
see.

The input window that displays is dependent on the category that you 
select.

● Menu Bar —allows you to use pull-down lists to select CMS Actions 
(Add, Delete, Find One, Next, Previous, List All, and Exit), Edit options 
(Cut, Copy, Paste, and Clear All), and Supervisor Help.

● Action Buttons — allows you to perform CMS actions (Add, Delete, 
Find One, Next, Previous, List All, and Exit) by clicking on a button. See 

1. Menu Bar
2. History List
3. Browse Button
4. Input Field

1 2 3

4
5

5. Current ACD
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Chapter 3, “Operations Basics,” for more information on the action 
buttons.

● Input Fields — allow you to type in the information needed to complete 
the CMS action.

● History List — displays a list of inputs you have previously used in the 
input field.

● Browse Button — allows you to browse through all possible items for 
the input field.
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Maintenance Reports Tab 10

The following graphic shows the report that you can run in Maintenance:

From the Reports tab, you may choose the following Maintenance category:

● Error Log Report — displays a chronological list of warnings, 
information, and errors detected by CMS. The main purpose of the error 
log is to aid you in working on system problems and to aid Lucent 
Technologies Services personnel in clearing problems in your system.
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Running the Error Log Report 10

To run the Error Log Report, do the following steps:

1. Select Maintenance from the Tools menu, or select the Maintenance 
button  on the toolbar.

The following input window displays:

2. Fill in the input field(s), including the following:

● ACD: — select the ACD(s) for which you want to run the report.
● Error codes: — if you want to run the report for specific error codes, 

enter them in this text box.
● Severity: — select the severity of errors for which you want a report. 

You can choose All Severities, Error, Information, or Alarm.
● Dates: — select the dates for which the report will run.
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To complete the input fields, you can do the following:
● Type in the name or number of the input requested.
● Press the Browse button to view all of the available inputs for which 

you have permissions.
● Use the history list to select an input that you have previously used.

3. Select the report destination.

The Maintenance Error Log can be viewed on screen or printed to any 
Microsoft* Windows† printer your PC is connected to, or any Microsoft 
Windows printer on your LAN. You can specify the destination for the 
report on this window. If you want to view the report on screen, select 
the View Report on Screen option. If you want to print the report, select 
the Print Report on: option. If you want to print the report on a printer 
other than the one shown in the Print Report on: field, select the Print 
Setup button  and select a different printer.

For more information on Print Setup, see the “Selecting a Printer” 
section in Chapter 4, “Reports Basics.”

4. Complete the input window, and select OK.

The report runs.

*Microsoft is a registered trademark of Microsoft Corporation.
†Windows is a registered trademark of Microsoft Corporation.
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Translating Data from the Switch to the CMS 10

At times, the link between the switch and the CMS is not correctly 
established. If this is the case, you can perform a data translation from the 
switch to the CMS. To do this, do the following steps:

1. Select Maintenance from the Tools menu, or select the Maintenance 
button  on the toolbar.

2. Select ACD Status from the Operations tab.

3. Select OK.

The ACD Status window displays.

4. Type the name(s) of the ACD(s), from which you want to translate data 
in the text box, or use the history list or browse button to select the ACD.

5. Select Find one from the Actions menu, or select the Find one button 
 on the toolbar.

The information for that ACD displays.

6. Select Translations from the Actions menu, or select the Translations 
button  on the toolbar.

A confirmation window displays:

7. Select the Yes button to continue the translation.
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Introduction 11

This chapter teaches you how to use the Operations tab in the User 
Permissions tool. It also gives you information on performing tasks that are 
specific to the User Permissions tool.

The sections in this chapter are as follows:
● About User Permissions
● Starting User Permissions
● User Permissions Operations Tab
● User Permissions Operations Input Windows
● Setting Up a New CMS User.

How User Permissions works in CMS is not described in detail in this 
chapter. For more information on User Permissions operations, please refer 
to the “User Permissions” chapter in the CentreVu CMS Administration
(585-215-820) document.
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About U ser Permissions 11

CMS user permissions are preserved in Supervisor. Your user permissions, 
as established by the CMS administrator, are the same whether you are 
using Supervisor, Terminal Emulator, or another terminal to access the CMS 
server.

From the User Permissions tool, the CMS administrator can assign the 
following permissions:

● ACD Access

● User access permissions for the CMS features

● CMS User IDs, default printers, maximum number of open user 
windows, the minimum refresh rate for real-time reports, login ACDs, 
and whether each user is a normal user or an administrator

● Split/skill, trunk group, and ACD access permissions

● Access permissions to VDNs and vectors if you have purchased the 
Vectoring feature.

A CMS administrator login ID is provided to you at installation. This login 
ID gives you access to the entire CMS system, including read and write 
permissions for all subsystems and ACDs (real and pseudo-ACDs).

Secondary administrators, such as split/skill supervisors, may require 
access to only a limited number of the CMS splits/skills, trunk groups, and 
ACDs and may require only read or write permission for a particular 
command or tool. For example, if your call center has a split (called split 1) 
with two trunk groups (22 and 23) assigned to it, then the supervisor of 
split 1 can be administered to be restricted to read and write access only for 
split 1 and trunk groups 22 and 23. In addition, the supervisor can be 
administered to have read and write permission for several commands 
needed to administer split 1 and trunk groups 22 and 23 effectively.

Note Assign access permissions only as needed. If a CMS user has the 
CMS default permissions (that is, no access), do not add access 
permission in the read and write fields. CMS does not store records 
of split/skill, trunk groups, VDN, and vector access permissions 
until you enter the permissions in the appropriate window(s). This 
way of storing permissions saves disk space. 

829.bk : userpermissions.fm  Page 2  Wednesday, November 20, 1996  3:09 PM



 Starting User Permissions 11-3

Tools | U ser Permissions

C
ha

pt
er

 1
1

Starting U ser Permissions 11

To select any User Permissions item in Supervisor, do the following steps:

1. Select User Permissions from the Tools menu.

OR

Select the User Permissions button  on the toolbar.

2. The User Permissions window appears. The only tab available in User 
Permissions is the Operations tab.
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The following graphic shows the Operations you can choose in User 
Permissions:

From the Operations tab, you can choose any of the following categories:

● ACD Access — allows you to assign, view, delete, and modify a user’s 
ability to access real or pseudo ACDs. This could be one ACD or several. 
You will also turn on or off the exceptions notification for ACDs in this 
window.

● Feature Access — allows you to assign, view, or modify user access 
permissions for the CMS subsystems (for example, Reports, Dictionary, 
Exceptions) and certain function key (SLK) menu items (such as UNIX* 
system/Solaris† system, Timetable). 

* UNIX is a registered trademark in the United States and other countries, 
licensed exclusively through X/Open Corporation.
† Solaris is a registered trademark of Sun Microsystems, Inc.

Note SLK menu items are accessible only from Terminal Emulator.
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The access permissions you give to any user affect what that user is able 
to do with CMS.

● Main Menu Addition Access — allows you to assign, view or modify 
user access permissions for the additional menu items of your choosing. 
These items could be access to your local electronic mail environment or 
daily news articles about your call center for agents or split/skill 
supervisors.

● Split/Skill Access — allows you to assign, view, modify, or delete a 
user’s permissions to specify splits/skills. Split/Skill Access 
permissions determine your ability to access and administer 
agent/queue data for a particular split or skill. You will also turn on or 
off the exceptions notification for splits/skills in this window.

● Trunk Group Access — allows you to assign, view, modify, or delete a 
user’s access permissions to specific trunk groups. Trunk Group Access 
permissions determine a user’s ability to access and administer data for 
a particular trunk group. You will also turn on or off the exceptions 
notification for trunk groups in this window.

● User Data — allows you to assign CMS user IDs, specify a default 
printer, specify whether the user is a normal user (such as a split/skill 
supervisor) or an administrator, and administer the maximum number 
of open windows, the minimum refresh rate for real-time reports, and 
the default login ACD.

● VDN Access — allows you to assign, view, modify, or delete a CMS 
user’s access permissions to specific VDNs. You can define VDN access 
permissions for users to determine a user’s ability to administer VDNs 
with the various CMS subsystems and to access report/administration 
data for VDNs. 

● Vector Access — allows you to define vector access permissions for 
users to determine a user’s ability to administer vectors and to access 
report/administration data for vectors. Use to assign, view, modify, or 
delete a CMS user’s access permissions to specific vectors.

Note Main Menu Addition Access applies only if you are using the 
CMS from a terminal or through the Terminal Emulator.
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When you select an item from the User Permissions Operations list, an 
input window displays. Below is an example of one of the input windows 
that you will see.

The input window that displays is dependent on the category you select.

● Menu Bar — allows you to use a pull-down list to select CMS Actions 
(Add, Delete, Find One, Next, Previous, List All, and Exit), Edit options 
(Cut, Copy, Paste, and Clear All), and Supervisor Help.

● Action Buttons — let you perform CMS actions (Add, Delete, Find One, 
Next, Previous, List All, and Exit) by clicking on a button. See Chapter 3, 
“Operations Basics,” for more information on the action buttons.

● Input Fields — are text boxes where you type in the information needed 
to complete the CMS action.

Note For more detail on the following User Permissions categories, 
please refer to the “User Permissions” chapter of the CentreVu 
CMS Administration (585-215-820) document. 

421

7

3

6

1. Menu Bar
2. Input Field(s)
3. History List
4.Browse Button 

5. Action Buttons
6. Permissions Check Boxes
7. Current ACD

5
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● History List — displays a list of inputs you have previously used in the 
input field.

● Browse Button — lets you browse through all possible items for the 
input field.

● Permissions Check Boxes — lets you turn read, write, and exceptions 
user permissions for the category on and off. When checked, the 
permission is on. When not checked, the permission is off. See the 
“Using Check Boxes” section in Chapter 2, “Supervisor Basics,” for 
more information.

● Current ACD — displays the ACD you are performing User 
Permissions work on.
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Setting Up a New CMS User 11

To set up a new CMS user, do the following steps:

● Establish a User ID.

● Establish CMS Subsystem Permissions.

● Establish ACD Permissions.

● Establish Split/Skill Permissions.

● Establish Trunk Group Permissions.

● Establish Vector Permissions.

● Establish VDN Permissions.

● Establish Main Menu Addition Permissions.

With the exception of establishing a User ID (which must be done first), the 
order in which you perform the steps does not matter. The following 
sections walk you through each of the steps in creating a new CMS user.
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Establishing a User ID 11

Establish the User ID by doing the following steps:

1. Choose User Permissions from the Tools menu, or select the User 
Permissions button  on the toolbar.

2. Select User Data from the Operations tab and select OK.

The User Data input window displays.

3. Complete the User Data input window.

4. Select Add from the Actions menu, or select the Add button  on the 
toolbar to save the user’s User ID and Login type on the CMS.

5. When the information is successfully saved, the status bar reads 
Successful.

6. Close the User Data window.

Note To clear all of the fields in the window at any time, select Clear 
all from the Edit menu, or press Ctrl+E.
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Establishing ACD Permissions 11

Establish the user’s ACD access by doing the following steps:

1. Choose User Permissions from the Tools menu, or select the User 
Permissions button  on the toolbar.

2. Select ACD Access from the Operations tab and select OK.

The ACD Access input window displays.

3. Type the User ID you assigned in the User Data window in the User ID: 
text box.

4. Clear the ACDs: text box.

5. Leave the Read, Write, and Exceptions check boxes selected.

Note The default permissions for ACDs is yes for all ACDs. 

Note To clear all of the fields in the window at any time, select Clear 
all from the Edit menu, or press Ctrl+E.

829.bk : userpermissions.fm  Page 10  Wednesday, November 20, 1996  3:09 PM



 Setting Up a New CMS User 11-11

Tools | U ser Permissions

C
ha

pt
er

 1
1

6. Select Find one from the Actions menu, or select the Find one button 
 on the toolbar.

The ACDs box is filled in with the first ACD this CMS tracks.

The status bar reads “xx Matches found.”

7. Use the Next  and Previous  buttons to scroll through the list of 
available ACDs for this User ID.

8. Change the Read, Write, and Exceptions check box permissions, as 
applicable (checked = on, blank = off), for each ACD.

9. Select Modify from the Actions menu, or select the Modify button  
on the toolbar to modify the record for each ACD.

10. Close the ACD Access window.
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Establishing Feature Access Permissions 11

Establish the user’s CMS subsystem feature access by doing the following 
steps:

1. Choose User Permissions from the Tools menu, or select the User 
Permissions button  on the toolbar.

2. Select Feature Access from the Operations tab and select OK.

The Feature Access input window displays.

3. Type in the User ID you assigned in the User Data window.

4. Select Find one from the Actions menu, or select the Find one button 
 on the toolbar.

5. The permissions for that user display.

Note To clear all of the fields in the window at any time, select Clear 
all from the Edit menu, or press Ctrl+E.
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6. Select or deselect the check boxes as appropriate for this user.

7. Select Modify from the Actions menu, or select the Modify button  
on the toolbar.

When the information is successfully saved, the status bar reads 
“Successful.”

8. Close the Feature Access window.

Note For more information on read/write permissions, see the “User 
Permissions” chapter in the CentreVu CMS Administration
(585-215-820) document.

829.bk : userpermissions.fm  Page 13  Wednesday, November 20, 1996  3:09 PM



11-14 Setting Up a New CMS User

Tools | U ser Permissions

Establishing Main Menu Addition Permissions 11

Establish the user’s Main Menu Addition access permissions by doing the 
following steps:

1. Choose User Permissions from the Tools menu, or select the User 
Permissions button  on the toolbar.

2. Select Main Menu Addition Access from the Operations tab and select 
OK.

The Main Menu Addition Access input window displays.

Note Main Menu Additions show up only when you are using a terminal 
or Terminal Emulator to access CMS.

Main Menu Additions are created in the CMS System Setup tool.

Note To clear all of the fields in the window at any time, select Clear 
all from the Edit menu, or press Ctrl+E.
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3. Type the User ID you assigned in the User Data window in the User ID: 
text box.

4. Type one of the available additions (from the list at the top of the 
window) in the Addition: text box.

5. Change the Read, Write, and Exceptions check box permissions, as 
applicable (checked = on, blank = off), for the VDN(s).

6. Select Modify from the Actions menu, or select the Modify button  
on the toolbar to modify the record for each main menu addition.

7. Close the Main Menu Addition Access window.
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Establishing Split/Skill Permissions 11

Establish the user’s split/skill access by doing the following steps:

Choose User Permissions from the Tools menu, or select the User 

Permissions button  on the toolbar.

8. Select Split/Skill Access from the Operations tab.

9. Select OK.

The Split/Skill Access input window displays.

10. Type the User ID you assigned in the User Data window in the User ID: 
text box.

11. Type the name(s) or number(s) of the split(s)/skill(s) for which you are 
assigning permissions.

Note The default permissions for splits/skills is no read/no write for all 
users. However, CMS does not store any split/skill access records 
for a user until you establish them in the window described below.

Note To clear all of the fields in the window at any time, select Clear 
all from the Edit menu, or press Ctrl+E.
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12. Change the Read, Write, and Exceptions check box permissions, as 
applicable (checked = on, blank = off), for the split(s)/skill(s).

13. Select Add from the Actions menu, or select the Add button  on the 
toolbar to modify the record for each split/skill.

14. Close the Split/Skill Access window.
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Establish the user’s trunk group access by doing the following steps:

1. Choose User Permissions from the Tools menu, or select the User 
Permissions button  on the toolbar.

2. Select Trunk Group Access from the Operations tab and select OK.

The Trunk Group Access input window displays.

3. Type the User ID you assigned in the User Data window in the User ID: 
text box.

4. Type the name(s) or number(s) of the trunk group(s) for which you are 
assigning permissions, or use the browse button to select the trunk 
group(s).

5. Change the Read, Write, and Exceptions check box permissions, as 
applicable (checked = on, blank = off), for the trunk group(s).

6. Select Add from the Actions menu, or select the Add button  on the 
toolbar to modify the record for each trunk group.

7. Close the Trunk Group Access window.

Note The default permissions for trunk groups is no read/no write for all 
users. However, CMS does not store any trunk group access records 
for a user until you establish them in the window described below.

Note To clear all of the fields in the window at any time, select Clear 
all from the Edit menu, or press Ctrl+E.
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Establishing VDN Permissions 11

Establish the user’s VDN access by doing the following steps:

1. Choose User Permissions from the Tools menu, or select the User 
Permissions button  on the toolbar.

2. Select VDN Access from the Operations tab and select OK.

The VDN Access input window displays.

3. Type the User ID you assigned in the User Data window in the User ID: 
text box.

4. Type the name(s) or number(s) of the VDN(s) you are assigning 
permissions for, or use the browse button to select the VDN(s).

5. Change the Read, Write, and Exceptions check box permissions, as 
applicable (checked = on, blank = off,) for the VDN(s).

6. Select Add from the Actions menu, or select the Add button  on the 
toolbar to modify the record for each VDN.

7. Close the VDN Access window.

Note The default permissions for VDNs no read/no write for all users. 
However, CMS does not store any VDN access records for a user 
until you establish them in the window described below.

Note To clear all of the fields in the window at any time, select Clear 
all from the Edit menu, or press Ctrl+E.
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Establish the user’s vector access by doing the following steps:

1. Choose User Permissions from the Tools menu, or select the User 
Permissions button  on the toolbar.

2. Select Vector Access from the Operations tab and select OK.

The Vector Access input window displays.

3. Type the User ID you assigned in the User Data window in the User ID: 
text box.

4. Type the name(s) or number(s) of the vectors(s) you are assigning 
permissions for, or use the browse button to select the vector(s).

5. Change the Read, Write, and Exceptions check box permissions, as 
applicable (checked = on, blank = off), for the vector(s).

6. Select Add from the Actions menu, or select the Add button  on the 
toolbar to modify the record for each vector.

7. Close the Vector Access window.

Note The default permissions for vectors is no read/no write for all users. 
However, CMS does not store any vector access records for a user 
until you establish them in the window described below.

Note To clear all of the fields in the window at any time, select Clear 
all from the Edit menu, or press Ctrl+E.
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This chapter teaches you how to use the Options tool to change the setup of 
the Supervisor application.

The sections in this chapter are as follows:

● About Options

● Starting Options

● Options General Tab

● Options Report Colors Tab

● Options Thresholds Colors Tab

● Options Names Tab

● Creating a New Report Color Scheme

● Creating a New Threshold Color Scheme

● Creating a New Name Format.
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Use Options to do the following actions:

● Set up or change the options for connecting to a remote host computer 
(Communications tab).

● Set up or change dial strings for connecting to the remote CMS through 
a modem port (Modem tab).

● Set the first calendar day that will display in Supervisor browse 
windows. (General Tab).

● Set the ACD and other general options that Supervisor will default to 
when you log in (General tab).

● Set up the colors that will be used in your graphical reports (Report 
Colors tab).

● Set up the colors that will be used in reports to tell you when threshold 
highlights (not exceptions thresholds) have been reached. See Chapter 5, 
“Reports,” for more information on threshold highlights.

● Choose or create a name format using {name} for Dictionary Name, 
{entity} for entity type, and {number} for entity number. The name 
format is how items will be displayed in reports. For instance, if you 
select the name format of {entity}{number}, then all of the entities 
(splits/skills, ACDs, VDNs, vectors, trunks, trunk groups, call work 
codes, and AUX codes) that can be named in the Dictionary will display 
as the entity type and number instead of the Dictionary name. If you 
selected {name} as the name format, then the names that have been 
assigned to the entities in the Dictionary will display.

Note This does not change the first day of the week that CMS uses for 
reporting purposes.
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Starting O ptions 12

To select any Options item in Supervisor, do the following steps:

1. Choose Options from the Tools menu.

OR

Select the Options button  on the toolbar. 

2. The Options window appears. You will see the following tabs to choose 
from:
● Communications
● Modem
● General
● Report Colors
● Threshold Colors
● Name Format.

The following sections describe the options available in each tab.
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Select the Communications tab to display the window that lets you set up or 
change the options for connecting to a remote host computer.

● Select Network, Serial, or Modem from the Connection box. Below are 
explanations and examples of the settings required for each type of 
connection. 

● Select Network if you are connecting to the CMS through a network.

An example of standard settings for a network connection is shown 
below:

Note The Communications tab is accessible only when you are not 
connected to a CMS server.

Warning
Do not change these settings unless you are instructed to do so 
by your Network Administrator.
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The information required for this setting is as follows:

— CMS Network Address — Enter the name or the Internet 
Protocol (IP) address of the remote host. There is no default.

— Network Port — Enter the network port that you wish to 
connect. The default is 23, which is the network port reserved 
for Telnet. 

● Select Serial if you are connecting to the CMS through a serial 
connection. 

The information required for the Serial setting is described on the next 
page.

● Select Modem if you are connecting to the remote CMS through a 
modem.

An example of standard settings for a serial or modem connection is 
shown below:

Warning
Do not change these settings unless you are instructed to do so 
by your Network Administrator.
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The information required for the Serial and Modem settings is as 
follows:
● Port — choose from the drop-down list the name of the 

communication port (COM) you will use to connect to the remote 
CMS. The options are COM1, COM2, COM3, and COM4.

● Baud Rate — choose the baud rate from the drop-down list. The 
options are 2400, 4800, 9600, 14.4K, 19.2K, and 38.4K.

● Flow Control — choose the appropriate flow control from the drop-
down list. The options are None, Xon/Xoff, Rts/Cts, and Both.

● Parity — choose the appropriate parity setting from the drop-down 
list. The options are None, Odd, Even, Mark, and Space.

● Data Bits — choose the number of data bits from the drop-down 
list. The options are 5, 6, 7, and 8.

● Stop Bits — choose the number of stop bits from the drop-down list. 
The options are 1, 1.5, and 2.
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Options Modem Tab 12

Select the Modem tab to set up or change dial strings for connecting to the 
remote CMS through a modem port. If you are connecting to the CMS 
through a modem, you also need to select the Modem option on the 
Communications tab. The following paragraphs describe the options 
available to you for setting up the modem connection. Below is an example 
of standard modem settings for Supervisor:

● Phone Number — enter the phone number of the remote host.

● Dial Prefix — enter the digits to be dialed before the Phone Number of 
the remote host. For example, if a 9 has to be dialed before the telephone 
number of the remote host, enter a 9 in this text box.

Note The Modem tab is accessible only when you are not connected to a 
CMS server.
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● Dial Suffix — enter the digits to be dialed after the Phone Number of 
the remote host. For example, if an extension has to be dialed after the 
telephone number of the remote host, enter it here.

● Hangup String — enter the character string to send to the modem to 
cause it to hang up the connection.

● Reset String — enter the character string to send to the modem to cause 
it to reset itself.

● Auto Retry — use this check box to turn on (or off) the auto retry option. 
If this option is turned off, the modem tries only once to establish a 
connection to the remote host.
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Options General Tab 12

The following graphic shows the Options General tab (with default 
settings).

Use the General tab to set your first calender day, default ACD, and other 
general options. The options are described below.

● First Day of Week — this option affects only how the calendar displays; 
it does not change the CMS Start of Week day for weekly data collection 
(the CMS Start of Week day is set through the System Setup—Storage 
Intervals window). For example, if you browse for a date, the calendar 
will start the week based on the day that you choose.

Use the drop-down list to make your selection.

● Default ACD — when you select the ACD, this ACD will be the default 
listed in the functions windows and drop-down list options. 

Note The General tab is accessible when you are connected to a CMS 
server.
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Use the drop-down list to make your selection.

● Synchronize PC and CMS Time at Login — activate the check box for 
this selection to set the PC’s clock to read the same time as the CMS 
clock. If you do not activate this selection, your PC clock and the CMS 
clock may not read the same time. This does not affect the CMS clock.

● Use Sound — activate the check box for this selection to be alerted, by 
sound, when the Exceptions Indicator box is updated. The Exceptions 
Indicator box is on the Controller status bar. The sound you hear is the 
sound you have chosen for the exclamation event associated with your 
PC.

● Use Tooltips — activate the check box for selection to make tooltips 
visible. For example, when you are working on the Controller window, 
you may place your mouse cursor over a toolbar button and a yellow 
box will appear with a brief description of that button.

● Use Tray Icon — activate the check box for this selection to use the 
Supervisor system tray icon feature. See Chapter 2, “Supervisor Basics,” 
for more information on using the Supervisor system tray icon.

● Window Menu Sort Order —if you activate the Use Tray Icon, you need 
to determine how the items that display in the system tray icon menu 
will be sorted.

— Start Order — select this radio button and the items in the system 
tray icon menu will display in the order in which you started them 
from Supervisor. 

— Alphabetical — select this radio button and the items in the system 
tray icon menu will display in alphabetical order, regardless of the 
order in which you started them.

Note Threshold Highlighting does not use sound. It uses color only 
as an indicator of a threshold being met.
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Options Report Colors Tab 12

The following graphic shows the Options Report Colors tab (with default 
settings).

Use the Report Colors tab to set up the colors that will be used in your 
Graphical reports. 

● Scheme: You can select the report color scheme that you want to use for 
Supervisor reports in one of two ways:

— From a series of predefined color schemes, which are listed in the 
Scheme: field. Use the drop-down list to select a different scheme 
from the one that is currently displayed.

— By creating a new color scheme. See the “Creating a New Report 
Color Scheme” section in this chapter for instructions on creating 
report color schemes. 

Note The Report Colors tab is accessible when you are connected to a 
CMS server.
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● Background: Supervisor gives you two choices for the background color 
of reports:

— White: Select this radio button to make the background of all 
reports white.

— Automatic: Select this radio button to make the background of all 
reports match the color that you have set up for your system in 
Windows*.

*Windows is a registered trademark of Microsoft Corp.
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Options Threshold Colors Tab 12

The following graphic shows the Options Threshold Colors tab (with 
default settings).

Use the Threshold Colors tab to set up the colors that will be used in reports 
to tell you when exceptions thresholds have been reached. You can select 
report color schemes in the following ways:

● From a series of predefined color schemes, which are listed in the 
Scheme: field. Use the drop-down list to select a different scheme from 
the one that is currently displayed.

● By creating a new color scheme. See the “Creating a New Threshold 
Color Scheme” section in this chapter for instructions on creating report 
color schemes. 

Note The Threshold Colors tab is accessible when you are connected to a 
CMS server.
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The following graphic shows the Options Name Format tab (with default 
settings).

Use the Name Format tab to choose or create formats for how CMS entities 
(splits/skills, ACDs, VDNs, vectors, trunks, trunk groups, call work codes, 
and AUX codes) will display in Supervisor. The display can be set to any one 
or a combination of {name} for Dictionary Name, {entity} for entity type, and 
{number} for entity number.

Note The Name Format tab is accessible when you are connected to a 
CMS server.
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To define the name format for entities, do the following steps:

1. Select the item that you want to set formats for from the Entity box.

2. In the Format text box, you can do either of the following actions:

— Type the format that you want ({name}, {entity}, and/or {number}), 
or 

— Use the drop-down list to choose from a set of preformatted options.

For example, if you want to display agent names and extension 
numbers on reports, enter {name} {number} in the Format box. 

The Example box provides an example of what the format will look like 
based on your current definition of the name format.

3. Select OK to save your changes. Select Cancel to clear your changes. 
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To create a new color scheme for reports, do the following steps:

1. Choose Options from the Tools menu, or select the Options button  
on the toolbar. 

2. Select the Report Colors tab.

3. Select the color scheme with which you want to begin from the Scheme: 
drop-down list.

The view of the scheme displays:

4. Choose the Background color for reports by selecting White or 
Automatic.

4 52 3

3. Color Bars
4. Color Selector
5. Pattern Selector

1

1. Scheme Drop-Down Selector List
2. Background Color
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5. Click on the color bar (1 through 16) you want to modify.

6. Select either the Color Selector or the Pattern Selector button.

If you select the Color Selector button, the following window displays:

If you select the Pattern Selector button, the following selection box 
displays:

Pattern Selection box
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7. To select a new color, choose from the Basic colors palette, or create a 
custom color using standard Windows procedures.

To select a new pattern, click on the pattern you want to use.

8. Repeat steps 5 through 7 until you have updated all of the color bars 
that you want to modify.

9. When you are done modifying color bars, select Save As.

The following window displays:

10. Type the name of the report color scheme that you created in the text 
box.

11. Select OK to save the scheme and the scheme name.

Warning
If you do not save the new color scheme using the Save As 
button, the changes that you have made will overwrite the 
default color scheme that you modified.

Note You can view the changes that you made to a color scheme at any 
point in the modification by selecting Apply. When you do this, the 
current color scheme is applied to any reports that are running.
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Creating a New Threshold Color Scheme 12

To create a new threshold color scheme for reports, do the following steps:

1. Choose Options from the Tools menu, or select the Options button  
on the toolbar. 

2. Select the Threshold Colors tab.

3. Select the color scheme with which you want to begin from the Scheme: 
drop-down list.

The view of the scheme displays:

4. Select the element of threshold highlighting that you want to modify 
colors for from the list box (Text Warning, Text Caution, Text Insufficient 

1

2

3 4 5 6
1. Scheme Drop-Down Selector List
2. Threshold Elements
3. Text Color
4. Background Color
5. Color Selector Buttons
6. Element Current Colors
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Sample Size, Chart Warning, Chart Caution, or Chart Insufficient 
Sample Size)

The current setting for the element displays to the right of the list box.

5. Set the color that will be displayed as text:

a. Select the Color Selector button next to the Text display box. The 
following window displays:

b. Choose a color from the Basic colors palette, or create a custom color 
using standard Windows procedures.

c. Select OK when you are done.

The Options window displays.

6. Set the color that will be displayed as the background on the threshold 
element:

a. Select the Color Selector button next to the Background display box. 

The Color palette displays.

b. Choose a color from the Basic colors palette or create a custom color 
using standard Windows procedures.

c. Select OK when you are done.

d. The Options window displays.
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7. Repeat steps 4 through 6 until you have updated all of the threshold 
element colors that you want to modify.

8. When you are done modifying the threshold element colors, select Save 
As.

The following window displays:

9. Type the name of the threshold color scheme that you created in the text 
box.

10. Select OK to save the scheme and the scheme name.

Note You can view the changes that you made to a color scheme at any 
point in the modification by selecting Apply. When you do this, the 
current color scheme is applied to any threshold highlights that are 
displayed on running reports.
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Creating a New Name Format 12

To create a new name format, do the following steps:

1. Choose Options from the Tools menu, or select the Options button  
on the toolbar. 

2. Select the Name Format tab.

3. Select the Entity for which you want to change the name format.

4. In the Format text box, use the drop-down list to select one of the 
standard formats, or type in a name combination.

5. Select OK.

If you typed a nonstandard name format in Step 4, the format is not 
saved in the Format list as a standard option.

6. To select another name format, go to the Name Format tab, select the 
format, and then select OK.
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Introduction 13

This chapter teaches you how to use the Add Button tool to create custom 
buttons for the toolbar, how to use the Remove Button tool to remove 
buttons from the toolbar, and how to reorganize the buttons on the toolbar.

The sections in this chapter are as follows:
● About the Add Button and Remove Button Tools
● Adding a Button to the Toolbar
● Editing a Button
● Removing a Button from the Toolbar
● Rearranging Buttons on the Toolbar.
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About the A dd Button and R emove Button 
Tools 13

You can use the Add Button and Remove Button options on the Tools menu 
to add and remove buttons, which represent Supervisor actions, to the 
toolbar.

The set of tool buttons on your toolbar are defined based on your user 
permissions. This is true for the standard buttons, as well as for buttons you 
can customize. 

When you login through Supervisor on a particular workstation for the first 
time, the tools on your toolbar are standard buttons. For example, some of 
the buttons may be as follows: Options, Logout, Reports, ACD 
Administration, Dictionary, Exceptions, and User Permissions. 

829.bk : toolbarsetup.fm  Page 2  Wednesday, November 20, 1996  3:09 PM



 Adding a Button to the Toolbar 13-3

Tools | A dd Button and R emove Button

C
ha

pt
er

 1
3

Adding a Button to the Toolbar 13

You can add a standard or custom toolbar button to the toolbar using the 
Add Button wizard. To add a button to the toolbar, do the following steps:

1. Select Add Button from the Tools menu. The first window in the Add 
Button wizard displays:

2. Select Next>.

3. Select the action that the button you are creating will perform.
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You can choose from the following selections:
● Run a ... —selecting the “Run a ...” action creates a button that starts 

a specific report from the Reports command.
● Select a ... — the “Select a ...” actions are the buttons that 

automatically appear on your toolbar. Unless you have previously 
removed one of these buttons from your toolbar, you will not be 
able to select them from this list.

● Open a ... — choosing one of the “Open a ...” actions creates a 
button that starts an operation or a report from the Dictionary, 
Exceptions, or ACD Administration commands or from the CMS 
System Setup, Maintenance, or User Permissions tools. 

4. Select Next>.
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Depending on the type of action you selected (“Run a ...” or “Open a ... 
window”), one of the following types of windows displays.

5. Select the appropriate radio button (Real-Time, Historical, or Integrated 
for the “Run a ...” action, or Operations or Reports for the “Open a ... 
window” action).

If you are creating a button for the “Open a ... window” action, select the 
operation or report that you want the button to access.
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6. Select Next>.

7. If you are creating a button for the “Open a ... window” action, go to 
Step 8.

If you are creating a button for the “Run a ...” action, the following 
window displays:

a. Select the report Category and the Report.

b. Select the ACD for which you would like to run the report.

c. Select Next>.
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The following window displays:

8. Type in the Description that you want to display in the status bar for this 
button.

9. Tab to the Tooltip text box. 

10. Type a one- or two-word description of the button, which will display as 
the tooltip when the mouse cursor is stopped on top of the button on the 
toolbar.

11. If you want to accept the default Button Face as the graphic for this 
button, select Finished.

The button is now available on your toolbar.

If you want to edit the Button Face, select Edit, and see the “Editing a 
Button” section in this chapter for instructions on editing a toolbar 
button.
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Editing a Button 13

You can define the design (paint) of any custom buttons that you define in 
Supervisor. To paint a custom button, do the following steps:

1. Select Edit Button Face option in the Add Button wizard.

2. The Edit Button Image window displays:

3. Position the mouse cursor over the primary color you will use to paint 
the button.

4. Click the left mouse button one time. The “L” moves to that color.

5. Position the mouse cursor over the secondary color you will use to paint 
the button.

6. Click the right mouse button one time. The “R” moves to that color.

7. Paint the grid using the colors you have selected (you can change colors 
at any time), using the following editing tools:
● Left mouse button: Hold down the left mouse button and move the 

cursor over the areas of the grid that you would like to paint the 
primary color.
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● Right mouse button: Hold down the right mouse button and move 
the cursor over the areas of the grid that you would like to paint the 
secondary color.

● Clear button: Select the Clear button to clear the current picture of 
the button. You can start over from this point.

● Up button: Select the Up button to paint the picture for this button 
when it is in the “Up” position. The “Up” position is what the 
button looks like when it is available, but not selected.

● Down button: Select the Down button to paint the picture for this 
button when it is in the “Down” position. The “Down” position is 
what the button looks like when you click on it from the toolbar.

● Disable button: Select the Disable button to paint the picture for 
this button when the operation or report is not currently available.

8. Once you have completed painting the button, select OK.

You are returned to the final window in the Add Button wizard.

9. Select Finished to save the changes you have made to the button and 
exit the Add Button wizard.

The button is now available on your toolbar.
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Removing a Button from the Toolbar 13

You can remove a button from the toolbar by doing the following steps:

1. Move the mouse cursor so that it is over the button you want to remove.

2. Right-click your mouse to display the menu.

3. Select Remove This Button.

The button is deleted from the toolbar.
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Rearranging Buttons on the Toolbar 13

You can rearrange the order in which buttons appear on the Controller 
toolbar using the drag-and-drop method (click on a button, hold the mouse 
button down, drag your cursor to the position in which you want the button 
to be located, and release the mouse button).

You can rearrange the order in which buttons appear on the toolbar and add 
spaces between buttons using the following steps:

1. Move the mouse cursor so that it is over the button that you want to 
move.

2. Hold down your CTRL key.

3. Press the left mouse button and move the cursor to the position where 
you want the button to be placed.

4. Release the mouse button and then the CTRL key.

The button is moved.

Note The toolbar buttons are positioned starting on the left side of the 
toolbar. You can move buttons just to the right of the last 
button, but not all the way to the right of the toolbar.
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Introduction 14

This sections in this chapter are as follows:

● About Bookmarks

● Adding Bookmarks

● Deleting Bookmarks

● Editing Bookmarks.
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About Bookmarks 14

Bookmarks offer a shortcut to running operations and reports. Once you 
add a bookmark, it is always available to you until you remove it using the 
Edit Bookmarks window.

Because bookmarks are so useful, Supervisor offers many options for 
organizing your bookmark list. You can add bookmarks to a standard list, 
then create hierarchical menus (folders) and separators to organize the 
bookmarks.

● Select the Add Bookmark button on any selector window to add the 
current report or operation to the Bookmarks menu. Each time you add 
a bookmark, the title of the window associated with the bookmark is 
appended as a menu item in the Bookmarks menu. Simply select the 
title to display the window on your screen.

● Choose Bookmarks | Edit Bookmarks to display the Edit Bookmarks 
window. The Edit Bookmarks window is where you can organize and 
maintain your bookmarks list.
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Adding Bookmarks 14

To add a bookmark from any selector window, simply highlight the 
report/operation for which you want to assign a bookmark and then click 
the Add Bookmark button.

When you select the bookmark from the Bookmarks menu, you will 
automatically be taken to the input window for the report/operation of that 
bookmark.

Add Bookmark
button

829.bk : bookmarks.fm  Page 3  Wednesday, November 20, 1996  3:09 PM



14-4 Deleting Bookmarks
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Deleting Bookmarks 14

To delete a bookmark from your list of bookmarks, do the following steps:

1. Select Edit Bookmarks from the Bookmarks menu.

2. On the Edit bookmarks window, highlight the bookmark you want to 
delete.

3. Select the Delete button or select the delete key on your keyboard.

Delete button
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Editing Bookmarks 14

The Edit Bookmarks window contains icons and folders to help you 
organize your bookmarks. Each bookmark icon corresponds to a menu item. 
each bookmark icon in a folder corresponds to a menu item under a header 
(a hierarchical or multilevel menu). Folders can be nested in other folders.

Use the Edit Bookmarks window in the following ways:

● Double click on a bookmark to access the Bookmark Properties window.

● To build a hierarchical menu, create a folder in the Edit Bookmarks 
window by selecting the New Category button and then using drag-
and-drop to move bookmarks into the category.

Any changes you make to your bookmarks are saved and immediately 
available.
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Bookmarks

● Properties — displays the Properties window as shown below:

● Delete — deletes the currently selected bookmark.

● Up arrow — moves the selected bookmark up in the list, one position 
per click.

● Down arrow — moves the selected bookmark down in the list, one 
position per click.

● New Category — lets you add a new folder above the current selection. 
To rename the folder, highlight it and then select the Properties button.

● New Separator — creates a SEPARATOR line above the current 
selection in the list.
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Putting bookmarks in folders 14

To create an hierarchical (cascading) bookmark menu, complete the 
following steps:

1. Choose the Bookmarks | Edit Bookmarks menu item to view the Edit 
Bookmarks window.

2. Click on the bookmark icon below where you want to position a new 
folder. Each folder represents a level (header) in a hierarchical 
(cascading) pull-down menu.

3. Select the New Category button. A folder titled “New Category” is 
inserted in the bookmarks list.

4. Leave the “New Category” folder highlighted and select the Properties 
button.

The Bookmark Properties window displays.

5. Type the name you want to assign to the folder, and then select OK.

You are returned to the Edit bookmarks window.

6. Highlight the first bookmark you want to move into the new folder. Use 
the up/down arrows to position the bookmark under the folder. You 
will notice that it is now indented from the level of the folder. The new 
folder is now displayed in your list of bookmarks. To see the bookmarks 
in the folder, click on the folder name.

When you are done arranging the bookmarks, select the OK button.
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Introduction 15

The sections in this chapter are as follows:

● About Real-Time Reports

● Agent—Graphical Information

● Agent—Information

● Split/Skill—Graphical AUX Agents

● Split/Skill—Graphical AUX Top Agents

● Split/Skill—Graphical Call Profile

● Split/Skill—Graphical EWT

● Split/Skill—Graphical Queue

● Split/Skill—Graphical Status

● Split/Skill—Graphical Top Skill Status

● Split/Skill—Top Agent Work State

● Split/Skill—Work State

● VDN—Graphical Call Profile.
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About Real-Time Reports 15

There are a series of Real-Time Supervisor reports that are available only 
when you are using the Supervisor application (they are not available 
through Terminal or standard CMS). 

Only reports that are available exclusively through Supervisor are described 
in this chapter. For descriptions of CMS reports that are not described in this 
chapter, see the CentreVu CMS Real-Time and Historical Reports document 
(585-215-821).

For general information about Historical reports, see Chapter 4, “Reports 
Basics,” and Chapter 5, “Reports”.

The Real-Time reports are identified in the following table:

Category Report Name
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Agent Graphical Information ❏ ❏

Information ❏ ❏

Split/Skill Comparison ❏

Graphical ASA ❏

Graphical AUX Agents ❏

Graphical AUX Top Agents ❏

Graphical Call Profile ❏ ❏

Graphical EWT ❏

Graphical Queue ❏

Graphical Service Level ❏

Graphical Skill Time Spent ❏

Graphical Split/Skill View ❏

Graphical Status ❏

Graphical Time Spent ❏

Graphical Top Skill Status ❏

Top Agent Work State ❏

Work State Report ❏
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VDN Graphical Call Handling ❏

Graphical Call Profile ❏ ❏

Graphical Service Level ❏

Note  “Graphical ....” reports may not be available on the Real-Time 
Report tab if they are not valid for your switch type or the features 
you purchased.

Category Report Name
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Real-Time Reports

Real-Time Agent Category Tab 15

The following is an example of the reports that may be available in the 
Agent Category from the Real-Time Report tab depending on your switch 
type and if you have purchased the EAS or Vectoring feature.
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Agent—Graphical Information 15

This report shows real-time information and statistics for the specified 
agent.

Things to Know About This Report 15

● You can access this report in the following ways:

— From the Real-Time Agent Category selector menu.

— By drilling down to this report from the Agent Name or Login ID 
fields on other reports (for example, Agent Information, Work State, 
or Graphic AUX Agent reports).

● Supervisors can use this report to access further information on one 
particular agent without having to execute several steps and several 
different reports to get the pertinent information. This report enables the 
supervisor to quickly make a more educated decision on whether an 
agent should be added to or removed from a skill.

● This report is available for all switch releases. The contents of this report 
depends upon the switch release for which it is being run.

● The following example of this report shows the information it will 
contain for the DEFINITY ® Enterprise Communications Server (ECS) 
Release 5 switch:

— Graphical information:

A three-dimensional vertical bar chart, with time (in minutes) along 
the y-axis, and agent work states along the x-axis. The chart shows 
how much time (in minutes) during the current interval the agent 
spent in each of the work states. By default, no legend accompanies 
the chart.

— Grid information:

A grid shows the skill that are assigned to the agent, and the skill 
level (if ECS switch with EAS) or the priority level with “1” 
representing the primary level, and “2” representing the secondary 
level (if using a pre-ECS switch with the EAS feature).

A scroll bar is displayed only if the number of skills to which the 
agent is assigned exceeds what can be displayed in the grid.

— Real-Time report status.
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Real-Time Reports

Input Window 15

Item Description

Agent: Enter the name of the agent. The agent’s name 
must be defined in the Dictionary subsystem, 
otherwise you will see the agent IDs.

Refresh Every <#> 
Seconds

Enter the number of seconds (3 to 600) to 
specify how rapidly CentreVu Supervisor 
should update the report data.
The default for the Refresh rate in seconds: field 
in this window is your assigned minimum 
refresh rate plus 15 seconds. To find out what 
your minimum refresh rate is, or to change it, 
check with your CentreVu CMS administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the 
report. For more information, see the “Setting 
Report threshold Highlights” section in Chapter 
5, “Reports.”

Run Minimized Check this box to minimize the report. 
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Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Agent: The names (or agent ID if the names have 
not been assigned in Dictionary) of the 
agent.

 syn(LOGID)

cagent
Login ID: The login identification of the agent. LOGID 

cagent
Extn: The extension that the agent logged in 

from.
EXTENSION
cagent

State: The current work mode (state) that the 
agent is in (AVAIL, ACD, ACW, AUX, 
DACD, DACW, RING, UNKNOWN, 
OTHER, UNSTAFF) and the call 
direction (blank, IN or OUT).

(syn)AWORKMODE 
and (syn)DIRECTION

cagent
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Time: Amount of time the agent has been in the 
current work mode (AVAIL, ACD, etc.) 
and the call direction. Time is zeroed 
whenever the work mode or call 
direction changes. That is, if the agent 
goes from ACD-IN to AVAIL, time starts 
over.

AGTIME

cagent

Active 
Skill:

The skill is active when the agent is:
• On a split/skill, on a direct agent ACD 

call, or in ACW—this is the split/skill 
associated with the call or ACW. 

• Available, in AUX or in OTHER states, 
this is null (blank). 

• On an AUXIN/AUXOUT call—this is 
the OLDEST_LOGON split/skill. 

• On an AUXIN/AUXOUT call from the 
available state, while in AUX or with 
an AUXIN/AUXOUT call from the 
available state, while in AUX or with 
an AUXIN/AUXOUT call on hold—
this is the OLDEST_LOGON 
split/skill. 

• On an AUXIN call with an ACD call on 
hold—this is the OLDEST_LOGON 
split/skill. 

• On an AUXOUT call with an ACD call 
on hold—this is the split/skill associ-
ated with the ACD call.

WORKSKILL differs from WORKSPLIT 
only in the case that the agent is 
available. In this case, WORKSKILL will 
be blank and WORKSPLIT will contain 
one of the splits/skills in which the agent 
is available.

syn(WORKSKILL)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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AUX 
Reason:

For ECS switch releases, this is the reason 
code associated with the auxiliary work 
state (on a break, in a meeting, and so on) 
of this agent. This field is blank if the 
agent is not in the AUX state.

syn(AUXREASON)

cagent
Top Skill: The agent’s first-administered, highest-

level, measured skill, where skill level 1 
is the highest, skill level 16 is the lowest.

syn(TOPSKILL)

cagent
Call 
Handling 
Preference:

The agent’s call handling preference. 
Values are blank, skill level (LVL) or 
greatest need (NEED).

syn(PREFERENCE)

cagent
ACD Calls: The ACD calls that were queued to the 

split/skill and answered by an agent 
during the current interval. This does not 
include direct agent calls, but it does 
include ACD calls placed by an adjunct 
(also called outbound predictive dialing), 
for the Generic 2.2 switches with ASAI 
Gateway or the Generic 3 with ASAI 
only. 

sum(ACDCALLS)

cagent

Move 
Pending?:

A move to a new split or skill or a change 
of skills is pending for this agent. This is 
available only for Generic 3 Version 4 and 
later switch releases with the “Move 
Agent While Staffed” feature.

MOVEPENDING

cagent
Direct 
Agent Skill:

The skill currently assigned as the agent’s 
direct agent skill. Direct agent calls to the 
agent are queued to this skill.

syn(DA_SKILL)

cagent
Direct 
Agent 
Calls:

The total number of split/skill and direct 
agent calls (Generic 3 switches only) that 
have been answered by this agent during 
the current interval. This is the number of 
calls that the agent answered, not the 
number of calls for which the agent 
counted an event.

sum(DA_ACDCALLS
)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Skill The split number that this EXTENSION 
is assigned to or the skill number that the 
agent logged into.

syn(SPLIT)

cagent
Level The skill level (1-16) associated with the 

SPLIT.
LEVEL
cagent

AVAIL The time during the collection interval 
that the agent was in the available state 
for split/skill. 

sum(TI_AVAILTIME)

cagent
ACD The total time during the collection 

interval that the agent was talking on 
ACD calls. 

sum 
(<TOTAL_I_ACDTIM
E>)
cagent

ACW The total time during the collection 
interval that the agent was in after call 
work (ACW). This includes ACW for 
split/skill ACD calls and ACW not 
associated with the call. 

sum(<TOTAL_I_ACW
TIME>

cagent)
AUX The total time during the collection 

interval that the agent was in the AUX 
work state in all splits/skills or on 
AUXINCALLS or AUXOUTCALLS. 

sum(TI_AUXTIME)

cagent
RING The time during the collection interval 

that the agent had split/skill and direct 
agent ACD calls ringing. 

sum(I_RINGTIME)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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OTHER The time during the collection interval 
that the agent was doing other work in 
all splits/skills.
For Generic 3 switches, while in Auto-in 
or Man-In: the agent put any call on hold 
and performed no further action, the 
agent dialed to place a call or to activate a 
feature, or an extension call rang with no 
other activity.

For Generic 2.2 switches, the agent 
pushed the Hold button or flashed the 
switchhook from auto-in or manual-in 
mode and performed no further action.
For all switches, TI_OTHERTIME is 
collected for the time period after the link 
to the switch comes up or after the agent 
logs in and before the CMS receives 
notification of the agent’s state from the 
switch.

The “TI_” time is stored only for the 
split/skill logged into the longest. “TI_” 
time needs to be summed across the 
splits/skills the agents may log into, in 
case the logon order changes during the 
collection interval.

sum(TI_OTHERTIME)

cagent

Staffed 
Time:

The time during the collection interval 
that the agent was staffed in any 
split/skill. “TI_” time is recorded only 
for the split/skill logged into the longest 
amount of time. “TI_” time needs to be 
summed across the splits/skills the 
agents may log into, in case the login 
order changes during the collection 
interval.

sum(TI_STAFFTIME)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Agent—Information 15

This report shows real-time information and statistics for the specified 
agent. 

Things to Know About This Report 15

● This version of the Agent Information report is for non-EAS users.

● You can access this report as follows:

— From the Real-Time Agent Category selector menu.

— By drilling down from the Agent Name or Login ID fields on other 
reports (for example, Agent, Agent Group, Graphical AUX Agents 
Report, Graphical AUX Top Agents Report, or other Real-Time and 
Integrated reports).

● Whenever you drill down to the Real-Time Agent Information report, 
you can also drill down to the Integrated Agent Information report by 
clicking the right mouse button.

● From this report, you can drill down to the Work State or Top Agent 
Work State reports.

● This report includes a grid that shows all the splits which the agent is 
logged into. 

● When this report is accessed from the report selector menu, you need to 
enter the Agent Name and Login ID input fields. 

● When this report is accessed from another report by drilling down, the 
input fields will be defaulted from the report you are drilling down 
from.

Note  If the agent is assigned to additional splits, but is not logged into 
those splits, these will not be reflected in this grid.
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Item Description

Agent: Enter the name of the agent. The agent’s name 
must be defined in the Dictionary subsystem; 
otherwise, you will see the agent Login IDs.

Refresh Every <#> 
Seconds

Enter the number of seconds (3 to 600) to 
specify how rapidly CentreVu CMS should 
update the report data.
The default for the Refresh rate in seconds: field 
in this window is your assigned minimum 
refresh rate plus 15 seconds. To find out what 
your minimum refresh rate is, or to change it, 
check with your CentreVu CMS administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the 
report. For more information, see the “Setting 
Report threshold Highlights” section in Chapter 
5, “Reports.”

Run Minimized Check this box to minimize the report. 
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Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Agent: The names (or agent ID if the names have 
not been assigned in Dictionary) of the 
agent.

 syn(LOGID)

cagent
Login ID: The login identification of the agent. LOGID

cagent
Extn: The extension that the agent logged in 

from.
EXTENSION
cagent

State: The current work mode (state) that the 
agent is in (AVAIL, ACD, ACW, AUX, 
DACD, DACW, RING, UNKNOWN, 
OTHER, UNSTAFF) and the call 
direction (blank, IN or OUT).

syn(AWORKMODE
) and 
syn(DIRECTION)

cagent
Time: The time that the agent has been in the 

current work mode (AVAIL, ACD, etc.) 
and the call direction. Time is zeroed 
whenever the work mode or call 
direction changes. That is, if the agent 
goes from ACD-IN to AVAIL, time starts 
over.

AGTIME

cagent

829.bk : realtimereports.fm  Page 14  Wednesday, November 20, 1996  3:09 PM



 Agent—Information 15-15

Real-Time Reports

C
ha

pt
er

 1
5

Active Split: The split is active when the agent is:
• On a split/skill, on a direct agent ACD 

call, or in ACW—this is the split/skill 
associated with the call or ACW. 

• Available, in AUX or in OTHER states, 
this is null (blank). 

• On an AUXIN/AUXOUT call—this is 
the OLDEST_LOGON split/skill. 

• On an AUXIN/AUXOUT call from the 
available state, while in AUX or with 
an AUXIN/AUXOUT call from the 
available state, while in AUX or with 
an AUXIN/AUXOUT call on hold—
this is the OLDEST_LOGON 
split/skill. 

• On an AUXIN call with an ACD call 
on hold—this is the OLDEST_LOGON 
split/skill. 

• On an AUXOUT call with an ACD call 
on hold—this is the split/skill associ-
ated with the ACD call.

WORKSKILL differs from WORKSPLIT 
only in the case that the agent is 
available. In this case, WORKSKILL will 
be blank and WORKSPLIT will contain 
one of the splits/skills in which the agent 
is available.

syn(WORKSKILL)

cagent

ACD Calls: The ACD calls that were queued to the 
split/skill and answered by the agent. 
This does not include direct agent calls, 
but it does include ACD calls placed by 
an adjunct (also called outbound 
predictive dialing), for the Generic 2.2 
switches with ASAI Gateway or the 
Generic 3 with ASAI only. 

sum(ACDCALLS)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Move 
Pending?:

A move to a new split is pending for this 
agent. This is available only for Generic 3 
Version 4 and later switch releases with 
the “Move Agent While Staffed” feature.

MOVEPENDING

cagent
Direct Agent 
Calls:

The number of split and direct agent calls 
(Generic 3 switches only) that the agent 
answered during the current interval. 
This is the number of calls that the agent 
answered, not the number of calls for 
which the agent counted an event.

sum(DA_ACD
CALLS)

cagent
AVAIL The time during the collection interval 

that the agent was in the available state 
for split or direct agent ACD calls in any 
split. 

sum(TI_AVAIL
TIME)

cagent
ACD The time during the collection interval 

that the agent was talking on ACD calls 
for the SPLIT. 

sum 
(<TOTAL_I_ACD
TIME>)
cagent

ACW The time during the collection interval 
that the agent was in after call work 
(ACW). This includes ACW for split 
ACD calls and ACW not associated with 
the call. 

sum(<TOTAL_I_
ACWTIME>

cagent)
AUX The time during the collection interval 

that the agent was in the AUX work state 
in all splits or on AUXINCALLS or 
AUXOUTCALLS. 

sum(TI_AUXTIME)

cagent
RING The time during the collection interval 

that the agent had split and direct agent 
ACD calls ringing. 

sum(I_RINGTIME)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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OTHER The time during the collection interval 
that the agent was doing other work in 
all splits.
For Generic 3 switches, while in Auto-in 
or Man-In: the agent put any call on hold 
and performed no further action, the 
agent dialed to place a call or to activate 
a feature, or an extension call rang with 
no other activity.

For Generic 2.2 switches, the agent 
pushed the Hold button or flashed the 
switchhook from Auto-in or Manual-in 
mode and performed no further action.
For all switches, TI_OTHERTIME is 
collected for the time period after the 
switch comes up or after the agent logs in 
and before the CMS receives notification 
of the agent’s state from the switch.

The “TI_” time is stored only for the 
split/skill logged into the longest. “TI_” 
time needs to be summed across the 
splits/skills the agents may log into, in 
case the logon order changes during the 
collection interval.

sum(TI_OTHER
TIME)

cagent
Staffed 
Split(s)

The split number(s) that this extension is 
assigned to or the split number(s) that 
the agent logged into.

syn(SPLIT)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Real-Time Split/Skill Category Tab 15

The following is an example of the reports that may be available in the 
Split/Skill Category from the Real-Time Report tab depending on your 
switch type and whether you have purchased the EAS or Vectoring feature.
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This report, which is available only with the ECS switch release, shows all 
agents with this skill who are in AUX, the reason, and the time in AUX.

Things to Know About This Report 15

● You can access this report as follows:

— From the Real-Time Split/Skill Category selector menu.

— By drilling down from the AUX work state fields on other reports to 
this report (only available with ECS switches). All other 
switch/EAS configuration drills down to the Work State Report. 

● From this report, you can drill-down to the Agent Information report 
from the “Agent Name” field.

● Call center supervisors can use this report to see which staffed agents 
are unavailable to take calls, and for what reason. The supervisor will 
also be able to see how long each agent has been unavailable for each of 
the reason codes. This will help the supervisor determine who will be 
available to answer calls if call volumes increase, and will also help to 
identify agents who are taking too long for breaks, lunch, etc.

● This report includes the following grid information:

— A row for each agent that is currently in the AUX work state for that 
skill.

— The agent’s name, login ID, reason code, and the time in AUX since 
the agent entered AUX for that reason code.

— You can specify how you want to sort the agent’s name, login ID, 
reason code, and time.

— You can use the scroll bar to see additional agents that are in the 
AUX state.

● This report shows the following two-dimension pie chart information 
for the number of agents in AUX for each reason code for that skill:
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— The pie chart’s legend shows the synonym for each reason code and 
its corresponding color of the pie. 

— The number of agents are shown inside each slice of the pie.

— The legend is sorted in ascending order by the reason code number, 
with the customer-defined synonym for reason code 0 at the 
bottom.

● The chart type can be changed. See the “Formatting Chart Reports” 
section in Chapter 4, “Reports Basics,” for more information.
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Item Description

Skill: Enter the skill name or number that you want to 
view in this report. Any name(s) that you want 
to appear on the report must have been 
previously defined and entered in the 
Dictionary subsystem.

Refresh Every 
<number> Seconds

Enter the number of seconds (3 to 600) to 
specify how rapidly CentreVu CMS should 
update the report data.
The default for the Refresh rate in seconds: field 
in this window is your assigned minimum 
refresh rate plus 15 seconds. To find out what 
your minimum refresh rate is, or to change it, 
check with your CentreVu CMS administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the 
report. For more information, see the “Setting 
Report threshold Highlights” section in Chapter 
5, “Reports.”

Run Minimized Check this box to minimize the report. 
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Report Example 15

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Skill: The name or number of the skill (up to 20 
characters) that is selected for this report. 

syn(SPLIT)
csplit

Agents in 
AUX:

The current number of positions that are 
in auxiliary work for this skill or on AUX-
IN/AUX-OUT calls.

INAUX

csplit
Reason 
Code 0

The current number of positions that are 
in auxiliary work with reason code zero 
(0) for this skill or on AUXIN/AUXOUT 
calls. Reason code 0 is for “system” AUX 
work when reason codes are active (ECS 
switches with EAS and later). 

INAUX0

csplit
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Reason 
Code 1-9

The current number of positions that are 
in auxiliary work with each of the reason 
codes 1-9 for this skill (ECS switches and 
later).

INAUX1-9

csplit
Agent Name The names (or agent IDs if the names 

have not been assigned in Dictionary) of 
the agents assigned to this split/skill and 
logged in.

syn(LOGID)

cagent
Login ID The login identification of the agent. LOGID

cagent
AUX Reason The reason associated with the auxiliary 

work state (on a break, in a meeting, and 
so on) of this agent. The agent will not 
appear in this report if the agent is not in 
the AUX work state.

syn(AUXREASON)

cagent
Time The time that has elapsed since the last 

agent WORKMODE changed for any 
split/skill. This item is not reset if the 
DIRECTION changes, but WORKMODE 
remains the same. For example, if the 
agent goes from AUX to AUXOUT to 
AUX, AGTIME continues without 
resetting.

AGTIME

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Split/Skill—Graphical AUX Top Agents 15

This report, which is available only with the ECS switch release, shows the 
top agents with this skill who are in AUX, the reason, and the time in AUX.

Things to Know About This Report 15

● You can access this report as follows:

— From the Real-Time Split/Skill Category selector menu

— By drilling down from the AUX or Top Agent AUX (csplit.TINAUX) 
work states on other top agent reports to this top agent report. This 
occurs only with ECS switches with EAS; otherwise, you drill down 
to the Top Agent Work State report.

● From this report, you can drill-down to the Agent Information report 
from the “Agent Name” field.

● Call center supervisors can use this report to see which top agents are 
unavailable to take calls, and for what reason. The supervisor will also 
be able to see how long each top agent has been unavailable for each of 
the reason codes. This will help the supervisor figure out who could be 
pulled in to answer calls if call volumes increase, and will also help to 
identify top agents who are taking too long for breaks, lunch, etc.

● A top agent for a skill is an agent who can be counted on to answer a call 
to that skill. An agent can have only one top skill and when an agent 
with a call handling preference skill level becomes available, the agent 
receives calls to this top skill. The agent receives calls to other skills only 
if no calls are waiting for the top skill.

● This report includes the following grid information:

— A row for each top agent that is currently in the AUX work state for 
that skill.

— The top agent’s name, login ID, reason code, and the time in AUX 
since the agent entered AUX for that reason code.

— You can specify how you want to sort the agent’s name, login ID, 
reason code, and time.
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AUX state.

● This report shows the following two-dimensional pie chart information 
for the number of agents in AUX for each reason code for that skill:

— The pie chart’s legend shows the synonym for each reason code and 
its corresponding color of the pie. 

— The number of agents are shown inside each slice of the pie.

— The legend is sorted in ascending order by reason code number, 
with the customer-defined synonym for reason code 0 at the 
bottom.

● The chart type can be changed. See the “Formatting Chart Reports” 
section in Chapter 4, “Reports Basics,” for more information. 
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Input Window 15

Item Description

Skill: Enter the skill name or number that you want to 
view in this report. Any name(s) that you want 
to appear on the report must have been 
previously defined and entered in the 
Dictionary subsystem.

Refresh Every 
<number> Seconds

Enter the number of seconds (3 to 600) to 
specify how rapidly CentreVu CMS should 
update the report data.
The default for the Refresh rate in seconds: field 
in this window is your assigned minimum 
refresh rate plus 15 seconds. To find out what 
your minimum refresh rate is, or to change it, 
check with your CentreVu CMS administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the 
report. For more information, see the “Setting 
Report threshold Highlights” section in Chapter 
5, “Reports.”

Run Minimized Check this box to minimize the report. 
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Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Skill: The name or number of the skill (up to 20 
characters) that is selected for this report. 

syn(SPLIT)
csplit

Top Agents in 
AUX:

The number of top agents logged into the 
skill who are in the AUX work mode. This 
includes agents on AUXIN/AUXOUT 
calls.

TINAUX

csplit
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Reason 
Code 0

The number of top agents logged into the 
skill who are in AUX work for reason 
code 0 (zero) for this skill or on 
AUXIN/AUXOUT calls for AUX with 
reason code 0. Reason code “0” is for 
“system” AUX work when reason codes 
are active (ECS EAS and later Generic 3 
EAS switches). 

TINAUX0

csplit
Reason 
Code 1-9

The number of top agents logged into the 
skill who are in AUX work for each of the 
reason codes 1-9. 

TINAUX1-9

csplit
Agent Name The names (or agent IDs if the names 

have not been assigned in Dictionary) of 
the top agents assigned to this skill and 
logged in.

syn(LOGID)

cagent
Login ID The login identification of the agent. LOGID

cagent
AUX Reason The reason associated with the auxiliary 

work state (on a break, in a meeting, and 
so on) of this agent. 

syn(AUXREASON)

cagent
Time The time that has elapsed since the last 

agent WORKMODE changed for any 
split/skill. This item is not reset if the 
DIRECTION changes, but WORKMODE 
remains the same. For example, if the 
agent goes from AUX to AUXOUT to 
AUX, AGTIME continues without 
resetting.

AGTIME

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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This report shows how well the split/skill you specify is performing 
compared to your call center’s predefined acceptable service level. 

Things to Know About This Report 15

● You can access this report from the Real-Time Split/Skill Category 
selector menu.

● This report has two charts:

— The top chart, a three-dimensional pie chart, shows the percentage 
of ACD calls answered within the predefined acceptable service 
level and the percentage of ACD calls answered outside this level. 

— The bottom chart, a stacked area graph, shows the number of 
answered and abandoned ACD calls within each service interval.

● The split/skill selected for the report and the predefined acceptable 
service level are displayed above the top chart. Legends appear to the 
right of each chart.

● On the bottom chart, the horizontal axis represents the service interval 
in seconds, and the vertical axis represents the number of ACD calls 
answered/abandoned within the acceptable service level.

● The number displayed for each service interval is the upper limit of the 
interval. For example, if the first two intervals are “3” and “5,” the first 
data point on the graph indicates the number of calls answered/ 
abandoned within 0-3 seconds, and the second data point indicates the 
number of calls answered/abandoned within 4-5 seconds.

● The chart type can be changed. See the “Formatting Chart Reports” 
section in Chapter 4, “Reports Basics,” for more information. 
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Input Window 15

Item Description

Split/Skill Enter the appropriate split/skill name. Any 
name you want to appear on the report must 
have been previously defined and entered in the 
Dictionary subsystem.

Refresh Every <#> 
Seconds

Enter the number of seconds (3 to 600) to 
specify how rapidly CentreVu CMS should 
update the report data.
The default for the Refresh rate in seconds: field 
in this window is your assigned minimum 
refresh rate plus 15 seconds. To find out what 
your minimum refresh rate is, or to change it, 
check with your CentreVu CMS administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the 
report. For more information, see the “Setting 
Report threshold Highlights” section in Chapter 
5, “Reports.”

Run Minimized Check this box to minimize the report. 
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Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Split/Skill: The name of the split/skill selected for 
this report.

syn(SPLIT)
csplit

Secs: The number of seconds within which calls 
must be answered in order to be 
considered acceptable for this split/skill.

SERVICELEVEL

csplit
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% Within 
Service Level

The percentage of split/skill ACD calls 
that were answered by an agent within 
the predefined acceptable service level. 
Calls to the split/skill include abandoned 
calls, calls not answered, and outbound 
ACD calls placed by an adjunct (for 
example, Outbound predictive dialing—
Generic 2.2 switches with ASAI Gateway 
Interface feature or Generic 3 switches 
with the ASAI feature). Calls that were 
not answered may include forced busy 
calls, forced disconnect calls, calls 
redirected to another destination, and 
calls queued to more than one split and 
answered in another split/skill.
For Generic 3 switches, Percent Within 
Service Level does not include direct 
agent calls.

<PERCENT_SERV_
LVL_SPL>

csplit

% Outside 
Service Level

The percentage of split/skill ACD calls 
that were answered by an agent within 
the predefined acceptable service level. 
Calls to the split/skill include abandoned 
calls, calls not answered, and outbound 
ACD calls placed by an adjunct (for 
example, Outbound predictive dialing - 
Generic 2.2 switches with ASAI Gateway 
Interface feature or Generic 3 switches 
with the ASAI feature). Calls that were 
not answered may include forced busy 
calls, forced disconnect calls, calls 
redirected to another destination, and 
calls queued to more than one split and 
answered in another split/skill.

For Generic 3 switches, Percent Within 
Service Level does not include direct 
agent calls.

<100-
PERCENT_SERV_
LVL_SPL>

csplit

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Aban Calls The number of calls that were abandoned 
during the collection interval in each of 
the service level increments PERIOD1 
through PERIOD9. ABNCALLS 10 counts 
calls that abandoned after PERIOD 9.

ABNCALLS1

csplit
ACD Calls The number of CALLSOFFERED calls 

that are answered by an agent for this 
split/skill. ACDCALLS includes 
O_ACDCALLS.

ACDCALLS1

csplit

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Split/Skill—Graphical EWT 15

This report shows the current Expected Wait Time (EWT) for one or more of 
the splits or skills you specify.

Things to Know About This Report 15

● This report is available only if you have a Generic 3 Version 4 or later 
version switch with the EWT option. 

● You can access this report from the Real-Time Split/Skill Category 
selector menu.

● The vertical axis of the chart is labeled with the names or numbers of the 
splits or skills selected for the report. 

● A legend appears to the right of the chart. 

● The appearance of the report can be changed. See the “Formatting Chart 
Reports” section in Chapter 4, “Reports Basics,” for more information. 
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Item Description

Splits/Skills: Enter the appropriate split/skill name(s). Any 
name you want to appear on the report must 
have been previously defined and entered in the 
Dictionary subsystem.

Refresh Every <#> 
Seconds

Enter the number of seconds (3 to 600) to 
specify how rapidly CentreVu CMS should 
update the report data.
The default for the Refresh rate in seconds: field 
in this window is your assigned minimum 
refresh rate plus 15 seconds. To find out what 
your minimum refresh rate is, or to change it, 
check with your CentreVu CMS administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the 
report. For more information, see the “Setting 
Report threshold Highlights” section in Chapter 
5, “Reports.”

Run Minimized Check this box to minimize the report. 
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Report Example 15

Report 
Heading

Description
Database Item/ 
Calculation
Table Name

Skill Name or number of the split/skill selected 
for this report (X-axis of the graph).

syn(SPLIT)
csplit
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Top Contains EWT for the split/skill at top 
priority.
EWT is administered in the Exceptions 
subsystem. It is the wait time for the call if 
it were queued to the split/skill at this 
priority. EWT measures only the time it 
takes to deliver the call to an agent. It does 
not include ringing time.

EWT is updated when a call is added to a 
queue, or every time the specified time 
interval is exceeded, whichever comes 
first.
If CMS is connected to a pre-Generic 3 
Version 4 switch or vectoring is not 
activated, the EWT headings and columns 
are displayed, but the fields are blank.

EWTTOP

csplit
High Contains EWT for the split/skill at high 

priority.
EWT is administered in the Exceptions 
subsystem. It is the wait time for the call if 
it were queued to the split/skill at this 
priority. EWT measures only the time it 
takes to deliver the call to an agent. It does 
not include ringing time.

EWT is updated when a call is added to a 
queue, or every time the specified time 
interval is exceeded, whichever comes 
first.
If CMS is connected to a pre-Generic 3 
Version 4 switch or vectoring is not 
activated, the EWT headings and columns 
are displayed, but the fields are blank.

EWTHIGH

csplit

Report 
Heading

Description
Database Item/ 
Calculation
Table Name
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Medium Contains EWT for the split/skill at 
medium priority.
EWT is administered in the Exceptions 
subsystem. It is the wait time for the call if 
it were queued to the split/skill at this 
priority. EWT measures only the time it 
takes to deliver the call to an agent. It does 
not include ringing time.

EWT is updated when a call is added to a 
queue, or every time the specified time 
interval is exceeded, whichever comes 
first.
If CMS is connected to a pre-Generic 3 
Version 4 switch or vectoring is not 
activated, the EWT headings and columns 
are displayed, but the fields are blank.

EWTMEDIUM

csplit
Low Contains EWT for the split/skill at low 

priority.
EWT is administered in the Exceptions 
subsystem. It is the wait time for the call if 
it were queued to the split/skill at this 
priority. EWT measures only the time it 
takes to deliver the call to an agent. It does 
not include ringing time.

EWT is updated when a call is added to a 
queue, or every time the specified time 
interval is exceeded, whichever comes 
first.
If CMS is connected to a pre-Generic 3 
Version 4 switch or vectoring is not 
activated, the EWT headings and columns 
are displayed, but the fields are blank.

EWTLOW

csplit

Report 
Heading

Description
Database Item/ 
Calculation
Table Name
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This report shows the number of calls waiting in queue, the amount of time 
that the oldest call has waited in queue, and trending for one or more 
splits/skills.

Things to Know About This Report 15

● You can access this report from the Real-Time Split/Skill Category 
selector menu.

● You can use this report to view trends of calls waiting for several 
splits/skills.

● The appearance of the report can be changed. See the “Formatting Chart 
Reports” section in Chapter 4, “Reports Basics,” for more information. 

● This report has four charts. The two charts on the left side of the report 
show the number of Calls Waiting (upper left quadrant) and the Oldest 
Call Waiting (lower left quadrant). The two charts on the right side of 
the report show the trends for the last ten refresh intervals for the same 
data items. Two legends (in the left quadrant) display to the left of the 
rolling line charts to show which line corresponds to which split/skill.

● Each bar chart has a horizontal bar, labeled with the split/skill name or 
number, for each split/skill selected for the report. Each chart’s x-axis 
dynamically scales to the largest value of the items being reported. The 
x-axis of the Calls Waiting bar chart displays the number of calls (No. 
Calls) waiting in the split/skill queue. The x-axis of the Oldest Call 
Waiting bar chart displays the number of seconds the oldest call in the 
split/skill queue has waited. 
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Input Window 15

Item Description

Splits/Skills: Enter the appropriate split/skill name(s). Any 
name you want to appear on the report must 
have been previously defined and entered in the 
Dictionary subsystem.

Refresh Every <#> 
Seconds

Enter the number of seconds (3 to 600) to 
specify how rapidly CentreVu CMS should 
update the report data.

The default for the Refresh rate in seconds: field 
in this window is your assigned minimum 
refresh rate plus 15 seconds. To find out what 
your minimum refresh rate is, or to change it, 
check with your CentreVu CMS administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the 
report. For more information, see the “Setting 
Report threshold Highlights” section in Chapter 
5, “Reports.”

Run Minimized Check this box to minimize the report. 
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Report 
Heading

Description
Database Item/ 
Calculation
Table Name

Split/Skill The name or number of the split/skill 
selected for this report.

syn(SPLIT)
csplit

Calls Waiting The number of split ACD calls waiting to 
be answered. This includes calls that are in 
queue and calls that are ringing at an agent 
voice terminal. It does not include direct 
agent calls (Generic 3).

INQUEUE + 
INRING

csplit
Oldest Call 
Waiting

The number of seconds that the oldest 
ACD call has waited in queue or ringing 
before being answered. This does not 
include direct agent calls.

OLDESTCALL

csplit
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Split/Skill—Graphical Status 15

This report shows the status of the agent, the amount of time in an agent 
state, and the split/skill statistics for individual agents.

Things to Know About This Report 15

● You can access this report from the Real-Time Split/Skill Category 
selector menu.

● From this report, you can drill down to the Real-Time or Integrated 
Agent Information, Work State, and Graphical AUX Agent (for an ECS 
switch with EAS) reports.

● The appearance of the report can be changed. See the “Formatting Chart 
Reports” section in Chapter 4, “Reports Basics,” for more information.

● This report is available in both graphical and tabular formats.

● The grid on the left side of the report lists the staffed (logged in) agents 
in the split/skill you specify, the state (workmode) each agent is 
currently in, the amount of time the agent has been in the current state, 
and the split/skill that the agent is in currently. If the Split/Skill column 
is empty, the agent is not currently on a call. The split/skill selected for 
the report is displayed above the table.

● By default, agent names are sorted alphabetically. If there are more 
staffed agents than can be displayed, a scroll bar appears on the right 
side of the table. To the left of each agent name (or login id, if names are 
not assigned) is an icon representing the agent’s state.

● The three-dimensional pie chart in the upper-right quadrant shows the 
number of agents in each agent state (Avail, ACD, AUX, ACW, Ring, 
Other) for the selected split/skill. The number of agents in each agent 
state is displayed on the corresponding piece of pie. A legend is 
displayed to the right of the chart.

● The fields in the lower-right quadrant of the report display real-time 
split/skill information.
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Item Description

Split/Skill: Enter the appropriate split/skill name(s). Any 
name you want to appear on the report must 
have been previously defined and entered in the 
Dictionary subsystem.

Refresh Every <#> 
Seconds

Enter the number of seconds (3 to 600) to 
specify how rapidly CentreVu CMS should 
update the report data.

The default for the Refresh rate in seconds: field 
in this window is your assigned minimum 
refresh rate plus 15 seconds. To find out what 
your minimum refresh rate is, or to change it, 
check with your CentreVu CMS administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the 
report. For more information, see the “Setting 
Report threshold Highlights” section in Chapter 
5, “Reports.”

Run Minimized Check this box to minimize the report. 

829.bk : realtimereports.fm  Page 43  Wednesday, November 20, 1996  3:09 PM



15-44 Split/Skill—Graphical Status

Real-Time Reports

Report Example 15

Report 
Heading 

Description
Database Item/ 
Calculation
Table Name

Split/Skill: The split/skill for which the agent is in 
the current work mode.

syn(SPLIT)
csplit

Agents 
Staffed:

The current number of positions that are 
staffed.

STAFFED
csplit

Agent Name The names (or agent IDs if the names 
have not been assigned in Dictionary) of 
the agents assigned to this split/skill 
and logged in.

syn(LOGID)

cagent
State The current work mode (state) the agent 

is in (AVAIL, ACD, ACW, AUX, DACD, 
DACW, RING, UNKNOWN, OTHER, 
UNSTAFF) and the call direction (blank, 
IN, or OUT).

syn(AWORKMODE)
 and 
syn(DIRECTION)

cagent
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Time The amount of time that the agent has 
been in the current work mode (AVAIL, 
ACD, etc.) and the call direction. Time is 
zeroed whenever the work mode or call 
direction changes. That is, if the agent 
goes from ACD-IN to AVAIL, time starts 
over.

AGTIME

cagent
Split/Skill The split/skill the agent is currently 

working in.
The skill is active when the agent is:

• On a split/skill, on a direct agent 
ACD call, or in ACW — this is the 
split/skill associated with the call or 
ACW. 

• Available, in AUX or in OTHER 
states, this is null (blank). 

• On an AUXIN/AUXOUT call — this 
is the OLDEST_LOGON split/skill. 

• On an AUXIN/AUXOUT call from 
the available state, while in AUX or 
with an AUXIN/AUXOUT call from 
the available state, while in AUX or 
with an AUXIN/AUXOUT call on 
hold — this is the OLDEST_LOGON 
split/skill. 

• On an AUXIN call with an ACD call 
on hold — this is the 
OLDEST_LOGON split/skill. 

• On an AUXOUT call with an ACD 
call on hold — this is the split/skill 
associated with the ACD call.

WORKSKILL

cagent

Report 
Heading 

Description
Database Item/ 
Calculation
Table Name
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Split/Skill 
(continued)

WORKSKILL differs from WORKSPLIT 
only in the case that the agent is 
available. In this case, WORKSKILL will 
be blank and WORKSPLIT will contain 
one of the splits/skills in which the 
agent is available.

WORKSKILL

cagent
AVAIL The number of positions that are 

currently available in this split/skill.
AVAILABLE
csplit

ACD The current number of positions that are 
on inbound and outbound ACD calls to 
this split/skill.

ONACD

csplit
ACW The current number of positions that are 

in after call work for this split/skill. This 
includes agents on ACW-IN/ACW-
OUT calls as well as agents in ACW not 
associated with an ACD call. It does not 
include agents in ACW for direct agent 
ACD calls.

INACW

csplit
AUX The current number of positions that are 

in auxiliary work for all splits/skills or 
on AUX-IN/AUXOUT calls.

INAUX

csplit
RING The current number of positions that are 

in the “ring” state for this split/skill.
AGINRING

csplit
OTHER The current number of positions that are 

doing other work. 
OTHER
csplit

Report 
Heading 

Description
Database Item/ 
Calculation
Table Name
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% Within 
Service Level:

The percentage of split/skill ACD calls 
answered by an agent within the 
predefined acceptable service level. 
Calls to the split/skill include calls that 
were abandoned and calls that were not 
answered, but do not include direct 
agent calls. Calls that were not 
answered may include forced busy calls, 
forced disconnect calls, calls redirected 
to another destination, and calls queued 
to more than one split/skill and 
answered in another split/skill.

100*(ACCEPTABLE/
 CALLSOFFERED)
<PERCENT_SERV_
LVL_SPL>

csplit
Calls Waiting: The number of split/skill ACD calls 

waiting to be answered. This includes 
calls that are in queue and ringing at an 
agent voice terminal and outbound 
ACD calls placed by an adjunct 
(outbound predictive dialing - Generic 
2.2 switches with ASAI Gateway 
Interface feature or Generic 3 switches 
with the ASAI feature only). It does not 
include direct agent calls (Generic 3 
switches only).

INQUEUE+INRING

csplit
Oldest Call 
Waiting:

The number of seconds the oldest ACD 
call has waited in queue or ringing 
before being answered. This does not 
include direct agent calls.

OLDESTCALL

csplit
Avg Speed 
Ans:

The average time calls waited in queue 
or ringing before an agent answered. 
This does not include direct agent calls, 
but it does include outbound ACD calls 
placed by an adjunct (outbound 
predictive dialing - Generic 2.2 switches 
with ASAI Gateway Interface feature or 
Generic 3 with the ASAI feature only).

ANSTIME / 
ACDCALLS

<AVG_ANSWER_
SPEED>

csplit

Report 
Heading 

Description
Database Item/ 
Calculation
Table Name
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ACD Calls: The queued ACD calls to the split/skill 
that were answered by an agent. This 
does not include direct agent calls, but it 
does include ACD calls placed by an 
adjunct (outbound predictive dialing - 
Generic 2.2 switches with ASAI 
Gateway or Generic 3 with ASAI only).

ACDCALLS

csplit, hsplit
Avg ACD 
Time:

The average talk time (does not include 
hold time) for all ACD calls to this 
split/skill. This does not include direct 
agent calls, but it does include talk time 
of all ACD calls placed by an adjunct 
(outbound predictive dialing - Generic 
2.2 switches with ASAI Gateway 
Interface feature or Generic 3 with the 
ASAI feature only).

ACDTIME / 
ACDCALLS

<AVG_ACD_TALK_
TIME>

csplit
Aban Calls: The number of queued calls for each 

split/skill that abandoned before an 
agent answered. This includes calls that 
are ringing at a voice terminal but does 
not include direct agent calls. It also 
includes the number of outbound calls 
for each split/skill that abandoned at 
the far end before an agent answered 
(Generic 2.2 switches with ASAI 
Gateway Interface feature or Generic 3 
with the ASAI feature only).

ABNCALLS

csplit
Avg Aban 
Time:

The average time a caller waited before 
hanging up.

ABNTIME / 
ABNCALLS
<AVG_ABANDON_
TIME>
csplit

Report 
Heading 

Description
Database Item/ 
Calculation
Table Name
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This report, available only with EAS, contains a grid of top agents and their 
work state, a pie chart showing the composite top agent status, and a pie 
chart showing the composite reason codes for top agents who are in AUX. 

Things to Know About This Report 15

● You can access this report from the Real-Time Split/Skill Category 
selector menu.

● From this report, you can drill down to the Real-Time and Integrated 
Agent Information, Top Agents Work State, and Graphical Top AUX 
Agent reports.

● You can use this report for skill level distribution and to keep agents 
very busy on ACD calls.

● Even though a skill may be staffed by many agents, it is likely that only 
those for whom this is their top skill will be available to answer calls to 
this skill.

● In addition, this report gives you an easy-to-read picture of what is 
happening with agents who are actually taking calls for this skill. This 
report is available for Generic 3 switch with EAS. 

● The three-dimension pie chart on the top left side of the report contains 
the following:

— The composite status of top agents for the skill in each of the work 
states.

— A legend in which a different color corresponds to each of the work 
states (synonyms for reason codes are defined in Dictionary).

● The two-dimension pie chart on the right side of the report contains:

— The composite status of top agents for the skill who are in AUX for 
each reason code.
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— A legend in which a different color corresponds to each of the 
reason codes (synonyms for reason codes are defined in Dictionary). 
The legend is sorted in ascending order by reason code number, 
with the customer-defined synonym for reason code 0 at the 
bottom.

● The grid on the left bottom half of the report contains a row for each 
staffed agent for whom this skill is their top skill. The row shows an icon 
representing agent state, the agent names as defined in the Dictionary, 
the agent state for this skill, time in current state, and a reason code (as 
defined in the Dictionary) for the AUX work state. The Reason column 
is blank except for those agents who are in AUX work. This grid also 
contains the skill in which the agent is active. This field is blank if the 
agent is in AVAIL, AUX, or OTHER work modes.

Note This pie chart contains data only for the ECS switch with 
EAS.
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Item Description

Skill: Enter the appropriate split/skill name or 
number. Any name you want to appear on the 
report must have been previously defined and 
entered in the Dictionary subsystem.

Refresh Every <#> 
Seconds

Enter the number of seconds (3 to 600) to 
specify how rapidly CentreVu CMS should 
update the report data.
The default for the Refresh rate in seconds: field 
in this window is your assigned minimum 
refresh rate plus 15 seconds. To find out what 
your minimum refresh rate is, or to change it, 
check with your CentreVu CMS administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the 
report. For more information, see the “Setting 
Report threshold Highlights” section in Chapter 
5, “Reports.”

Run Minimized Check this box to minimize the report. 
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Report Example 15

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Skill: The name or number of the skill (up to 
20 characters) that is selected for this 
report. 

syn(SPLIT)

csplit
Top Agents 
Staffed:

The number of staffed agents for whom 
this skill is their top skill.

TSTAFFED
csplit

Backup Agents 
Staffed:

The total number of backup (non-top) 
agents that are staffed for these skills.

STAFFED-TSTAFFED
csplit

AVAIL The total number of top agents logged 
into the skill who are available in the 
skill.

TAVAILABLE

csplit
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ACD The total number of top agents 
connected to inbound and outbound 
ACD calls in each skill. This does not 
include direct agent calls.

TONACD

csplit
ACW The number of top agents who are in the 

after call work state for each skill. This 
includes agents on ACW-IN or ACW-
OUT calls and agents in ACW not 
associated with an ACD call.

TINACW

csplit
AUX The total number of top agents logged 

into the skill who are in the AUX Work 
mode for all skills or are on 
AUXIN/AUXOUT calls.

TINAUX

csplit
RING The number of top agents with ACD 

calls (including direct agent calls) 
ringing.

TAGINRING

csplit

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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OTHER The current number of top agent 
positions that are doing other work. 
For the Generic 3 switch, the agent did 
one of the following activities while in 
the Auto-in or Manual-In state:

• The agent put any call on hold and 
performed no further action.

• The agent is on a direct agent call or in 
ACW for a direct agent call.

• The agent is dialing to place a call or 
to activate a feature.

• The agent has a personal call ringing 
with no other activity.

For the Generic 3 and the Generic 1 
switches without EAS, agents are logged 
into multiple splits and doing work for a 
split other than this one (on an ACD call 
or in call-related ACW).

For the Generic 3 and the Generic 2.2 
switches with EAS, agents are logged 
into multiple skills and doing work for a 
skill other than this one (on an ACD call 
or in call-related ACW).
Agent positions show up as OTHER 
directly after the link to the switch 
comes up and directly after the agents 
log in before the CentreVu CMS is 
notified of the agent's work state.

TOTHER

csplit

Agent Name The names (or agent IDs if the names 
have not been assigned in Dictionary) of 
the top agents assigned to this skill and 
logged in.

syn(LOGID)

cagent
State The current work mode (state) the agent 

is in (AVAIL, ACD, ACW, AUX, DACD, 
DACW, RING, UNKNOWN, OTHER, 
UNSTAFF) and the call direction (blank, 
IN, or OUT).

syn(AWORKMODE)
and 
syn(DIRECTION)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

829.bk : realtimereports.fm  Page 54  Wednesday, November 20, 1996  3:09 PM



 Split/Skill—Graphical Top Skill Status 15-55

Real-Time Reports

C
ha

pt
er

 1
5

Time The length of time the agent has been in 
the current work mode (AVAIL, ACD, 
and so on), and the call direction.

AGTIME

cagent
AUX Reason The reason associated with the auxiliary 

work state (on a break, in a meeting, and 
so on) of this agent. This field is blank if 
the agent is not in the AUX state.

syn(AUXREASON)

cagent
Skill When an agent is on a split/skill call, a 

direct agent call, or in the After Call 
Work (ACW) mode, this is the split/skill 
associated with the call or the ACW. 
WORKSKILL is the OLDEST_LOGON:

• When an agent is on an 
AUXIN/AUXOUT call from the avail-
able state, while in AUX or with an 
AUXIN/AUXOUT call on hold

• When an agent is on an AUXIN call 
with an ACD call on hold.

When an agent is on an AUXOUT call 
with an ACD call on hold, this is the 
split/skill associated with the ACD call. 

When an agent is available, in AUX, or 
in OTHER, this is blank.

WORKSKILL

cagent

Reason 
Code 0

The number of top agents logged into 
the skill who are in AUX work for reason 
code 0 for all splits or on 
AUXIN/AUXOUT calls for AUX with 
reason code 0.

TINAUX0

csplit
Reason Code 
1...9

The number of top agents logged into 
the skill who are in AUX work for each 
of the reason codes 1-9. This includes 
agents on AUXIN/AUXOUT calls from 
AUX with the appropriate reason code.

TINAUX1-9

csplit

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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This report shows top agents who are in the specified work state and the 
time in the state. In addition, this report shows all of the agents that are 
staffed even if they are not in a particular state for the specified split/skill. 

Things to Know About This Report 15

● You can access this report only by drilling down from work states 
(AVAIL, ACD, ACW, RING, and OTHER) on other Real-Time Top Agent 
reports (for example, from the Real-Time Graphical Top Skill Status 
report) except for the AUX work state which requires ECS with EAS.

● Because this report is only accessible by drilling down, there is no input 
window for the report.

● When you drill down to this report from another report, this report 
shows all of the top agents in that particular work state for that split or 
skill only.

● From this report, you can drill down to Real-Time or Integrated Agent 
Information reports.

● This report is available on all ECS or later switch releases with EAS.

● Call center supervisors can use this report to look at all the top agents in 
a particular work state, to see how long an agent has been in this work 
state, the skill for which they are occupied, and to see the skill level 
assigned to the agent for this skill.

● This report contains the following:

— A grid with a row for each top agent currently in the selected work 
state.

— Top agent name, login ID, time in state, split/skill, and the skill level 
for the skill in which the agent is active in each row of the grid.

— Ability of the user to specify sort by agent name, login ID, time in 
state, split/skill, and skill level.

— Ability of the user to specify a primary and a secondary sort key.

— A grid, by default, that is sorted by split/skill for the primary sort, 
then by time in state (in descending order) for the secondary sort.
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Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Skill: The name or number of the skill selected 
for the report.

syn(SPLIT)

Agent State: The current work mode for this agent. 
Values include AVAIL, ACD, ACW, AUX, 
DACD, DACW, RING, UNKNOWN, 
OTHER, and UNSTAFF.

(syn)WORKMODE

cagent
Agent Name: The names (or agent IDs if the names 

have not been assigned in Dictionary) of 
the top agents assigned to this skill and 
logged in.

syn(LOGID)

cagent
Login ID The login identification of the agent. LOGID

cagent
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Active Skill The split is active when the agent is:
• On a skill, on a direct agent ACD call, 

or in ACW—this is the skill associated 
with the call or ACW. 

• Available, in AUX or in OTHER states, 
this is null (blank). 

• On an AUXIN/AUXOUT call—this is 
the OLDEST_LOGON skill. 

• On an AUXIN/AUXOUT call from the 
available state, while in AUX or with 
an AUXIN/AUXOUT call from the 
available state, while in AUX or with 
an AUXIN/AUXOUT call on hold—
this is the OLDEST_LOGON skill. 

• On an AUXIN call with an ACD call on 
hold—this is the OLDEST_LOGON 
skill. 

• On an AUXOUT call with an ACD call 
on hold—this is the split/skill associ-
ated with the ACD call.

WORKSKILL differs from WORKSPLIT 
only in the case that the agent is available. 
In this case, WORKSKILL will be blank 
and WORKSPLIT will contain one of the 
skills in which the agent is available.

syn(WORKSKILL)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Level When an agent is on a skill call, a direct 
agent call, or in ACW mode, this is the 
skill associated with the call or the ACW, 
and the level associated with the skill.
WORKSKILL is the OLDEST_LOGON:

• When an agent is on an AUXIN/AUX-
OUT call from the available state, while 
in AUX or with an AUXIN/AUXOUT 
call on hold

• When an agent is on an AUXIN call 
with an ACD call on hold.

When an agent is on an AUXOUT call 
with an ACD call on hold, this is the skill 
associated with the ACD call.

When an agent is available, in AUX, or in 
OTHER, this is blank.
WORKSKLEVEL is the skill level 
(ranging from 1 to 16 for ECS switches, or 
1-2 for earlier switch releases) associated 
with WORKSKILL.

WORKSKLEVEL

cagent

Time The amount of time the agent has been in 
the current work mode (AVAIL, ACD, 
etc.) and the call direction. Time is zeroed 
whenever the work mode or call direction 
changes. That is, if the agent goes from 
ACD-IN to AVAIL, time starts over.

AGTIME

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Split/Skill—Work State 15

This report shows all of the agents who are in a specified work state and the 
time in that state.

Things to Know About This Report 15

● You can access this report only by drilling down from work states 
(AVAIL, ACD, ACW, AUX, RING, and OTHER) on other Real-Time 
reports (for example, from the Real-Time Graphical Status report).

● Because this report is only accessible by drilling down, there is no input 
window for the report.

● When you drill down to this report from another report, this report 
shows all of the agents in that work state for that split or skill only.

● From this report, you can drill down to Real-Time or Integrated Agent 
Information reports.

● This report is available on all switches.

● Call center supervisors can use this report to look at all agents in a 
particular work state, and to see how long an agent has been in this 
work state, the split/skill for which they are occupied, and to see the 
skill level assigned to the agent for this skill.

● This report contains the following:

— A grid with a row for each top agent currently in the selected work 
state.

— Agent name, login ID, time in state, split/skill, and the skill level for 
the skill in which the agent is active in each row of the grid.

— Ability of the user to specify sort by agent name, login ID, time in 
state, split/skill, and skill level.

— Ability of the user to specify a primary and a secondary sort key.

— A grid, by default, that sorts by split/skill for the primary sort, then 
by time in state (in descending order) for the secondary sort.
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Item Description
Database Item/ 
Calculation, 
Table Name

Split/Skill: The name or number of the split/skill 
selected for the report.

syn(SPLIT)
csplit

Agent State: The current work mode (state) that the 
agent is in (AVAIL, ACD, ACW, AUX, 
DACD, DACW, RING, UNKNOWN, 
OTHER, UNSTAFF) and the call direction 
(blank, IN or OUT).

AWORKMODE 
and DIRECTION

cagent
Agent Name The names (or agent IDs if the names 

have not been assigned in Dictionary) of 
the agents assigned to this split/skill and 
logged in

syn(LOGID)

cagent
Login ID The login identification of the agent. LOGID

cagent
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Active 
Split/Skill

The split is active when the agent is:
• On a split/skill, on a direct agent ACD 

call, or in ACW—this is the split/skill 
associated with the call or ACW. 

• Available, in AUX or in OTHER states, 
this is null (blank). 

• On an AUXIN/AUXOUT call—this is 
the OLDEST_LOGON split/skill. 

• On an AUXIN/AUXOUT call from the 
available state, while in AUX or with 
an AUXIN/AUXOUT call from the 
available state, while in AUX or with 
an AUXIN/AUXOUT call on hold—
this is the OLDEST_LOGON 
split/skill. 

• On an AUXIN call with an ACD call on 
hold—this is the OLDEST_LOGON 
split/skill. 

• On an AUXOUT call with an ACD call 
on hold—this is the split/skill associ-
ated with the ACD call.

WORKSKILL differs from WORKSPLIT 
only in the case that the agent is available. 
In this case, WORKSKILL will be blank 
and WORKSPLIT will contain one of the 
splits/skills in which the agent is 
available.

syn(WORKSKILL)

cagent

Item Description
Database Item/ 
Calculation, 
Table Name
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Level When an agent is on a skill call, a direct 
agent call, or in ACW mode, this is the 
skill associated with the call or the ACW, 
and the level associated with the skill.
WORKSKILL is the OLDEST_LOGON:

• When an agent is on an AUXIN/AUX-
OUT call from the available state, while 
in AUX or with an AUXIN/AUXOUT 
call on hold

• When an agent is on an AUXIN call 
with an ACD call on hold.

When an agent is on an AUXOUT call 
with an ACD call on hold, this is the skill 
associated with the ACD call.

When an agent is available, in AUX, or in 
OTHER, this is blank.
WORKSKLEVEL is the skill level 
(ranging from 1 to 16) associated with 
WORKSKILL.

WORKSKLEVEL

Time The amount of time that the agent has 
been in the current work mode (AVAIL, 
ACD, etc.) and the call direction. Time is 
zeroed whenever the work mode or call 
direction changes. That is, if the agent 
goes from ACD-IN to AVAIL, time starts 
over.

AGTIME

Item Description
Database Item/ 
Calculation, 
Table Name
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The following is an example of the reports that may be available in the VDN 
Category from the Real-Time Report tab depending on your switch type and 
whether you have purchased the EAS or Vectoring feature.
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This report shows how calls to the VDN that you specify are being handled 
compared to your call center’s predefined acceptable service level. By 
default, the report appears as shown in this section. However, the chart type 
can be changed.

Things to Know About This Report 15

● You can access this report from the Real-Time VDN Category selector 
menu.

● This report is available on switches with the Call Vectoring feature.

● See the “Formatting Chart Reports” section in Chapter 4, “Reports 
Basics,” for more information.

● Call center supervisors can use this report to look at VDN calls 
answered within the acceptable service level and service interval 
answer and abandons.

● This report contains two charts, with a legend to the right of each:

— The top chart, a three-dimensional pie chart, shows the percentage 
of ACD calls answered within the predefined acceptable service 
level and the percentage of ACD calls answered outside this level.

— The bottom chart, an area graph, shows the number of ACD calls 
answered and abandoned within each service interval. The 
horizontal axis represents each of the defined service intervals in 
seconds, and the vertical axis represents the number of ACD calls 
answered/abandoned within each of the defined service levels. The 
number displayed for each service interval is the upper limit of the 
interval. For example, if the first two intervals are “5” and “10,” the 
first data point on the graph shows the number of calls answered/
abandoned within 0-5 seconds, and the second data point shows the 
number of calls answered/abandoned within 6-10 seconds.

— The VDN selected for the report and the predefined acceptable 
service level are displayed above the top chart.
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Item Description

VDN: Enter the name or number of the VDN that you 
want included in the report. You can enter a name 
only if it has been previously defined in the 
Dictionary subsystem. To complete the input field, 
do the following:

• Type in the information requested.
• Select the information from the pull-down list of 

previously used items. During each CMS session, 
Supervisor recalls the items you have selected for 
each input field. You can use the pull-down list to 
select an item for the input field.

• Use the Browse button to view all available items 
for the input field, and then select an item(s) for 
the input field. When you click on the Browse 
button, a window opens that lets you select items 
for the input field.
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Refresh Every <#> 
Seconds

Enter the number of seconds (3 to 600) to specify 
how rapidly CentreVu CMS should update the 
report data.
The default for the Refresh rate in seconds: field in 
this window is your assigned minimum refresh rate 
plus 15 seconds. To find out what your minimum 
refresh rate is, or to change it, check with your 
CentreVu CMS administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the 
report. For more information, see the “Setting 
Report Threshold Highlights” section in Chapter 5, 
“Reports.”

Run Minimized Check this box to minimize the report. 

Item Description
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Item Description
Database Item/ 
Calculation
Table Name

VDN: The number or name of the VDN for which 
the report shows data (selected in the report 
input window).

VDN or syn(VDN)

cvdn
Secs.: The current setting for the acceptable 

service level.
SERVICELEVEL
cvdn
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% Within 
Service Level

Percentage of calls to the VDN that were 
answered/connected within the service 
level (specified in the VDN Call Profile 
Setup window). For Generic 3 switches, 
Percent Within Service Level does not 
include direct agent calls.

<PERCENT_SERV
_LVL_VDN>

cvdn
% Outside 
Service Level

The percentage of VDN calls that were not 
answered by an agent within the predefined 
acceptable service level. Calls that were not 
answered may include forced busy calls, 
forced disconnect calls, calls redirected to 
another destination, and calls queued to 
more than one VDN and answered in 
another VDN.

<100-PERCENT_
SERV_LVL_VDN>

cvdn
Service 
Interval - 
Seconds

The lower and upper limit in seconds of 
each service level increment (as defined in 
the VDN Call Profile Setup window). These 
increments represent progressively longer 
wait time segments in which calls may be 
answered, connected, or abandoned.

PERIOD1-9

cvdn
ACD + Conn 
Calls

The number of calls to the VDN that were 
answered by an agent or connected to a 
non-ACD destination within each of the 
service level increments. Calls in each 
increment are represented by color-coded 
area (see legend).

ANSCONNCALLS
1 through 10

cvdn

Aban Calls The number of calls to the VDN that were 
abandoned within each of the service level 
increments. Calls in each increment are 
represented by color-coded area (see chart 
legend) that change color when an upper or 
lower threshold is reached. For Generic 2.2 
and all Generic 3 switches, this is all VDN 
calls abandoned. With Generic 2.1 and 
System 85 switches, this is ACD calls 
abandoned.

ABNCALLS1-10

cvdn

Item Description
Database Item/ 
Calculation
Table Name
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Introduction 16

The sections in this chapter are as follows:

● About Historical Reports

● Agent—Graphical Time Spent

● Split/Skill—Graphical ASA

● Split/Skill—Graphical Call Profile

● Split/Skill—Graphical Service Level

● Split/Skill—Graphical Skill Time Spent

● VDN—Graphical Call Profile

● VDN—Graphical Service Level.
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About Historical Reports 16

There are a series of Historical Supervisor reports that are available only 
when you are using the Supervisor application (they are not available 
through Terminal or standard CMS). 

Only reports that are available exclusively through Supervisor are described 
in this chapter. For descriptions of CMS reports that are not described in this 
chapter, see the CentreVu CMS Real-Time and Historical Reports document 
(585-215-821).

For general information about Historical reports, see Chapter 4, “Reports 
Basics,” and Chapter 5, “Reports.”

The Historical reports are identified in the following table:

Category Report Name
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Agent Graphical Information ❏ ❏

Information ❏ ❏

Split/Skill Comparison ❏

Graphical ASA ❏

Graphical AUX Agents ❏

Graphical AUX Top Agents ❏

Graphical Call Profile ❏ ❏

Graphical EWT ❏

Graphical Queue ❏

Graphical Service Level ❏

Graphical Skill Time Spent ❏

Graphical Split/Skill View ❏

Graphical Status ❏

Graphical Time Spent ❏

Graphical Top Skill Status ❏

Top Agent Work State ❏

Work State Report ❏
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VDN Graphical Call Handling ❏

Graphical Call Profile ❏ ❏

Graphical Service Level ❏

Note  “Graphical ....” reports may not be available on the Real-Time 
Report tab if they are not valid for your switch type or the features 
you purchased.

Category Report Name
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The following is an example of the reports that may be available in the 
Agent Category from the Historical Report tab depending on your 
switch type and whether you have purchased the EAS or Vectoring 
feature.
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Agent—Graphical Time Spent 16

This report shows historical information and statistics for the specified 
agent.

Things to Know About This Report 16

● You can access this report from the Historical Agent Category selector 
menu.

● This report is available for all switch releases. The contents of this report 
depends upon the switch release for which it is being run.

● Call center supervisors can use this report to get an idea of how much 
time an agent spent on ACD calls, in available state, in ACW, in AUX, 
etc. for a particular day. This report enables the supervisor to tell how 
much time the agent spent in AUX work state for each of the reason 
codes defined for this call center.

● The following example of this report shows the information it will 
contain for the DEFINITY ® Enterprise Communications Server (ECS) 
Release 5 switch with EAS.
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Item Description

Agent: Enter the name of the agent. The agent’s name 
must be defined in the Dictionary subsystem; 
otherwise, you will see the agent IDs.
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Date: Enter the date for which the report will be run. 
To complete the input field, do any of the 
following steps:

• Type in the information requested. You can 
type in month/date/year format (for exam-
ple, 8/21/96), or you can use a “-” offset 
based on today’s date (for example, -1 for 
yesterday).

• Select the information from the pull-down list 
of previously used items. During each CMS 
session, Supervisor recalls the items you have 
selected for each input field. You can use the 
pull-down list to select an item for the input 
field.

• Use the Browse button to view all available 
items for the input field, and then select an 
item(s) for the input field. When you click on 
the Browse button, a window opens that lets 
you select items for the input field.

Destination Choose a report destination. You can select 
View Report on Screen or Print Report on: and 
then use the Select Printer button to print the 
report on any Windows printer. The default 
printer is shown.

Item Description
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Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Agent: The names (or agent login ID if the 
names have not been assigned in 
Dictionary) of the agent.

 syn(LOGID)

cagent
Date: The day for which the report was run 

(selected in the report input window).
ROW_DATE

AVAIL The time during the collection interval 
that the agent was in the available state 
for split/skill or direct agent ACD calls 
in any split/skill. 

sum(TI_AVAILTIME)

cagent
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ACD The time during the collection interval 
that the agent was talking on ACD calls 
for the SPLIT. 

sum (<TOTAL_I_ACD
TIME>)
cagent

ACW The time during the collection interval 
that the agent was in after call work 
(ACW). This includes ACW for 
split/skill ACD calls and ACW not 
associated with the call. 

sum(<TOTAL_I_ACW
TIME>

cagent)
AUX The time during the collection interval 

that the agent was in the AUX work state 
in all splits/skills or on AUXINCALLS 
or AUXOUTCALLS. 

sum(TI_AUXTIME)

cagent
RING The time during the collection interval 

that the agent had split/skill and direct 
agent ACD calls ringing. 

sum(I_RINGTIME)

cagent
Reason 
Code 0

The time that the agent spent in AUX 
with reason code 0. This is the time in 
“system” AUX for the switches with 
AUX reason codes active. It is the same 
as TI_AUXTIME for switches without 
AUX reason codes active. The “TI_” 
stands for the time that is stored only for 
the split or skill that the agent is logged 
into for the longest amount of time. 
“TI_” time needs to be summed across 
the skills the agents may log into, in case 
the login order changes during the 
collection interval.

sum(TI_AUXTIME0)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Reason 
Codes 1-9

The time that the agent spent in AUX 
with each of the reason codes 1-9. The 
“TI_” stands for the time that is stored 
only for the split or skill that the agent is 
logged into for the longest amount of 
time. “TI_” time needs to be summed 
across the skills the agents may log into, 
in case the login order changes during 
the collection interval.

sum(TI_AUXTIME1-9)

cagent
OTHER The time during the collection interval 

that the agent was doing other work in 
all splits/skills.

For Generic 3 switches, while in Auto-in 
or Man-In: the agent put any call on hold 
and performed no further action, the 
agent dialed to place a call or to activate 
a feature, or an extension call rang with 
no other activity.
For Generic 2.2 switches, the agent 
pushed the Hold button or flashed the 
switchhook from Auto-in or Manual-in 
mode and performed no further action.

For all switches, TI_OTHERTIME is 
collected for the time period after the 
line to the switch comes up or after the 
agent logs in and before the CMS 
receives notification of the agent’s state 
from the switch.
The TI_ stands for the time that is stored 
only for the split/skill that the agent is 
logged into for the longest amount of 
time. TI_ time needs to be summed 
across the splits/skills the agents may 
log into, in case the logon order changes 
during the collection interval.

sum(TI_OTHERTIME)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Historical Split/Skill Category Tab 16

The following is an example of the reports that may be available in the 
Agent Category from the Historical Report tab depending on your switch 
type and whether you have purchased the EAS or Vectoring feature.
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The Historical Graphical ASA (Average Speed of Answer) report shows the 
average speed of answer for ACD calls answered in each selected split/skill 
for each selected interval.

Things to Know About This Report 16

● You can access this report from the Historical Split/Skill Category 
selector menu.

● The chart type can be changed. See the “Formatting Chart Reports” 
section in Chapter 4, “Reports Basics,” for more information.
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Input Window 16

Item Description

Splits/Skills: Enter the name(s) or number(s) of the 
split(s)/skill(s) you want included in the report. 
You can enter a name only if it has been 
previously defined in the Dictionary subsystem. 
To complete the input field, do the following:
• Type in the information requested.
• Select the information from the pull-down 

list of previously used items. During each 
CMS session, Supervisor recalls the items you 
have selected for each input field. You can 
use the pull-down list to select an item for the 
input field.

Use the Browse button to view all available 
items for the input field, and then select (an) 
item(s) for the input field. When you click on 
the Browse button, a window opens that lets 
you select items for the input field.
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Date: Enter the date for which the report will be run. 
To complete the input field, do the following:

• Type in the information requested. You can 
type in month/date/year format (for exam-
ple, 8/21/96), or you can use a “-” offset 
based on today’s date (for example, -1 for 
yesterday).

• Select the information from the pull-down list 
of previously used items. During each CMS 
session, Supervisor recalls the items you have 
selected for each input field. You can use the 
pull-down list to select an item for the input 
field.

Use the Browse button to view all available 
items for the input field, and then select an 
item(s) for the input field. When you click on 
the Browse button, a window opens that lets 
you select items for the input field.

Times: Enter the period of time you would like the 
report to cover. To complete the input field, do 
the following:
• Type in the information requested. You can 

type in AM/PM format (for example, 
7:30AM-5:00PM), or you can use 24-hour for-
mat (for example, 7:30-17:00).

• Select the information from the pull-down list 
of previously used items. During each CMS 
session, Supervisor recalls the items you have 
selected for each input field. You can use the 
pull-down list to select an item for the input 
field.

Use the Browse button to view all available 
items for the input field, and then select an 
item(s) for the input field. When you click on 
the Browse button, a window opens that lets 
you select items for the input field.

Item Description
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Destination Choose a report destination. You can select 
View Report on Screen or Print Report on: and 
then use the Select Printer button to print the 
report on any Windows printer. The default 
printer is shown.

Item Description
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Report Heading Description
Database Item/ 
Calculation
Table Name

Date: The day for which the report was run 
(selected in the report input window).

syn(LOGID)
cagent

Start Time
(Interval)

The start time of the interval for which 
the data was collected. (This field 
displays only for the Interval report.)

STARTTIME

hsplit
Split/Skill 
ASA

The name or number of the split/skill you 
are currently viewing.

syn(SPLIT)
hsplit

Average Speed 
of Answer - 
Seconds

The value in seconds of the average speed 
of answer for the split/skill during the 
time period covered in the report.

<AVG_ANSWER_
SPEED>
hsplit
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Split/Skill—Graphical Call Profile Daily 16

This report shows how well the split or skill you specified performed 
compared to your call center’s predefined service levels for the date you 
specify. 

Things to Know About This Report 16

● You can access this report from the Historical Split/Skill Category 
selector menu.

● This report has four charts and displays a collection of split/skill call 
profile related data items at the top of the report. A legend appears to 
the right of each chart.

● The three-dimensional pie chart in the upper-left quadrant shows the 
percentage of ACD calls answered within the acceptable service level 
and the percentage of ACD calls answered outside this level. The 
numerical value represented by each pie piece is shown inside the pie 
chart.

● The horizontal bar chart in the lower-left quadrant shows the actual 
number of ACD calls answered within each service interval. The 
horizontal axis represents the number of calls answered or abandoned. 
The vertical axis represents the customer’s service intervals. For each of 
these intervals, two horizontal bars are displayed. One bar shows the 
number of abandoned calls and the other bar shows the number of 
answered ACD calls.

● The number displayed for each service interval is the upper limit of the 
interval. For example, if the first two intervals are “5” and “10,” the first 
data point on the chart indicates the number of calls answered/ 
abandoned within 0-5 seconds, and the second data point indicates the 
number of calls answered/abandoned within 6-10 seconds.

● The three-dimensional pie charts on the right side of the report show the 
Percentage Answered Distribution (upper right quadrant) and the 
Percentage Abandoned Distribution (lower right quadrant) for each 
service level increment. The numerical value represented by each pie 
piece is shown inside the pie chart.

● Other chart styles are available and can be changed. See the “Formatting 
Chart Reports” section in Chapter 4, “Reports Basics,” for more 
information.
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Input Window 16

Item Description

Split/Skill: Enter the name or number of the split/skill you 
want included in the report. You can enter a name 
only if it has been previously defined in the 
Dictionary subsystem. To complete the input field, 
do the following:

• Type in the information requested.
• Select the information from the pull-down list of 

previously used items. During each CMS ses-
sion, Supervisor recalls the items you have 
selected for each input field. You can use the 
pull-down list to select an item for the input 
field.

Use the Browse button to view all available items 
for the input field, and then select an item for the 
input field. When you click on the Browse button, 
a window opens that lets you select items for the 
input field

829.bk : historicalreports.fm  Page 18  Wednesday, November 20, 1996  3:09 PM



 Split/Skill—Graphical Call Profile Daily 16-19

Historical Reports

C
ha

pt
er

 1
6

Date: Enter the date for which the report will be run. To 
complete the input field, do the following:

• Type in the information requested. You can type 
in month/date/year format (for example, 
8/21/96), or you can use a “-” offset based on 
today’s date (for example, -1 for yesterday).

• Select the information from the pull-down list of 
previously used items. During each CMS ses-
sion, Supervisor recalls the items you have 
selected for each input field. You can use the 
pull-down list to select an item for the input 
field.

Use the Browse button to view all available items 
for the input field, and then select an item(s) for 
the input field. When you click on the Browse 
button, a window opens that lets you select items 
for the input field.

Destination Choose a report destination. You can select View 
Report on Screen or Print Report on: and then use 
the Select Printer button to print the report on any 
Windows printer. The default printer is shown.

Item Description
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Report 
Heading

Description
Database Item/ 
Calculation
Table Name

Date: The day for which the report was run 
(selected in the report input window).

ROW_DATE

ACD Calls: The number of calls answered within the 
split/skill for that day.

ACDCALLS
dsplit

Secs: The number of seconds defined by the 
customer as acceptable for answering calls.

SERVICELEVEL
dsplit

Split/Skill: The name or number of the split/skill. syn(SPLIT)
dsplit

Aban Calls: The number of split/skill calls abandoned for 
that day.

ABNCALLS
dsplit
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Acceptable 
Service 
Changed:

Shows whether or not the service level was 
changed.

A ”YES” appears if the acceptable service 
level changed during the period covered by 
the report. Otherwise, a “NO” appears.

SVCLEVELCHG

dsplit
Service 
Intervals 
Changed:

A “YES” appears if service intervals were 
changed during the period covered by the 
report.

PERIODCHG

dsplit
In Level Percentage of split/skill ACD calls that were 

answered by an agent within the predefined 
acceptable service level. Calls to the 
split/skill include abandoned calls, calls not 
answered, and outbound ACD calls placed 
by an adjunct (for example, outbound 
predictive dialing—Generic 2.2 switches 
with ASAI Gateway Interface feature or 
Generic 3 switches with the ASAI feature). 
Calls that were not answered may include 
forced busy calls, forced disconnect calls, 
calls redirected to another destination, and 
calls queued to more than one split and 
answered in another split/skill.
For Generic 3 switches, Percent Within 
Service Level does not include direct agent 
calls.

<PERCENT_
SERV_LVL_SPL>

dsplit

Report 
Heading

Description
Database Item/ 
Calculation
Table Name
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Outside Percentage of split/skill ACD calls that were 
answered by an agent within the predefined 
acceptable service level. Calls to the 
split/skill include abandoned calls, calls not 
answered, and outbound ACD calls placed 
by an adjunct. Outbound predictive dialing - 
Generic 2.2 switches with ASAI Gateway 
Interface feature or Generic 3 switches with 
the ASAI feature only. Calls that were not 
answered may include forced busy calls, 
forced disconnect calls, calls redirected to 
another destination, and calls queued to 
more than one split and answered in another 
split/skill.

For Generic 3 switches, Percent Within 
Service Level does not include direct agent 
calls.

<100-
PERCENT_SERV
_LVL_SPL>

dsplit
ACD Calls Graphically displays the distribution of all of 

the incoming calls that were answered 
within each of the defined service levels.

ACDCALLS1-10

dsplit
Aban Calls Graphically displays the distribution of all of 

the incoming calls that were abandoned 
within each of the defined service levels.

ABNCALLS1-10

dsplit

Report 
Heading

Description
Database Item/ 
Calculation
Table Name
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Split/Skill—Graphical Service Level Interval 16

This report shows the percentage of ACD calls answered within the 
predefined acceptable service level and the percentage of ACD calls 
abandoned for the date and split or skill you specify. 

Things to Know About This Report 16

● You can access this report from the Historical Split/Skill Category 
selector menu.

● The chart type can be changed. See the “Formatting Chart Reports” 
section in Chapter 4, “Reports Basics,” for more information.

● Each set of vertical bars is labeled with the start time for the service 
interval. The box below the chart is a legend.

829.bk : historicalreports.fm  Page 23  Wednesday, November 20, 1996  3:09 PM



16-24 Split/Skill—Graphical Service Level Interval

Historical Reports

Input Window 16

Item Description

Split/Skill: Enter the name or number of the split/skill you want 
included in the report. You can enter a name only if it 
has been previously defined in the Dictionary 
subsystem. To complete the input field, do the 
following:

• Type in the information requested.
• Select the information from the pull-down list of pre-

viously used items. During each CMS session, Super-
visor recalls the items you have selected for each 
input field. You can use the pull-down list to select an 
item for the input field.

Use the Browse button to view all available items for 
the input field, and then select an item for the input 
field. When you click on the Browse button, a window 
opens that lets you select items for the input field.
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Date: Enter the date for which the report will be run. To 
complete the input field, do the following:

• Type in the information requested. You can type in 
month/date/year format (for example, 8/21/96), or 
you can use a “-” offset based on today’s date (for 
example, -1 for yesterday).

• Select the information from the pull-down list of pre-
viously used items. During each CMS session, Super-
visor recalls the items you have selected for each 
input field. You can use the pull-down list to select an 
item for the input field.

• Use the Browse button to view all available items for 
the input field, and then select an item(s) for the 
input field. When you click on the Browse button, a 
window opens that lets you select items for the input 
field.

Times: Enter the period of time that you would like the report 
to cover. To complete the input field, do the following:

• Type in the information requested. You can type in 
AM/PM format (for example, 7:30AM-5:00PM), or 
you can use 24-hour format (for example, 7:30-17:00).

• Select the information from the pull-down list of pre-
viously used items. During each CMS session, Super-
visor recalls the items that you selected for each input 
field. You can use the pull-down list to select an item 
for the input field.

• Use the Browse button to view all available items for 
the input field, and then select an item(s) for the 
input field. When you click on the Browse button, a 
window opens that lets you select items for the input 
field.

Destination Choose a report destination. You can select View Report 
on Screen or Print Report on: and then use the Select 
Printer button to print the report on any Windows 
printer. The default printer is shown.

Item Description
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Report Example 16

Report Heading Description
Database Item/ 
Calculation
Table Name

Date: The day for which the report was run 
(selected in the report input window).

ROW_DATE

Secs.: Shows actual administered service 
level.

SERVICELEVEL
hsplit

Split/Skill: The name or number of the split/skill 
that you are currently viewing.

syn(SPLIT)
hsplit
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Acceptable 
Service Changed:

Shows whether or not the service level 
was changed.

A ”YES” appears if the acceptable 
service level changed during the period 
covered by the report. Otherwise, a 
“NO” appears.

SVCLEVELCHG

hsplit
% Within Service 
Level

Percentage of ACD calls that were 
answered by an agent within the 
predefined acceptable service level for 
the time period shown in the report.

<PERCENT_SER
V_LVL_SPL>

hsplit
% Aban Calls Percentage of ACD calls that were 

abandoned for the time period shown 
in the report.

<PERCENT_
CALL_ABAN>
hsplit

Report Heading Description
Database Item/ 
Calculation
Table Name
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Split/Skill—Graphical Time Spent Daily 16

This report shows how much time the agents staffed in the specified split or 
skill spent in each work state. It also shows the composite time spent in the 
AUX work state for each of the reason codes defined for this call center.

Things to Know About This Report 16

● Call center supervisors can use this report to estimate how much time 
agents in this split/skill spent on ACD calls, in available state, in ACW, 
in AUX, etc. for a particular day. This report enables supervisors to tell 
how much time the agents in this split/skill spent in AUX work state for 
each of the reason codes defined for this call center.

● You can access this report from the Historical Split/Skill Category 
selector menu.

● This report displays a three-dimensional pie chart that shows the 
percentage of time (in hours and minutes) that the agent spent in each 
work state.

— By default, the percentage is shown inside of each section of the pie 
chart.

— A legend displays a different color for each of the agent work states 
(dictionary-defined synonym for each work state).

● This report displays a three-dimensional pie chart that shows the reason 
codes for the time that the agent spent in AUX work mode. This half of 
the report contains data available only with ECS switches with EAS.

— The percentage of AUX time (in hours and minutes) agents spent in 
AUX for each reason code is displayed inside the slice of the pie 
chart.

— A legend to the right of the pie chart shows a different color for each 
of the reason codes. This legend contains the dictionary-defined 
reason codes or numbers (if the reason codes have not been defined 
in Dictionary). See Chapter 5, “Reports,” for more information.
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Input Window 16

Item Description

Split/Skill: Enter the name or number of the split/skill that you 
want included in the report. You can enter a name only 
if it has been previously defined in the Dictionary 
subsystem. To complete the input field, do the 
following:
• Type in the information requested.
• Select the information from the pull-down list of pre-

viously used items. During each CMS session, Super-
visor recalls the items you have selected for each 
input field. You can use the pull-down list to select 
an item for the input field.

Use the Browse button to view all available items for 
the input field, and then select an item for the input 
field. When you click on the Browse button, a window 
opens that lets you select items for the input field.
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Date: Enter the date for which the report will be run. To 
complete the input field, do the following:

• Type in the information requested. You can type in 
month/date/year format (for example, 8/21/96), or 
you can use a “-” offset based on today’s date (for 
example, -1 for yesterday).

• Select the information from the pull-down list of pre-
viously used items. During each CMS session, Super-
visor recalls the items you have selected for each 
input field. You can use the pull-down list to select 
an item for the input field.

• Use the Browse button to view all available items for 
the input field, and then select an item(s) for the 
input field. When you click on the Browse button, a 
window opens that lets you select items for the input 
field.

Destination Choose a report destination. You can select View 
Report on Screen or Print Report on: and then use the 
Select Printer button to print the report on any 
Windows printer. The default printer is shown.

Item Description

829.bk : historicalreports.fm  Page 30  Wednesday, November 20, 1996  3:09 PM



 Split/Skill—Graphical Time Spent Daily 16-31

Historical Reports

C
ha

pt
er

 1
6

Report Example 16

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Split/Skill: The name or number of the split/skill you 
are currently viewing.

syn(SPLIT)
hsplit

Date: The day for which the report was run 
(selected in the report input window).

ROW_DATE

AVAIL The time during the collection interval 
that POSITIONS were available for calls 
from this split/skill.

I_AVAILTIME

dsplit
ACW The time during the collection interval 

that POSITIONS were in AUX in this 
split/skill. This includes I_AUXINTIME 
and I_AUXOUTTIME.

<I_ACWTIME>

dsplit
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RING The time during the collection interval 
that agents were in the ringing state for 
calls to this split/skill. If the agent 
changes work modes or answers/makes 
another call instead of answering the 
ringing call, I_RINGTIME will stop 
accumulating. RINGTIME is the time that 
the caller spends ringing and is 
independent of agent activity. 

I_RINGTIME

dsplit
ACD The time during the collection interval 

that POSITIONS were on split/skill ACD 
calls for this split/skill. 

<I_ACDTIME>

dsplit
AUX The time during the collection interval 

that POSITIONS are in AUX in this 
split/skill. 

I_AUXTIME

dsplit
OTHER The time during the collection interval 

that POSITIONS were doing other work. 
I_OTHERTIME
dsplit

Reason 

Code 0

The time during the collection interval 
that POSIITONS were in AUX for reason 
code 0 in this split/skill. This includes 
time on extension calls from this AUX 
state. 
For switches with AUX reason codes 
active, this represents the time agents 
spent in “system” AUX. 

For switches without AUX reason codes 
active, I_AUXTIME0 is the same as 
I_AUXTIME.

I_AUXTIME0

dsplit
Reason Code 
1-9

The time during the collection interval 
that POSITIONS were in AUX for each 
reason code 1-9 in this skill. This includes 
the time on extension calls from each 
AUX state.

I_AUXTIME1-9

dsplit

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Historical VDN Category Tab 16

The following is an example of the reports that may be available in the VDN 
Category on the Historical tab depending on your switch type and whether 
you have purchased the EAS or Vectoring feature.
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VDN—Graphical Call Profile 16

This report shows how calls to the VDN you specify are being handled 
compared to your call center’s predefined acceptable service level for the 
date you specify. By default, the report appears as shown below. However, 
the chart type can be changed. 

Things to Know About This Report 16

● You can access this report from VDN Category report list on the Report 
Selector window’s Historical tab.

● This report has four charts and displays a collection of VDN call profile 
related data items at the top of the report. A legend appears to the right 
of each chart.

● The three-dimension pie chart in the upper-left quadrant shows the 
percentage of ACD calls answered within the predefined acceptable 
service level and the percentage of ACD calls answered outside this 
level. The numerical value represented by each pie piece is shown inside 
the pie chart.

● The stacked area graph in the lower-left quadrant shows the number of 
ACD calls to the VDN which were answered and abandoned within 
each service interval.

● The number displayed for each service interval is the upper limit of the 
interval. For example, if the first two intervals are “5” and “10,” the first 
data point on the chart indicates the number of calls answered/ 
abandoned within 0-5 seconds, and the second data point indicates the 
number of calls answered/abandoned within 6-10 seconds.

● The three-dimension pie charts on the right side of the report show the 
Percentage Answered Distribution and the Percentage Abandoned 
Distribution. The numerical value represented by each pie piece is 
shown inside the pie chart.

● The chart type can be changed. See the “Formatting Chart Reports” 
section in Chapter 4, “Reports Basics,” for more information.
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Input Window 16

Item Description

VDN: Enter the name or number of the VDN that you want 
included in the report. You can enter a name only if it 
has been previously defined in the Dictionary 
subsystem. To complete the input field, do the 
following:
• Type in the information requested.
• Select the information from the pull-down list of pre-

viously used items. During each CMS session, Super-
visor recalls the items you have selected for each 
input field. You can use the pull-down list to select 
an item for the input field.

• Use the Browse button to view all available items for 
the input field, and then select an item for the input 
field. When you click on the Browse button, a win-
dow opens that lets you select items for the input 
field.
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Date: Enter the date for which the report will be run. To 
complete the input field, do the following:

• Type in the information requested. You can type in 
month/date/year format (for example, 8/21/96), or 
you can use a “-” offset based on today’s date (for 
example, -1 for yesterday).

• Select the information from the pull-down list of pre-
viously used items. During each CMS session, Super-
visor recalls the items you have selected for each 
input field. You can use the pull-down list to select 
an item for the input field.

• Use the Browse button to view all available items for 
the input field, and then select an item(s) for the 
input field. When you click on the Browse button, a 
window opens that lets you select items for the input 
field.

Destination Choose a report destination. You can select View 
Report on Screen or Print Report on: and then use the 
Select Printer button to print the report on any 
Windows printer. The default printer is shown.

Item Description
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Report Example 16

Report Heading Description
Database Item/ 
Calculation
Table Name

Date: The day for which the report was run 
(selected in the report input window).

ROW_DATE

VDN: The number or name of the VDN for 
which the report shows data (selected in 
the report input window).

VDN or 
syn(VDN)
dvdn
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ACD Calls: The total number of calls answered within 
the split/skill for that day.

ACDCALLS
dvdn

Aban Calls: The total number of split/skill calls 
abandoned for that day.

ABNCALLS
dvdn

Secs.: Shows administered acceptable service 
level.

SERVICELEVE
L

Acceptable 
Service Changed

Shows whether or not the service level 
was changed.
A ”YES” appears if the acceptable service 
level changed during the period covered 
by the report. Otherwise, a “NO” appears.

SVCLEVELCH
G

dvdn

Service Intervals 
Changed

A ”YES” appears if the service intervals 
increments changed during the period 
covered by the report. Otherwise, a “NO” 
appears.

PERIODCHG

dvdn
Service Interval 
Calls Answered

The number of calls that, while connected 
to this VDN, were answered by an agent 
or were connected to a non-ACD 
destination within each of the service 
level increments. With Generic 2.2 and 
Generic 3 switches, connected means calls 
that were answered at a non-ACD 
destination. With Generic 2.1 and System 
85 switches, connected means calls that 
rang at a non-ACD destination.

sum 
(ANSCONNCA
LLS1), sum 
(ANSCONNCA
LLS2 
through 10)

dvdn
In Level The percentage of calls to the VDN that 

were answered/connected within the 
service level (specified in the VDN Call 
Profile Setup window). For Generic 3 
switches, Percent Within Service Level 
does not include direct agent calls.

<PERCENT_
SERV_LVL_
VDN>

dvdn

Report Heading Description
Database Item/ 
Calculation
Table Name
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Outside The percentage of VDN calls that were 
not answered by an agent within the 
predefined acceptable service level. Calls 
that were not answered may include 
forced busy calls, forced disconnect calls, 
calls redirected to another destination, 
and calls queued to more than one VDN 
and answered in another VDN.

<100 - 
PERCENT_
SERV_LVL_
VDN>

dvdn
ACD + Conn 
Calls

The number of calls to the VDN that were 
answered by an agent or connected to a 
non-ACD destination within each of the 
service level increments. Calls in each 
increment are represented by color-
coded area (see legend).

ANSCONNCA
LLS1 through 10

dvdn
Aban Calls The number of calls to the VDN that were 

abandoned within each of the service 
level increments. Calls in each increment 
are represented by color-coded area (see 
chart legend) that change color when an 
upper or lower threshold is reached. For 
Generic 2.2 and all Generic 3 switches, 
this is all VDN calls abandoned. With 
Generic 2.1 and System 85 switches, this is 
ACD calls abandoned.

ABNCALLS1-10

dvdn
Service Interval 
- seconds

The lower and upper limit in seconds of 
each service level increment (as defined in 
the VDN Call Profile Setup window). 
These increments represent progressively 
longer wait time segments in which calls 
may be answered or abandoned.

PERIOD1-9

dvdn
% Answered 
Distribution

A chart displaying the distribution of the 
percent of calls answered for the day 
across all intervals.

None.

% Abandoned 
Distribution

A chart displaying the distribution of the 
percent of calls abandoned for the day 
across all intervals.

None.

Report Heading Description
Database Item/ 
Calculation
Table Name
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VDN—Graphical Service Level 16

This report shows the percentage of ACD calls answered within the 
predefined acceptable service level and the percentage of ACD calls 
abandoned for the date and VDN that you specify. 

Things to Know About This Report 16

● The chart type can be changed. See the “Formatting Chart Reports” 
section in Chapter 4, “Reports Basics,” for more information.

● Each set of vertical bars is labeled with the start time for the service 
interval. The legend appears below the chart.
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Input Window 16

Item Description

VDN: Enter the name or number of the VDN that you want 
included in the report. You can enter a name only if it 
has been previously defined in the Dictionary 
subsystem. To complete the input field, do the 
following:

• Type in the information requested.
• Select the information from the pull-down list of pre-

viously used items. During each CMS session, Super-
visor recalls the items that you selected for each input 
field. You can use the pull-down list to select an item 
for the input field.

• Use the Browse button to view all available items for 
the input field, and then select an item for the input 
field. When you click on the Browse button, a win-
dow opens that lets you select items for the input 
field.
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Date: Enter the date for which the report will be run. To 
complete the input field, do the following:

• Type in the information requested. You can type in 
month/date/year format (for example, 8/21/96), or 
you can use a “-” offset based on today’s date (for 
example, -1 for yesterday).

• Select the information from the pull-down list of pre-
viously used items. During each CMS session, Super-
visor recalls the items you have selected for each 
input field. You can use the pull-down list to select an 
item for the input field.

• Use the Browse button to view all available items for 
the input field, and then select an item(s) for the 
input field. When you click on the Browse button, a 
window opens that lets you select items for the input 
field.

Times: Enter the period of time you would like the report to 
cover. To complete the input field, do the following:

• Type in the information requested. You can type in 
AM/PM format (for example, 7:30AM-5:00PM), or 
you can use 24-hour format (for example, 7:30-17:00).

• Select the information from the pull-down list of pre-
viously used items. During each CMS session, Super-
visor recalls the items you have selected for each 
input field. You can use the pull-down list to select an 
item for the input field.

• Use the Browse button to view all available items for 
the input field, and then select an item(s) for the 
input field. When you click on the Browse button, a 
window opens that lets you select items for the input 
field.

Destination Choose a report destination. You can select View 
Report on Screen or Print Report on: and then use the 
Select Printer button to print the report on any 
Windows printer. The default printer is shown.

Item Description
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Report Example 16

Report Heading Description
Database Item/ 
Calculation
Table Name

Date: The day for which the report was run 
(selected in the report input window).

ROW_DATE

VDN: The number or name of the VDN for 
which the report shows data (selected in 
the report input window).

VDN

hvdn
Seconds Shows actual administered service level. SERVICELEVEL
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Acceptable 
Service 
Changed

Shows whether or not the service level 
was changed.

A ”YES” appears if the acceptable service 
level changed during the period covered 
by the report. Otherwise, a “NO” 
appears.

SVCLEVELCHG

hvdn
% Calls Y-axis. Shows increments of zero to one 

hundred, representing the possible 
percentages.

None.

% Within 
Service Level

The percentage of incoming calls to the 
VDN that were answered by a measured 
agent or connected to a non-ACD 
destination within the service level (as 
specified in the VDN Call Profile Setup 
window). Data are for each specified 
intrahour interval or day (selected in the 
report input window).

<PERCENT_
SERV_LVL_
VDN>

hvdn
% Aban Calls The percentage of incoming calls that 

were abandoned in the VDN.
<PERCENT_
VDN_ABAN>
hvdn

Report Heading Description
Database Item/ 
Calculation
Table Name
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Introduction 17

This chapter includes the following sections:

● About Integrated Reports

● Agent—Graphical Information

● Agent—Information

● Split/Skill—Comparison Report

● Split/Skill—Graphical Split/Skill View

● VDN—Graphical Call Handling.

829.bk : integratedreports.fm  Page 1  Wednesday, November 20, 1996  3:09 PM



17-2 About Integrated Reports

Integrated Reports

About Integrated Reports 17

There are a series of Integrated Supervisor reports that are available only 
when you are using the Supervisor application (they are not available 
through Terminal or standard CMS).

Only reports that are available exclusively through Supervisor are described 
in this chapter. For descriptions of CMS reports that are not described in this 
chapter, see the CentreVu CMS Real-Time and Historical Reports document 
(585-215-821).

An Integrated report combines real-time and historical data for a current 
view of the day. For general information about Integrated reports, see 
Chapter 4, “Reports Basics” and Chapter 5, “Reports.” 

The Integrated reports are identified in the following table:

Category Report Name

R
ea

l-T
im

e 

H
is

to
ric

al

In
te

gr
at

ed

Agent Graphical Information ❏ ❏

Information ❏ ❏

Split/Skill Comparison ❏

Graphical ASA ❏

Graphical AUX Agents ❏

Graphical AUX Top Agents ❏

Graphical Call Profile ❏ ❏

Graphical EWT ❏

Graphical Queue ❏

Graphical Service Level ❏

Graphical Skill Time Spent ❏

Graphical Split/Skill View ❏

Graphical Status ❏

Graphical Time Spent ❏

Graphical Top Skill Status ❏

Top Agent Work State ❏

Work State Report ❏
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VDN Graphical Call Handling ❏

Graphical Call Profile ❏ ❏

Graphical Service Level ❏

Note  “Graphical ....” reports may not be available on the Real-Time 
Report tab if they are not valid for your switch type or the features 
you purchased.

Category Report Name

R
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l-T
im

e 

H
is

to
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gr
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Integrated Agent Category Tab 17

The following is an example of the reports that may be available in the 
Agent Category from the Integrated Report tab depending on your switch 
type and whether you have purchased the EAS or Vectoring feature.
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Agent—Graphical Information 17

This report shows information and statistics for an agent for a specified start 
time. 

Things to Know About This Report 17

● You can access this report in the following ways:

— From the Integrated Agent Category selector menu.

— By drilling down to this report from the Agent Name or Login ID 
fields on other reports (for example, Work State or Graphic AUX 
Agent reports).

● This report is available in two forms: 

— Generic 3 Version 5 switches with the EAS feature

— Pre-Generic 3 Version 5 switches with the EAS feature.

● This report is available for all switch releases. The contents of this report 
depend upon the switch release for which it is being run.

● Supervisors can use this report to access further information on one 
particular agent without having to execute several steps and several 
different reports to get the pertinent information. This report enables 
supervisors to quickly decide whether an agent should be added to or 
removed from a skill.

● The following example of this report shows the information it will 
contain for the DEFINITY® Enterprise Communications Server (ECS) 
Release 5 switch:

— Graphical information: a two-dimensional bar chart that shows the 
time the agent has spent in each of the work states since the report 
data start time.

Above the bar chart is the text “Agent Time Spent.”

Note If you are using a switch that does not have the EAS feature, see 
the “Agent—Information” report in this chapter for details.
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— Grid information: a grid that shows the skills which are assigned to 
the agent, and the corresponding skill level.

A scroll bar is provided if the number of skills to which the agent is 
assigned exceeds the default size of this grid.
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Input Window 17

Item Description

Agent: Enter the name of the agent. The agent’s name must be 
defined in the Dictionary subsystem; otherwise, you 
will see the agent IDs.

Report Data 
Start Time:

Enter the day and time (either in military time or with 
AM/PM specified) you want the report to start 
collecting data. The time entered (or the time adjusted to 
the nearest previous interval start time relative to the 
entered time) is used to populate the Report Data Start 
Time field on the report.
NOTE: If no report start time is available, the start time 
will be midnight of the current day. The report start 
time must be less than 24 hours before the current time.
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Refresh Every 
<#> Seconds

Enter the number of seconds (3 to 600) to specify how 
rapidly CentreVu CMS should update the report data.

The default for the Refresh rate in seconds: field in this 
window is your assigned minimum refresh rate plus 15 
seconds. To find out what your minimum refresh rate is, 
or to change it, check with your CentreVu CMS 
administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the report. 
For more information, see the “Setting Report threshold 
Highlights” section in Chapter 5, “Reports.”

Run Minimized Check this box to minimize the report. 

Item Description
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Report Example 17

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Report Data 
Start Time:

The day and time that the report started 
collecting data.

No database item.

Agent: The names (or agent IDs if the names have 
not been assigned in Dictionary) of the 
agents assigned and logged into this 
split/skill.

syn(LOGID)

cagent
Login ID: The login identification of the agent. LOGID

cagent
Extn: The extension that the agent logged in 

from.
EXTENSION
cagent
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State: The current work mode (state) that the 
agent is in (AVAIL, ACD, ACW, AUX, 
DACD, DACW, RING, UNKNOWN, 
OTHER, UNSTAFF) and the call direction 
(blank, IN or OUT).

syn(AWORKMODE) 
and 
syn(DIRECTION)

cagent
Time: The time that the agent has been in the 

current work mode (AVAIL, ACD, etc.) 
and the call direction. Time is reset 
whenever the work mode or call direction 
changes. For example, if the agent goes 
from AUX-IN to AUX, the time starts over.

AGTIME

cagent
Active 
Split/Skill:

When an agent is on a split/skill or direct 
agent ACD call or in ACW, this is the 
split/skill associated with the call or 
ACW. When an agent is available, in AUX 
or in OTHER, this is null (blank). 

When an agent is on an 
AUXIN/AUXOUT call, this is the 
OLDEST_LOGON split/skill.
When an agent is on an 
AUXIN/AUXOUT call from the available 
state, while in AUX or with an 
AUXIN/AUXOUT call on hold, this is the 
OLDEST_LOGON split/skill. 

When an agent is on an AUXIN call with 
an ACD call on hold, this is the OLDEST_
LOGON split/skill.
When an agent is on an AUXOUT call 
with an ACD call on hold, this is the 
split/skill associated with the ACD call.

syn(WORKSKILL)

cagent
AUX Reason: The reason code associated with the agent 

current state. This is blank if the agent is 
not in the AUX state. For agents in AUX 
on switch releases that are earlier than the 
ECS or that do not have EAS and reason 
codes active, this will only be 0 (zero).

syn(AUXREASON)

cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Top Skill: The agent’s first-administered, highest-
level, measured skill, where skill level 1 is 
the highest, and skill level 16 is the lowest.

syn(TOPSKILL)

cagent
Call 
Handling 
Preference:

The agent’s call handling preference. 
Values are blank, skill level (LVL) or 
greatest need (NEED).

syn(PREFERENCE)

cagent
ACD Calls: The queued ACD calls to the split/skill 

that were answered by an agent in the 
split/skill. This does not include direct 
agent calls, but it does include ACD calls 
placed by an adjunct (outbound predictive 
dialing - Generic 2.2 switches with ASAI 
Gateway or Generic switches with ASAI 
only).

sum(ACDCALLS)

hagent, cagent
Login Time: The time of the day that the agent logged 

into this SPLIT. This field is not set unless 
the agent is logged in. Values include 
NULL and time-of-day.

LOGONSTART

cagent
Move 
Pending?:

A move to a new split or skill or a change 
of skills is pending for this agent. This is 
available only for Generic 3 Version 4 and 
later switch releases with the “Move 
Agent While Staffed” feature.

MOVEPENDING

cagent
Direct Agent 
Skill:

The skill that is currently assigned as the 
agent’s direct agent skill. Direct agent calls 
to the agent are queued to this skill. 

syn(DA_SKILL)

cagent
Direct Agent 
Calls:

The number of direct agent ACD calls that 
the agent answered.

DA_ACDCALLS
cagent

Split/Skill: The split/skill number for which the data 
was collected.

syn(SPLIT)
cagent

Level: The skill level (1-16) that is associated with 
the SPLIT.

LEVEL
cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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AVAIL The time during the collection interval 
that the agent was in the available state for 
split/skill or direct agent ACD calls in any 
split/skill. TI_AVAILTIME is recorded for 
the split/skill that was the 
OLDEST_LOGON.

For non-EAS operation, if an agent logged 
into multiple splits in AUX mode in one 
split and is available for ACD calls in 
another split. The agent accrues 
I_AVAILTIME for the split in which the 
agent is available and TI_AVAILABLE in 
the split logged into the longest.

sum(TI_AVAILTIME
)

hagent, cagent
ACD The time during the collection interval 

that the agent was talking on ACD calls 
for the SPLIT.

sum(I_ACDTIME+
I_DA_ACDTIME)
hagent, cagent

ACW The total time during the collection 
interval that the agent was in after call 
work (ACW). This includes ACW for 
split/skill ACD calls and ACW not 
associated with the call.

sum(I_ACWTIME+
I_DA_ACWTIME)

hagent, cagent
AUX The time during the collection interval 

that the agent was in AUX in all 
splits/skills or on AUXINCALLS or 
AUXOUTCALLS. “TI__” stands for the 
time that is stored for the split/skill 
logged into the longest. 

sum(TI_AUXTIME)

hagent, cagent
RING The time during the collection interval 

that the agent had split/skill and direct 
agent ACD calls ringing. If the agent 
changes work modes or answers/makes 
another call instead of answering the 
ringing call, I_RINGTIME will stop 
accumulating. RINGTIME is the time the 
caller spends ringing and is independent 
of agent activity.

sum(I_RINGTIME)

hagent, cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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OTHER The time during the collection interval 
that the agent was doing other work in all 
splits/skills. 

For Generic 3 switches, while in Auto-in 
or Man-In: the agent put any call on hold 
and performed no further action, the agent 
dialed to place a call or to activate a 
feature, or an extension call rang with no 
other activity.
For Generic 2.2, the agent pushed the 
Hold button or flashed the switchhook 
from Auto-in or Manual-in mode and 
performed no further action.

For all switches, TI_OTHERTIME is 
collected for the time period after the link 
to the switch comes up or after the agent 
logs in and before the CMS receives 
notification of the agent’s state from the 
switch.

sum(TI_OTHERTIM
E)

hagent, cagent
Staffed 
Time:

The time during the collection interval 
that the agent was staffed in any 
split/skill. The “TI_” stands for the time 
that is stored only for the split or skill that 
the agent is logged into for the longest 
amount of time.

sum(TI_STAFFTIME)

hagent, cagent
AUX Time: The time during the collection interval 

that the agent was in AUX in all 
splits/skills or on AUXINCALLS or 
AUXOUTCALLS. The “TI_” stands for the 
time that is stored only for the split or skill 
that the agent is logged into for the longest 
amount of time.

sum(TI_AUXTIME)

hagent, cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Reason Code The time that the agent spent in active 
AUX reason codes. It is the same as 
TI_AUXTIME for switches without AUX 
reason codes active. The “TI_” stands for 
the time that is stored only for the skill 
that the agent is logged into for the longest 
amount of time.

sum(TI_AUXTIME0)

hagent, cagent
Reason Code The time that the agent spent in AUX with 

each of the reason codes 1-9.The “TI_” 
stands for the time that is stored only for 
the skill that the agent is logged into for 
the longest amount of time. 

sum(TI_AUXTIME1 
through 9)

hagent, cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Agent—Information 17

This version of the Agent Information report shows information and 
statistics for an agent for a specified start time. 

Things to Know About This Report 17

● This report is not available with the EAS feature.

● You can access this report as follows:

— From the Integrated Agent Category selector menu.

— By drilling down to this report from the Agent Name or Login ID 
fields on other reports (for example, Agent Information, Work State, 
or Graphic AUX Agent reports).

● Drilling down to this report gives the user the ability to select a real-time 
or integrated version of a drill-down report.

● When a Supervisor user drills down from an agent name to an Agent 
Information report and selects an integrated report, the report data start 
time defaults to the start time specified in the last integrated report 
input window. If no integrated report has ever been entered, the default 
is set to midnight. You have the ability to restart this report just as any 
other Supervisor report can be restarted, and a different report start time 
can be specified when the report is restarted.
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Input Window 17

Field Description

Agent: Enter the name of the agent assigned to the split and 
logged in. The agent’s name must be defined in the 
Dictionary subsystem; otherwise, you will see the agent 
IDs.

Report Data 
Start Time

Enter the day and time (either in military time or with 
AM/PM specified) you want the report to start 
collecting data. The time entered (or the time adjusted to 
the nearest previous interval start time relative to the 
entered time) is used to populate the Report Data Start 
Time field on the report.
NOTE: If no report start time is available, the start time 
will be midnight of the current day. The report start 
time must be less than 24 hours before the current time.
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Refresh Every 
<#> Seconds

Enter the number of seconds (3 to 600) to specify how 
rapidly CentreVu CMS should update the report data.

The default for the Refresh rate in seconds: field in this 
window is your assigned minimum refresh rate plus 15 
seconds. To find out what your minimum refresh rate is, 
or to change it, check with your CentreVu CMS 
administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the report. 
For more information, see the “Setting Report threshold 
Highlights” section in Chapter 5, “Reports.”

Run Minimized Check this box to minimize the report. 

Field Description
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Report Example 17

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Report 
Data Start 
Time:

The day and time that the report started 
collecting data.

No database item.

Agent: The names (or agent IDs if the names have 
not been assigned in Dictionary) of the 
agents assigned and logged into this 
split/skill.

syn(LOGID)

Login ID: The login identification of the agent. LOGID
cagent

Extn: The extension that the agent logged in 
from.

EXTENSION
cagent

State: The current work mode (state) that the 
agent is in (AVAIL, ACD, ACW, AUX, 
DACD, DACW, RING, UNKNOWN, 
OTHER, UNSTAFF) and the call direction 
(blank, IN or OUT).

syn(AWORKMODE) 
and 
syn(DIRECTION)

cagent
Time: The time that the agent has been in the 

current work mode (AVAIL, ACD, etc.) 
and the call direction. Time is reset 
whenever the work mode or call direction 
changes. For example, if the agent goes 
from AUX-IN to AUX, the time starts over.

AGTIME

cagent

829.bk : integratedreports.fm  Page 18  Wednesday, November 20, 1996  3:09 PM



 Agent—Information 17-19

Integrated Reports

C
ha

pt
er

 1
7

Active Split: When an agent is on a split or direct agent 
ACD call or in ACW, this is the split 
associated with the call or ACW. When an 
agent is available, in AUX or in OTHER, 
this is null (blank). 

When an agent is on an 
AUXIN/AUXOUT call, this is the 
OLDEST_LOGON split.
When an agent is on an 
AUXIN/AUXOUT call from the available 
state, while in AUX or with an 
AUXIN/AUXOUT call on hold, this is the 
OLDEST_LOGON split/skill. 

When an agent is on an AUXIN call with 
an ACD call on hold, this is the OLDEST_ 
LOGON split.
When an agent is on an AUXOUT call 
with an ACD call on hold, this is the split 
associated with the ACD call.

syn(WORKSKILL)

cagent
ACD Calls: The queued ACD calls to the split/skill 

that were answered by an agent in the 
split/skill. This does not include direct 
agent calls, but it does include ACD calls 
placed by an adjunct (outbound 
predictive dialing - Generic 2.2 switches 
with ASAI Gateway or Generic switches 
with ASAI only).

sum(ACDCALLS)

hagent, cagent
Move 
Pending?:

A move to a new split or skill or a change 
of skills is pending for this agent. This is 
available only for Generic 3 Version 4 and 
later switch releases with the “Move 
Agent While Staffed” feature.

MOVEPENDING

hagent, cagent
Direct 
Agent Calls:

The number of direct agent ACD calls that 
the agent answered.

sum(DA_ACDCALLS)
hagent, cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Staffed 
Time:

Current number of top agents that are 
staffed in the skill.

sum(TI_STAFFTIME)
hagent, cagent

AVAIL The time during the collection interval 
that the agent was in the available state 
for split/skill or direct agent ACD calls in 
any split/skill. TI_AVAILTIME is 
recorded for the split/skill that was the 
OLDEST_LOGON.

For non-EAS operation, if an agent logged 
into multiple splits in AUX mode in one 
split and is available for ACD calls in 
another split. The agent will accrue 
I_AVAILTIME for the split in which the 
agent is available and TI_AVAILABLE in 
the split logged into the longest.

sum(TI_AVAILTIME
)

hagent, cagent
ACD The time during the collection interval 

that the agent was talking on ACD calls 
for the SPLIT.

sum(I_ACDTIME+
I_DA_ACDTIME)
hagent, cagent

ACW The time during the collection interval 
that the agent was in after call work 
(ACW). This includes ACW for split/skill 
ACD calls and ACW not associated with 
the call.

sum(I_ACWTIME+
I_DA_ACWTIME)

hagent, cagent
AUX The time during the collection interval 

that the agent was in AUX in all 
splits/skills or on AUXINCALLS or 
AUXOUTCALLS. The “TI_” stands for 
the time that is stored only for the split or 
skill that the agent is logged into for the 
longest amount of time.

sum(TI_AUXTIME)

hagent, cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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RING The time during the collection interval 
that the agent had split/skill and direct 
agent ACD calls ringing. If the agent 
changes work modes or answers/makes 
another call instead of answering the 
ringing call, I_RINGTIME will stop 
accumulating. RINGTIME is the time the 
caller spends ringing and is independent 
of agent activity.

sum(I_RINGTIME)

hagent, cagent
OTHER The time during the collection interval 

that the agent was doing other work in all 
splits/skills. 

For Generic 3 switches, while in Auto-in 
or Man-In: the agent put any call on hold 
and performed no further action, the 
agent dialed to place a call or to activate a 
feature, or an extension call rang with no 
other activity.
For Generic 2.2, the agent pushed the 
Hold button or flashed the switchhook 
from Auto-in or Manual-in mode and 
performed no further action.

For all switches, TI_OTHERTIME is 
collected for the time period after the link 
to the switch comes up or after the agent 
logs in and before the CMS receives 
notification of the agent’s state from the 
switch.

sum(TI_OTHERTIM
E)

cagent
Staffed 
Split(s)

The split number for which the data was 
collected.

syn(SPLIT)
cagent

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Integrated Split/Skill Category Tab 17

The following is an example of the reports that may be available in the 
Split/Skill Category from the Integrated Report tab depending on your 
switch type and whether you have purchased the EAS or Vectoring feature.
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Split/Skill—Comparison Report 17

This report shows the current status and cumulative data for one or more 
splits/skills.

Things to Know About This Report 17

● Call center supervisors or administrators who are responsible for 
several splits/skill, can use this report to see if splits/skills have 
comparable talk times, abandon rates, and average speed of answer 
figures that are comparable up until a certain point in the day.

● You can access this report from the Integrated Split/Skill Category 
selector menu.
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Input Window 17

Field Description

Split/Skill Enter the appropriate split/skill name(s). Any name 
you want to appear on the report must have been 
previously defined and entered in the Dictionary 
subsystem.

Report Data 
Start Time:

Enter the day and time (either in military time or with 
AM/PM specified) you want the report to start 
collecting data. The time entered (or the time adjusted 
to the nearest previous interval start time relative to the 
entered time) is used to populate the Report Data Start 
Time field on the report.

NOTE: If no report start time is available, the start time 
will be midnight of the current day. The report start 
time must be less than 24 hours before the current time.
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Refresh Every 
<#> Seconds

Enter the number of seconds (3 to 600) to specify how 
rapidly CentreVu CMS should update the report data.

The default for the Refresh rate in seconds: field in this 
window is your assigned minimum refresh rate plus 15 
seconds. To find out what your minimum refresh rate 
is, or to change it, check with your CentreVu CMS 
administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the report. 
For more information, see the “Setting Report threshold 
Highlights” section in Chapter 5, “Reports.”

Run Minimized Check this box to minimize the report. 

Field Description
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Report Example 17

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name

Report Data 
Start Time:

The day and time that the report started 
collecting data.

No database item.

Split/Skill: The name or number of the split(s)/skill(s) 
selected for the report.

syn(SPLIT)
csplit

Agents 
Staffed

The number of agents logged into each 
split/skill.

STAFFED
csplit

Calls Waiting The total number of ACD calls waiting to 
be answered for each split/skill in the 
report. This includes calls that are in 
queue and ringing at an agent voice 
terminal. It also includes outbound ACD 
calls placed by an adjunct (also called 
outbound predictive dialing), for the 
Generic 2.2 switches with ASAI Gateway 
or the Generic 3 with ASAI only. For the 
Generic 3 switches, it does not include 
direct agent calls.

INQUEUE+INRIN
G

csplit
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Oldest Call 
Waiting

The number of seconds that the oldest call 
has waited in queue or ringing at an agent 
voice terminal for each split/skill in the 
report. This does not include direct agent 
calls.

OLDESTCALL

csplit
ACD Calls The ACD calls that were queued to the 

split/skill and answered by an agent. This 
does not include direct agent calls, but it 
does include ACD calls placed by an 
adjunct (also called outbound predictive 
dialing), for the Generic 2.2 switches with 
ASAI Gateway or the Generic 3 with ASAI 
only. 

ACDCALLS

hsplit, csplit
Avg ACD 
Time

The average talk time for all ACD calls to 
the split. This does not include hold time 
on direct agent calls, but it does include 
talk time of all outbound ACD calls placed 
by an adjunct (also called outbound 
predictive dialing), for the Generic 2.2 
switches with ASAI Gateway or the 
Generic 3 with ASAI only. 

ACDTIME
/ ACDCALLS

<AVG_ACD_TAL
K_TIME>

hsplit, csplit
Aban Calls The total number of queued calls for each 

split/skill that abandoned before an agent 
answered. This includes calls that are 
ringing at a voice terminal but does not 
include direct agent calls. It also includes 
the number of outbound calls for each 
split/skill that abandoned at the far end 
before an agent answered. For the Generic 
2.2 switches with ASAI Gateway Interface 
feature or the Generic 3 with the ASAI 
feature only.

ABNCALLS

hsplit, csplit
Avg Aban 
Time

The average time a caller waited before 
hanging up.

ABNTIME
/ ABNCALLS
hsplit, csplit

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Avg Speed 
Ans

The average time calls waited in queue 
and ringing before an agent answered. 
This does not include direct agent calls, 
but it does include outbound ACD calls 
placed by an adjunct (also called 
outbound predictive dialing), for the 
Generic 2.2 switches with ASAI Gateway 
or the Generic 3 with ASAI only. 

ANSTIME
/ ACDCALLS

<AVG_ANSWER_
SPEED>

hsplit, csplit

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Name
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Split/Skill—Graphical Split/Skill View 17

This report shows the status of agents in the split/skill, and cumulative 
split/skill statistics. 

Things to Know About This Report 17

● You may want to use this report if you have large numbers of agents in 
one split or skill who need split/skill status but do not want to consume 
the PC resources required to display individual agent status of many 
agents. 

● Call center managers may also use this report to see the totals and 
averages for a specific split or skill up to a certain point in the day.
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Input Window 17

Field Description

Split/Skill: Enter the appropriate split/skill name(s) or number(s). 
Any name you want to appear on the report must have 
been previously defined and entered in the Dictionary 
subsystem.

Report Data 
Start Time:

Enter the day and time (either in military time or with 
AM/PM specified) you want the report to start 
collecting data. The time entered (or the time adjusted 
to the nearest previous interval start time relative to the 
entered time) is used to populate the Report Data Start 
Time field on the report.
NOTE: If no report start time is available, the start time 
will be midnight of the current day. The report start 
time must be less than 24 hours before the current time.

829.bk : integratedreports.fm  Page 30  Wednesday, November 20, 1996  3:09 PM



 Split/Skill—Graphical Split/Skill View 17-31

Integrated Reports

C
ha

pt
er

 1
7

Refresh Every 
<#> Seconds

Enter the number of seconds (3 to 600) to specify how 
rapidly CentreVu CMS should update the report data.

The default for the Refresh rate in seconds: field in this 
window is your assigned minimum refresh rate plus 15 
seconds. To find out what your minimum refresh rate 
is, or to change it, check with your CentreVu CMS 
administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the report. 
For more information, see the “Setting Report 
Threshold Highlights” section in Chapter 5, “Reports.”

Run Minimized Check this box to minimize the report. 

Field Description
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Report Example 17

Report Heading Description
Database Item/ 
Calculation, 
Table Name

Split/Skill: The name or number of the 
split(s)/skill(s) selected for the report.

syn(SPLIT)
csplit

Report Data 
Start Time:

The day and time that the report started 
collecting data.

No database item.

AVAIL The current number of agents that are 
available to receive ACD calls in this 
split/skill.

AVAILABLE

csplit
ACD The total number of agents connected to 

inbound and outbound ACD calls in 
each split/skill. This does not include 
direct agent calls.

ONACD

csplit
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ACW The current number of POSITIONS that 
are in after call work for this split/skill. 
This includes agents on ACW-
IN/ACW-OUT calls as well as agents in 
ACW not associated with an ACD call. 
It does not include agents in ACW for 
direct agent ACD calls.

INACW

csplit
AUX The current number of POSITIONS that 

are in auxiliary work for all splits/skills 
or on AUX-IN/AUX-OUT calls.

INAUX

csplit
RING The current number of POSITIONS that 

are in the “ring” state, for this 
split/skill. For example, the positions 
that have a split/skill or direct agent 
ACD call ring for this split/skill and are 
not doing anything else. 

Note: When an agent makes or answers 
an extension call while an ACD call is 
ringing, that position is no longer 
counted in AGINRING (because the 
agent is then on an AUXIN/OUT call). 
Agents talking on ACD calls who 
receive a forced MCH call (for Generic 3 
Version 4 switches and later) are not 
counted in AGINRING (they are 
counted in ONACD).

AGINRING

csplit
OTHER The current number of POSITIONS that 

are doing other work. 
OTHER
csplit

Agents 
Staffed:

The number of agents logged into the 
split/skill.

STAFFED
csplit

Report Heading Description
Database Item/ 
Calculation, 
Table Name
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% Within 
Service Level:

The percentage of split/skill ACD calls 
that were answered by an agent within 
the predefined acceptable service level. 
Calls to the split/skill include 
abandoned calls, calls not answered, 
and outbound ACD calls placed by an 
adjunct (for example, outbound 
predictive dialing - Generic 2.2 switches 
with the ASAI Gateway Interface 
feature or Generic 3 switches with the 
ASAI feature). Calls that were not 
answered may include forced busy calls, 
forced disconnect calls, calls redirected 
to another destination, and calls queued 
to more than one split and answered in 
another split/skill.

For Generic 3 switches, Percent Within 
Service Level does not include direct 
agent calls.

100*(ACCEPTABLE/ 
CALLSOFFERED)

sum(PERCENT_
SERV_LVL_SPL)

<PERCENT_SERV_L
VL_SPL>

csplit
Calls Waiting The total number of split/skill ACD 

calls waiting to be answered. This 
includes calls that are in queue and 
ringing at an agent voice terminal and 
outbound ACD calls placed by an 
adjunct (for example, outbound 
predictive dialing - Generic 2.2 switches 
with the ASAI Gateway Interface 
feature or Generic 3 switches with the 
ASAI feature). It does not include direct 
agent calls (Generic 3 switches only).

INQUEUE + INRING

csplit
Oldest Call 
Waiting:

The number of seconds that the oldest 
ACD call has waited in queue or ringing 
before being answered. This does not 
include direct agent calls.

OLDESTCALL

csplit

Report Heading Description
Database Item/ 
Calculation, 
Table Name
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Avg Speed 
Ans:

The average time that calls waited in 
queue or ringing before an agent 
answered. This does not include direct 
agent calls, but it does include outbound 
ACD calls placed by an adjunct 
(outbound predictive dialing - Generic 
2.2 switches with ASAI Gateway 
Interface feature or Generic 3 with the 
ASAI feature only).

ANSTIME
/ ACDCALLS

<AVG_ANSWER_SPE
ED>

hsplit, csplit
ACD Calls: The queued ACD calls to the split/skill 

that were answered by an agent. This 
does not include direct agent calls, but it 
does include ACD calls placed by an 
adjunct (outbound predictive dialing - 
Generic 2.2 switches with ASAI 
Gateway or Generic 3 with ASAI only).

ACDCALLS

hsplit, csplit
Avg ACD 
Time:

The average talk time (does not include 
hold time) for all ACD calls to this 
split/skill. This does not include direct 
agent calls, but it does include talk time 
of all ACD calls placed by an adjunct 
(outbound predictive dialing - Generic 
2.2 switches with ASAI Gateway 
Interface feature or Generic 3 with the 
ASAI feature only).

<AVG_ACD_
TALK_TIME>

hsplit, csplit
 Aban Calls: The total number of queued calls for 

each split/skill that abandoned before 
an agent answered. This includes calls 
that are ringing at a voice terminal but 
does not include direct agent calls. It 
also includes the number of outbound 
calls for each split/skill that abandoned 
at the far end before an agent answered 
(Generic 2.2 switches with ASAI 
Gateway Interface feature or Generic 3 
with the ASAI feature only).

ABNCALLS

csplit

Report Heading Description
Database Item/ 
Calculation, 
Table Name
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Avg Aban 
Time:

The average time a caller waited before 
hanging up.

ABNTIME / 
ABNCALLS
<AVG_ABANDON_
TIME>
hsplit, csplit

Report Heading Description
Database Item/ 
Calculation, 
Table Name
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Integrated VDN Category Tab 17

The following is an example of the reports that may be available in the VDN 
Category from the Integrated Report tab depending on your switch type 
and whether you have purchased the EAS or Vectoring feature.

Menu Sample to be provided.
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VDN—Graphical Call Handling 17

This report shows for each VDN, the cumulative number of calls that are 
answered, abandoned, considered outflow calls, and includes the ASA.

Things to Know About This Report 17

● This report graphically represents how many ACD calls for each 
specified VDN were answered, abandoned, or outflowed. It also shows 
the switch-based average speed of answer for each specified VDN.

● You can access this report from the VDN Category report list on the 
Integrated tab of the Report Selector window.

● This report consists of two charts. A legend is to the right of each chart.

● The top chart is a three-dimensional, horizontal, color-coded bar chart 
showing numbers of ACD calls answered, abandoned, and outflowed.

● The bottom chart is a line graph, where the Rolling ASA of each VDN is 
represented by each color-coded line. 

● The chart type can be changed. See the “Formatting Chart Reports” 
section in Chapter 4, “Reports Basics,” for more information. 
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Input Window 17

Field Description

VDNs: Enter the number(s) or name(s) (if they have been 
defined in the Dictionary) of the VDN(s) that you want 
to include in the report. You can enter a name only if it 
has been previously defined in the Dictionary 
subsystem. To complete the input field, do the 
following:

• Type in the information requested.
• Select the information from the pull-down list of 

previously used items. During each CMS session, 
Supervisor recalls the items you have selected for 
each input field. You can use the pull-down list to 
select an item for the input field.

• Use the Browse button to view all available items 
for the input field, and then select item(s) for the 
input field. When you click on the Browse button, a 
window opens that lets you select items for the 
input field. 
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Report Data 
Start Time:

Enter the day and time (either in military time or with 
AM/PM specified) you want the report to start 
collecting data. The time entered (or the time adjusted 
to the nearest previous interval start time relative to the 
entered time) is used to populate the Report Data Start 
Time field on the report.

NOTE: If no report start time is available, the start time 
will be midnight of the current day. The report start 
time must be less than 24 hours before the current time.

Refresh Every 
<number> 
Seconds

Enter the number of seconds (3 to 600) to specify how 
rapidly CentreVu CMS should update the report data.

The default for the Refresh rate in seconds: field in this 
window is your assigned minimum refresh rate plus 15 
seconds. To find out what your minimum refresh rate 
is, or to change it, check with your CentreVu CMS 
administrator.

Enable Report 
Thresholds

Check this box to turn on the thresholds for the report. 
For more information, see the “Setting Report 
threshold Highlights” section in Chapter 5, “Reports.”

Run Minimized Check this box to minimize the report. 

Field Description
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Report Example 17

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Names

Report Data 
Start Time:

The day and time that the report started 
collecting data.

No database item.

VDN The number or name of the VDN for 
which the report shows data (selected in 
the report input window).

syn(VDN)
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Rolling ASA The switch-provided rolling average 
speed of answer for this VDN. This value 
is sent to CentreVu CMS whenever it 
changes (for example, when a call is 
answered) on the Generic 3 Version 4 or 
later switch with the call vectoring 
enhancements.

ASA

cvdn
Flow Out The number of calls that were redirected 

to another VDN or off-switch destination 
via a “route to” step or “adjunct routing” 
command, or were redirected to a VDN 
by redirection on no answer. Calls in the 
VDN that are routed to other switch 
destinations, such as splits/skills or 
extensions, are not counted as outflows 
from the VDN.

OUTFLOWCALLS

hvdn and cvdn
Aban Calls The number of calls to the ACD during 

the reporting period that hung up while 
being carried by this VDN.

ABNCALLS

hvdn, cvdn
ACD Calls The number of split/skill and direct agent 

ACD calls completed during the reporting 
period that were answered while carried 
by the VDN. This includes calls from 
“queue to main,” “check backup,” “route 
to” split/skill, and “adjunct routing” to a 
split/skill or direct agent.

ACDCALLS

hvdn, cvdn

Report 
Heading

Description
Database Item/ 
Calculation, 
Table Names
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18
CentreVu™ Terminal 18

Introduction 18

This chapter gives an overview of the Lucent CentreVu Terminal Emulator 
(referred to as Terminal) and teaches you to set up profiles for using 
Terminal. 

The sections in this chapter are as follows:
● About Terminal
● Using CentreVu Terminal with CentreVu Supervisor
● Opening and Exiting Terminal and CMS
● Using CentreVu Terminal
● CentreVu Terminal Messages.
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About Terminal 18

Terminal is a software application that emulates a 615 Color (615C) terminal. 
It is used to access the CentreVu CMS server from your PC running Microsoft* 
Windows†. You can use CentreVu Terminal with any CMS server that 
supports 615 or 615C terminal types.

Terminal can only be purchased in conjunction with Supervisor.

* Microsoft is a registered trademark of Microsoft Corp.
† Windows is a registered trademark of Microsoft Corp.
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Using Terminal with Supervisor 18

If you are using Supervisor and Terminal, you will use the CentreVu 
Terminal application for the following CMS capabilities:
● ACD Administration — Vector Contents
● cmsadm and cmssvc command capabilities
● UNIX*/Solaris† system command capabilities
● INFORMIX‡ database commands
● Forecast
● Shortcuts
● Timetables
● Creating and Editing CMS Custom Reports
● Administering ACDs for Generic 2.2 switches with the Expert Agent 

Selection (EAS) feature. For all of the other switches with EAS, you may 
use Supervisor to perform ACD Administration operations (except for 
Vector Contents) and run the applicable configuration reports.

* UNIX is a registered trademark of Novell, Inc. in the United States and other 
countries, licensed exclusively through X/Open Corporation.

† Solaris is a registered trademark of Sun Microsystems, Inc.
‡ INFORMIX is a registered trademark of Informix Software, Inc.

829.bk : terminalemulator.fm  Page 3  Wednesday, November 20, 1996  3:09 PM



18-4 Opening and Exiting Terminal and CMS

Terminal

Opening and Exiting Terminal and CMS 18

This section includes the following information:
● Opening Terminal
● Logging into CMS
● Exiting Terminal.

Open Terminal 18

To open Terminal:

1. For Windows 3.1 or Windows for Workgroups 3.11: Double click on the 
CentreVu Terminal icon in the Lucent CentreVu Supervisor Program 
Group from the Program Manager.

For Windows 95: Select the CentreVu Terminal item in the Lucent 
CentreVu Supervisor sub-menu under Programs from the Start Menu.

2. The Terminal window opens with no connection active:

The size of the application window is fixed at 24 rows by 80 columns, 
but the window resizes based on font size.
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Log Into CMS 18

1. Select the Profile menu.. The Profile menu items appear:

2. Click Open.

When you select a connection profile, a connection is initiated and a 
status window appears. The status window automatically goes away 
when the connection is established. If the connection is established 
through the network or a dedicated serial line, you see the CMS 
login: prompt. If the connection is established through a modem, the 
modem dials the number of the remote host and then attempts to 
connect.

Once a connection has been established, log into the remote CMS host 
using standard CMS login procedures.

Note If you do not have a profile created, refer to the “Creating 
Profiles” section in this chapter.

Note If you want to stop the login process, but keep Terminal 
running, select Disconnect from the Connection menu.

If you want to stop the login process and close Terminal, select 
Exit from the Profile menu.
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3. At the login: prompt, enter your CMS login ID, and press Return.

4. At the Password: prompt, enter your CMS password (it does not 
display on the screen), and press Return.

5. At the Terminal type: prompt, type 615c or CVTERM, and press 
Return.

The CMS Main Menu displays. 

Note CentreVu Terminal does not use cvsup as the terminal type.

Note If a system prompt, such as $ or # , displays instead of the 
terminal type prompt or the CMS Main menu, then type cms , 
and press Return.
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Exiting Terminal 18

To exit Terminal:

1. Select Logout from the CMS Main Menu.
You will see a window indicating that the CMS connection has been 
dropped.

2. Select OK or press Return in the message window.

3. Select Exit from the Profile menu. 

Note If a system prompt, such as $ or # , displays instead of the 
dropped connection message, then type exit , and press 
Return.

Note If you select Exit or try to close the Terminal window while a 
connection is active, a message is displayed informing you of 
this and asking if you want to exit anyway. Select Yes to drop 
the CMS connection and exit Terminal; select No to keep the 
connection active and ignore the Exit request.
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Using Terminal 18

This section contains the following information:

● Terminal Window

● Creating Profiles

● Editing Profiles

● Setting Profile Options.

Terminal Window 18

The Terminal window contains:

● Title bar — Displays “Lucent CentreVu Terminal” and the name of the 
current connection profile. If no profile is currently selected, “(untitled)” 
displays instead of the profile name.

● Menu bar — Includes the Profile, Edit, Connection, and Help options.

● Application window — The area of the screen where you log into CMS 
and use CMS.

Title Bar

Menu Bar

Application Window

Function Keys
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● Function keys — Initially, the function key labels at the bottom of 
Terminal’s main window are not visible. After you have logged into 
CMS, the function keys are appropriately labeled and work the same as 
the standard CMS Screen-Labeled Keys (SLKs). 

See the “User Basics” chapter in the CentreVu CMS Administration
(585-215-820) document for definitions of and instructions for using the 
function keys and their associated menus.

Menu Bar 18

The following paragraphs describe the menus on the Terminal menu 
bar, each menu item, and the action each menu item performs.

Profile Menu 18

From this menu you can create, open, and save a connection profile. 
You can also exit Terminal from this menu. Profiles are used to store 
information related to how a particular user connects to the remote 
host. The following table lists the items on the Profile menu and 
describes the action each item performs.

Menu Item Action

New Creates a new connection profile. By default, this 
connection profile is named “profile 1” until you 
Save it. This item is disabled if there is already a 
connection active.

Open... Opens an existing connection profile. Selecting 
this menu item brings up a window displaying 
the current profiles. Once you select a profile to 
open, that profile becomes the first profile in the 
list of recently accessed profiles. This item is 
disabled if there is already a connection active.

Save Saves the current connection profile.
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Edit Menu 18

From this menu you can copy selected text to the Microsoft Windows 
Clipboard, paste the contents of the Clipboard to a remote host 
computer, and clear the contents of the Clipboard. In this case, 
“pasting” means sending the selected text to the screen as if it were 
typed by the user. The capability to cut text is not supported by 
Terminal. The following table lists the items on the Edit menu and a 
brief description of the action each item performs. You can use the 
basic Microsoft Windows keyboard shortcuts.

Save As... Brings up a window that requests a name under 
which to save the profile. Existing profile names 
are listed in the Save Profile As window. You can 
select one of these names or enter a new profile 
name in the Profile Name text box. If you use an 
existing profile name, a message box warns you 
that you are overwriting the contents of an 
existing profile.

1...4 The four most-recently opened connection 
profiles are displayed here. You can choose a 
numbered profile for quick access. The most 
recently selected profile you choose becomes 
profile number 1, with the other items being 
renumbered accordingly. These items are 
disabled if there is a connection already active.

Exit Exits Terminal. If there is a profile that has been 
modified but not saved, a warning message is 
displayed.

Menu Item Action

Copy Copies the selected text to the Microsoft Windows 
clipboard.

Menu Item Action
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Connection Menu 18

From this menu you can connect to, disconnect from, or send a 
break to a remote host computer. You also use this menu to set up or 
change Terminal options (communications, modem, and font). The 
following table lists the items on the Connection menu and 
describes the action each item performs.

Paste Pastes (sends) the contents of the Microsoft 
Windows clipboard to the location of your cursor 
on your PC as if you had typed it in.

Clear Clears the contents of the Microsoft Windows 
clipboard.

Menu Item Action

Connect Establishes a connection to a remote host 
computer as specified in the active connection 
profile. If a connection is already active, this 
menu item is disabled.

Disconnect Disconnects the active connection. If there is no 
active connection, this menu item is disabled.

Send Break Sends a “break” sequence to a remote host 
computer. A break is used to temporarily 
suspend an operation or transmission. If your 
connection is “hung up” and the host appears 
not to respond when you press keys on your 
keyboard, try sending a break.

Options... Brings up a window from which you can set up 
or change Terminal options. Terminal options are 
grouped under three tabs: Communications, 
Modem, and Font. 

Menu Item Action
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Help Menu 18

From this menu, you can get on-line help for Terminal. The 
following table lists the items on the Help menu and describes the 
action each item performs.

Menu Item Action

Contents Displays a table of contents of help 
topics.

Search for Help On... Allows you to search for a given help 
topic.

Index Displays the Terminal help index in a 
new window.

Technical Support Shows how to get Terminal technical 
support.

About... Opens the Terminal Help About 
window.

829.bk : terminalemulator.fm  Page 12  Wednesday, November 20, 1996  3:09 PM



 Using Terminal 18-13

Terminal

C
ha

pt
er

 1
8

Creating Profiles 18

To create a profile:

1. Open the Terminal.

2. Select New from the Profile menu.

The Options window displays:
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3. Set the Terminal options.

4. Select Save As from the Profile menu.

5. The Save Profile As box displays:

6. Type the name of the profile in the text box and select OK.

Note The Terminal Options are grouped under three tabs: 
Communications, Modem, and Font. See the section on each 
tab later in this chapter to learn how to set the options in each 
tab.

Note If you want to overwrite an existing profile with one you have 
just created, double click the name in the list box.
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Editing Profiles 18

To edit an existing profile:

1. Select Open from the Profile menu.

2. Select the name of the profile you want to edit.

3. Select Open.

4. Select Options from the Connection menu.

5. Edit the profile.

6. Select OK.

7. Select Save from the Profile menu.
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Setting Profile Options 18

Use Options from the Connection menu to set up how you will connect to 
the CMS host computer. The following paragraphs describe the options 
available to you and give you illustrations of settings for standard Terminal 
profiles.

When you are working in any of the windows, the following conventions 
are used:

● Select OK to set your current settings in the selected profile, Save to 
keep your changes, and close the Options window.

● Selecting Cancel closes the window without accepting the current 
settings.

● Selecting Help brings up a help window with help on the currently 
selected folder tab.

Communications Tab Modem Tab Font Tab
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Communications Tab 18

Select the Communications Tab to display the window that lets you set 
up or change the options for connecting to a remote host computer 
(please see the previous graphic).

Select Network, Serial, or Modem from the Connection box. Below are 
explanations and examples of the settings required for each type of 
connection.

Network Connection Settings 18

Select Network if you are connecting to the remote CMS through a 
network.

The information required for this setting follows:
● CMS Network Address — enter the name or the Internet 

Protocol (IP) address of the remote host. There is no default.
● Network Port — enter the network port that you wish to 

connect. The default is 23, which is the network port reserved 
for Telnet. 

Warning

Do not change these settings unless you are instructed to 
do so by your Network Administrator.
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An example of standard settings for a network connection is shown 
below:

Serial and Modem Connection Settings 18

Select Serial if you are connecting to the remote CMS through a 
serial connection. Select Modem if you are connecting to the remote 
CMS through a modem.

The information required for each setting is as follows:
● Port — choose from the pull-down list the communication 

(COM) port you will use to connect to the CMS server. The 
options are COM1, COM2, COM3, and COM4.

● Baud Rate — choose the baud rate from the pull-down list. The 
options are 110, 300, 600, 1200, 2400, 4800, 9600, and 19.2K.

● Flow Control — choose the appropriate flow control from the 
pull-down list. The options are None, Xon/Xoff (software), 
Rts/Cts (hardware), or Both.

● Parity — choose the appropriate parity setting from the pull-
down list. The options are None, Odd, Even, Mark, and Space.

● Data Bits — choose the number of data bits from the pull-down 
list. The options are 5, 6, 7, and 8.

● Stop Bits — displays the number of stop bits from the pull-
down list. The options are 1, 1.5, and 2.
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An example of standard settings for a serial or modem connection is 
shown below:

Warning

Do not change these settings unless you are instructed to 
do so by your Network Administrator.
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Modem Tab 18

Select the Modem tab to set up or change dial strings for connecting to 
the remote CMS through a modem port. The following paragraphs 
describe the options available to you for setting up the modem 
connection. Below is an example of standard modem settings for 
Terminal:

● Phone Number — enter the phone number of the remote host.
● Dial Prefix — enter the characters to send to the modem before 

the Phone Number of the remote host. For example, if a “9” 
must be dialed before the telephone number, you can enter it 
after the phrase ATDT (ATDT9).

● Dial Suffix — enter the characters to send to the modem after 
the Phone Number of the remote host. For example, if an 
extension has to be dialed after the telephone number of the 
remote host, enter it here.

● Hangup String — enter the characters to send to the modem to 
cause it to hang up the connection. The default is ATH.

● Reset String — enter the characters to send to the modem to 
cause it to reset itself. The default is ATZ.
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● Auto Retry — turns the auto retry option on or off. If the check 
box is not selected, the modem tries only once to establish a 
connection to the remote host.

● Allow xx seconds for connection — enter the maximum time to 
wait for the connection to be established. The valid values are 1 
to 999 seconds. The default value is 45 seconds.

Font Tab 18

Select the Font tab to change the font size used by the Terminal when 
you are using CMS. The following paragraphs describe the options 
available to you for setting the font size. Below is an illustration of the 
standard font settings for Terminal:

● Small font is approximately 8 points and is appropriate for 
video displays that have a resolution of 640 x 480 (VGA) or less.

● Medium font is approximately 9 points and is appropriate for 
video displays that have a resolution of 800 x 600 or 1024 x 768. 
Medium is the default font size.

● Large font is approximately 10 points and is appropriate for 
video displays that have a resolution of 1024 x 768 or greater.

● Sample Text text box shows what the selected font size looks 
like.
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Terminal Messages 18

There are two types of messages you can receive when using Terminal:

● Error Messages

● Information Messages.

Error Messages 18

The following messages are displayed in a window with an OK button:

Unable to connect to the remote host. 18

Terminal failed to connect to the remote host. If the reason for failure can 
be determined, Terminal displays one of the following messages:
● Busy, no answer.
● The remote host is not responding.
● The network is not responding.

The connection to the remote host was lost. 18

Some possible causes for this message are:
● The remote host has crashed.
● The network has dropped the connection.
● The modem has hung up the line.

The profile {name} does not exist. 18

This message appears if you try to open a profile named {name} and it 
does not exist.
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Information Messages 18

The following messages are displayed in a box with Yes and No buttons:

The profile {name} exists, replace? 18

This message appears if you try to save a profile named {name} and it 
already exists.

Save changes to {name}? 18

This message appears if you try to exit the Terminal without saving 
changes to the profile named {name}.

A connection is active, exit anyway? 18

This message appears if you try to exit the Terminal while a connection 
is active.
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Introduction 19

This chapter describes the kinds of error messages that Supervisor displays 
and tells you what to do when error messages appear. 

The chapter is organized in two sections. The first section lists the types of 
error messages Supervisor might display (for each type of error message, 
three examples and a set of instructions are given). The second section lists 
error messages that do not fit into the categories of the first section.

If an error message displays, and the message is not described in this 
chapter, then the error is considered “unexpected”. When an unexpected 
error occurs, be sure to record all information appearing in the error 
message box, and call Services on 1-800-242-2121. (Customers outside the 
United States should call their Lucent Technologies Representative or 
Distributor.)

A typical Supervisor error message will contain the following information:

● A general description of the error

● The error code and specific error associated with the problem

● The location information for the error. 
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The following table lists the major types of error messages that Supervisor 
might display. Three examples, as well as general instructions, are given for 
each type of error message

Type of Message/Examples What to Do?

Login Errors Use any information in the error 
message to find and correct the 
problem. If you cannot correct the 
problem yourself, then see your 
system administrator or call Services.

The server did not recognize 
your Login ID and/or Pass-
word. Please try again later.

The server did not respond to 
the login request. Try again?

Your UNIX shell is not set to 
usr/bin/cms, so Automatic 
Login will not work properly. 
Please select Manual Login in 
the Options dialog box and try 
again.

Invalid User Input Reenter the input in the field. If 
applicable, you can also use the 
Browse button or the History list to 
select valid input for the field. 

Invalid Date

‘<user-entered value>’ is not a 
valid entry for this field.

A single value must be entered 
in this field. Ranges and lists are 
not allowed.
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Failed Operations Use any information in the error 
message to find and correct the 
problem. If you cannot correct the 
problem yourself, then see your 
system administrator or call Services.

Cannot perform the requested 
operation because the Server 
message queue is full. Try again.

Cannot perform the requested 
operation because of an internal 
Logic Error.

Cannot perform requested oper-
ation. Please try again or contact 
Technical Support.

Communications Errors Use any information in the error 
message to find and correct the 
problem. If you cannot correct the 
problem yourself, then see your 
system administrator or call Services.

Could not communicate with 
the modem.

Could not connect to the server.

Could not initialize communica-
tions.

Permissions Errors Contact your system administrator to 
request the read or write permission 
that you need.Cannot perform requested oper-

ation because you do not have 
read or write permission in any 
split or skill.

You do not have permission to 
write into this table.

You do not have permission for 
any ACD.

Type of Message/Examples What to Do?
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File System Errors If you cannot correct the problem in 
the file or file system, then see your 
system administrator or call Services.Could not find the file 

DALE.DLL. Please make sure 
that this file is on your worksta-
tion’s path.

The application could not be 
started because the path to the 
executable was not found. 
Please reinstall Lucent Technolo-
gies CentreVu Supervisor or call 
Technical Support.

The file <filename> is not a valid 
bitmap file. Please try again 
with another file.

CMS Server Errors If appropriate, wait and try your 
request again later. If you cannot 
wait, see your system administrator 
or call Services. 

The data requested is not 
present on the server. Please 
contact a system administrator.

The server is currently in single-
user mode. Please login again 
later.

The server is not currently run-
ning. Please try again later.

Type of Message/Examples What to Do?
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Report Errors Report errors can occur for any of the 
following reasons: 

● Syntax error in report

● Chart does not contain any 
series

● Report is not a Supervisor 
report

● Input control is invalid

● Input control is not found 

● Report object references a 
non-existent query

● Query has errors. 

Check the error log for more details. 
For additional information on reports, 
see the Reports Basics and/or Reports 
chapters in this document. If you 
cannot correct the problem yourself, 
then see your system administrator or 
call Services.

Reports must be started from 
the controller.

Report is too wide for Portrait 
mode but can be printed in 
Landscape mode. Do you want 
to print this report in Landscape 
mode?

The report cannot run because a 
problem was detected in the 
structure of the report.

Memory/Disk Space Error Use any information in the error 
message to find and correct the 
problem. If you cannot correct the 
problem yourself, then see your 
system administrator or call Services.

The disk is full.

The application could not be 
started because system memory 
is low. Please close some appli-
cations and try again.

The system is low on disk space. 
Please delete any unused files.

Type of Message/Examples What to Do?
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The following table lists (in alphabetical order) many user error messages 
that Supervisor might display.

Message Description/What to Do?

<count> records exported to 
<filename or clipboard>

Reason — This message indicates how 
many records of data were exported after 
a successful data export operation.
What to Do? — Select OK.

A Change Agent Skills window 
already exists. Do you wish to 
close it and start a new one?

Reason — This message may appear 
when launching a “Multi-Agent Skill 
Change” window from the controller. 
Only one window of this type may be 
active at any one time.
What to Do? — Select No to make the 
Multi-Agent Skill Change window active, 
or select Yes to open a new one and close 
existing window.

A Change Agent Split 
Assignments window already 
exists. Do you wish to close it and 
start a new one? 

Reason — This message may appear 
when launching a “Change Agent Split 
Assignments” window from the 
controller. Only one window of this type 
may be active at any one time. 
What to Do? — Select No to make the 
Change Agent Split Assignments 
window active, or select Yes to open a 
new one and close existing window.

A data export is in progress. 
Logging off will cause the data to 
be discarded. Do you really want 
to log off?

Reason — You attempted to log off the 
CMS server while report data transport 
was in progress.
What to Do? — Select Yes to log off, or 
select No to cancel the log off command.
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An internal error has occurred, 
and Lucent CentreVu Supervisor 
must exit. Please close all 
applications and restart Windows.

Reason — A fatal error has occurred in the 
application. 
What to Do? — Close all applications and 
restart Windows.

An internal failure occurred in 
attempting to display the window 
for task <form caption>. This task 
is being terminated, contact 
Technical Support.

Reason — Supervisor was unable to create 
the window you selected. The task will 
not be displayed. 
What to Do? — See the error log, which 
may have more information.

Are you sure you want to logout? Reason — This is displayed when the user 
chooses to log out via the Controller 
when there is a session active to a server.
What to Do? — Select Yes to log out, or 
select No to cancel the logout command.

CENTREVU.INI could not be 
created. 

Reason — You may be out of hard drive 
space.
What to Do? — Delete any unnecessary 
files and try again.

CMS windows must be started 
from the Controller. 

Reason — User tried to open a CMS 
window from a place other than the 
Controller (for example, double clicking 
on form.exe in file manager).
What to Do? — Use the Supervisor 
Controller to open the window.

Extension is not assigned to any 
splits.

Reason — When a user launches the 
“Change Extension Split Assignments” 
window from the Controller, an input 
box is displayed which allows the user to 
enter an extension. If the extension 
entered is not assigned to any splits, this 
message is displayed.
What to Do? — Enter a valid extension 
number.

Message Description/What to Do?
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Operation successful. Reason — The operation initiated by the 
user has completed successfully.
What to Do? — Select OK to continue.

Please specify a network address 
in the Options dialog.

Reason — There is no network address 
specified in the Options window.
What to Do? — Specify a network 
address. See your system administrator if 
you do not know the network address for 
the server.

Please specify a network port in 
the Options dialog.

Reason — There is no network port 
specified in the Options window.
What to Do? — Specify a network port. 
The network port is typically 23. This 
value should not change. For more 
information on the network port, see 
your system administrator.

Please specify a phone number in 
the Options dialog.

Reason — There is no modem phone 
number specified in the Options window.
What to Do? — Specify a phone number. 
See your system administrator if you do 
not know the phone number for the 
server.

Reports must be started from the 
Controller.

Reason — The user tried to run 
RENGINE.EXX from a place other than 
the controller (for example, double-
clicking the file’s icon in Windows 
Explorer or File Manager). 
What to Do? — Use the Supervisor 
Controller to open the window

Message Description/What to Do?
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Skill cannot be removed from this 
agent because a failure in 
communications prevents 
permission validation.

Reason — This message could appear in 
the Change Agent Skills window when 
the user attempts to remove a skill from 
an agent. The message indicates a 
problem in communications with the 
server.
What to Do? — See your system 
administrator or call Services.

The application could not be 
started because the executable file 
is corrupt. Please reinstall Lucent 
CentreVu Supervisor or call 
Technical Support.

Reason — A supervisor executable file is 
corrupt. 
What to Do? — Reinstall Supervisor. See 
the CentreVu Supervisor Installation and 
Getting Started Guide for instructions. If 
reinstalling Supervisor does not solve the 
problem, then call Technical Support.

The application could not be 
started because the path to the 
executable was not found. Please 
reinstall Lucent CentreVu 
Supervisor or call Technical 
Support.

Reason — When you selected the 
Supervisor icon, the path associated with 
the icon was incorrect. 
What to Do? — Reinstall Supervisor or 
call Services.

The device is not available. Correct 
the problem and try again.

Reason — This usually occurs when 
trying to export data to a floppy or 
network drive that is not currently 
accessible. 
What to Do? — Check to see if the floppy 
disk is inserted or the network drive is 
connected. 

The device is not ready. Correct 
the problem and try again.

Reason — This usually occurs when 
trying to export data to a floppy or 
network drive that is not currently 
accessible. 
What to Do? — Check to see if the device 
is ready.

Message Description/What to Do?
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The following file systems are low, 
and could adversely affect server 
performance: <filesystems>

Reason — This is displayed at login if any 
CMS file systems are low on space. Below 
this message is a list of the file systems 
and their percentages. 
What to Do? — See your system 
administrator or call Services.

The maximum length for the input 
field has been met, <entered name 
or range> is the last <entity> that 
can be added. Remove items from 
the Selected list.

Reason — In one of the multi-value 
browse windows, the user has selected so 
many items that the information will not 
fit in the input field. 
What to Do? — Remove all entities after 
the last one that can be added, which is 
indicated in the error message. 

The maximum number of Lucent 
CentreVu Supervisor logins on the 
server has been reached. Please try 
again later.

Reason — The limit on the number of 
users that have been authorized to use 
Supervisor has been met. Users who 
attempt to log in will be denied login 
until the number of Supervisor users falls 
below the authorized number. 
What to Do? — Try again later or see your 
system administrator to request a greater 
maximum number of Supervisor logins. 

The network connection to '<user-
entered server name>‘ timed out.

Reason — Supervisor could not connect to 
the specified server.
What to Do? — Try again or see your 
system administrator.

The operation could not be 
completed because the connection 
to the server is down.

Reason — Supervisor tried to 
communicate with the server to process a 
user request, update a report, or perform 
some other operation, and was unable to 
complete the transaction because the 
connection to the server was not active. 
What to Do? — Reconnect to the server or 
see your system administrator.

Message Description/What to Do?
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The operation was cancelled 
because it took too long to 
complete.

Reason — Supervisor was retrieving data 
from the CMS server. The retrieval took 
longer than expected, so Supervisor 
cancelled out of the retrieval. 
What to Do? —Try again or call Services.

The requested report could not be 
run. Please try again or call 
Technical Support.

Reason — Supervisor could not execute 
the report you selected.
What to Do? —Try again or call Services.

The requested window could not 
be opened. Please try again or call 
Technical Support.

Reason — Supervisor could not open the 
window you selected.
What to Do? —Try again or call Services.

There are no agents in this skill. Reason — This message may appear in 
the Multi-Agent Skill Change window 
when a user double clicks on a skill name 
to see the members of that skill and there 
are none.
What to Do? — Select OK and enter 
another skill name in the input field.

There are no extensions in this 
split.

Reason — This message may appear in 
the Move Extensions Between Splits 
window when a user double clicks on a 
split name to see the members of that 
split and there are none.
What to Do? — Select OK and enter 
another split name in the input field.

There was an unknown failure on 
the server.

Reason — The server shut down.
What to Do? — See your system 
administrator.

This button has already been 
placed on the toolbar.

Reason — You attempted to move a 
button onto the toolbar that is already 
assigned to the toolbar.
What to Do? — Select OK.

Message Description/What to Do?
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This report contains character-
style graphics that are not 
supported by CentreVu 
Supervisor. The graphics will be 
displayed as text.

Reason — CMS “graph” reports are not 
supported by Supervisor. The report will 
still be run, but the output will be 
displayed irregularly. 
What to Do? — Use one of the Supervisor 
graphical reports instead or create an 
equivalent report using Report Designer.

This request may modify or delete 
multiple entries in the database. 
Do you want to continue?

Reason — You have made a change in the 
Dictionary that will affect more than one 
item in the CMS database.
What to Do? — Select Yes if you want to 
continue or select No to cancel the 
command.

Threshold configuration file 
<filename> contains invalid data. 
Threshold highlights on real-time 
reports may be incorrect.

Reason — The threshold settings file was 
corrupt. Invalid entries are ignored. 
What to Do? — Re-create threshold 
settings or call Services. 

Threshold file format is invalid. Reason — The threshold settings file was 
corrupt. 
What to Do? — Re-create threshold 
settings or call Services. If this message 
recurs, delete the threshold settings file. 
For information on deleting the threshold 
settings file, call Services.

Threshold values must increase 
from lower numbers to higher 
numbers.

Reason — When setting threshold 
highlight numbers, the number for low 
caution must be the smallest. The number 
for high warning must be the largest.
What to Do? — Re-create threshold 
settings. 

Message Description/What to Do?
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Thresholds are not available for 
the selected data item.

Reason — This message indicates that the 
threshold menu item was enabled 
erroneously. You cannot set thresholds 
for this item.
What to Do? — See your system 
administrator or call Services if the 
selected data item is one for which you 
are allowed to set thresholds. 

Unable to communicate with the 
Server. Terminating task

Reason — Supervisor attempted to send a 
message to the server and it failed.
What to Do? — See your system 
administrator.

Unable to initialize the 
application.

Reason — Supervisor could not find the 
information it needed to start the 
application.
What to Do? — See your system 
administrator or call Services. 

Unable to initialize the Reports 
application. To correct the 
problem, try closing CentreVu 
Supervisor and restarting 
Windows. If this problem persists, 
contact Technical Support.

Reason — There are several causes for this 
error. 
What to Do? — See your system 
administrator or call Services.

Unable to start <CMS 
Form/Operation name> because 
someone else is already running it. 
Only one can be running on the 
server at a time.

Reason — This message is displayed for 
CMS tasks where only one task can be 
running on the system at a time (for 
example, Backup, Restore, Data Storage 
Allocation), or when a user tries to start 
another task.
What to Do? — Try again later.

Message Description/What to Do?
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Unable to start the ACD 
Administration application.

Reason — This usually means a shortage 
of DOS conventional memory.
What to Do? — Consult your Windows 
documentation for assistance in 
optimizing your conventional memory, 
or see your system administrator.

Warning: The server will shut 
down in one minute. Please exit at 
this time.

Reason — The CMS server will shut 
down.
What to Do? — Log out.

You are currently logged in. Are 
you sure you want to exit?

Reason — This is displayed when the user 
closes the Controller when there is a 
session active to a server.
What to Do? — Select Yes to exit 
(Supervisor will automatically log you 
out), or select No to cancel the command.

You are not recognized as a valid 
server user. Please contact your 
system administrator.

Reason — The login used to log into the 
server is not administered on the server.
What to Do? — See your system 
administrator.

Your new password must differ 
from the old by at least three 
character positions.

Reason — You are changing your 
password and did not enter one that is 
sufficiently different from the expired 
password.
What to Do? — Enter a valid new 
password.

Your password may not be the 
same as or similar to your login 
ID.

Reason — For security purposes, your 
password must be sufficiently different 
from your Login ID.
What to Do? —Select OK to continue.

Your password must be at least six 
characters in length.

Reason — You are changing your 
password and entered a new password 
that is not long enough.
What to Do? — Enter a valid password.

Message Description/What to Do?
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Your password must contain at 
least two alphabetic characters, 
and at least one numeric or special 
character.

Reason — You are changing your 
password and entered a new password 
that does not have the correct 
type/number of characters.
What to Do? — Enter a valid password.

Your UNIX shell is not set to 
/usr/bin/cms, so Automatic 
Login will not work properly. 
Please select Manual Login in the 
Options window and try again.

Reason — CMS, CMSSVC and logins 
where the user gets a shell prompt when 
they log into the server will receive this 
message when they try to log in via the 
automatic login. 
What to Do? — Open the Options dialog 
box and select Manual Login, then try 
again. For more information on manual 
login procedures, see Chapter 4, “Getting 
Started,” in the CentreVu Supervisor 
Installation and Getting Started guide.

Your user configuration could not 
be loaded. The default 
configuration will be used.

Reason — Supervisor could not load your 
configuration settings.
What to Do? — Select OK to continue.

Message Description/What to Do?
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